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Getting Started 

Studio Solution software combines the operations and functions of a professional 

working photo studio into a single, easy to use and automated software.  

Historically, for the smooth operation of a working photo studio, many different pieces 

of software would be required to cover all of the steps between the times when a client 

is booked, all the way through to when the finished order is delivered. 

Studio Solution brings all studio tasks together into a single, easy to use software that 

can manage a complete professional studio workflow regardless of the company's size. 

Because of the scalable design of Studio Solution, it can operate stand-alone on a 

single laptop computer on location, or it can easily run over a large network managing 

multiple workstations in various locations. 

Studio Solution uses all of Canon's advanced imaging technologies "under the hood" to 

ensure that the image quality being produced at every step in the shooting, processing 

and printing process is up to the highest industry standard.  

Rather than a studio owner or manager thinking about their camera, their computers 

and their printers as separate tools, Studio Solution integrates their individual operations 

effortlessly so that everything operates as a single unit. 

The following are some of Studio Solution's useful features:  

 Consistently superior image quality throughout the workflow 

 Canon CR2 RAW workflow 

 Access and permissions for all studio operations, Administrators can control 

which employees have access to individual parts of the software 

 Scalable to any size studio operation 

 Included product support web links 

 Management of all calendar, employee and customer databases 

 Keeps track of customer family relations and birthdays 

 Reporting 
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 Create pricing, packages and templates 

 Wireless FTP capture 

 Tethered capture 

 Quick import via memory card or disk 

 Image archiving 

 Speedy creation of professional proof sheets and online galleries 

 Unique borders, templates and composites. Apply graphic templates turning 

photos into profitable products. 

 Unique slide shows. 

 Nesting and load sharing 

 Built in Canon printer color management 

 Retouch photos in the Studio Solution retouch module or Adobe Photoshop. 

 Integrated Picture Styles for RAW editing 

 Send orders electronically to professional labs with Labtricity. 

 Green screen shooting and editing 

Reading the Manual 
We’re here to help. The manual is designed not just to tell you where buttons are 

located, but with tutorials on how to perform every necessary task within the software. 

Although you can easily move around the manual with links, depending on your 

experience with the software you might want to jump ahead right away.  

Setting Up 

Start at the beginning. We’ll guide you through setting up your studio, piece by piece, 

in the right order. No jumping around or missing important options. Click here to start 

setting up. 

Using the Software 

If you don’t need to worry about setting things up, you can jump ahead and start 

learning about using the software. Click here to start using the software. 
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Running a Shoot 

If you’re only concerned with the steps necessary to run a shoot, start to finish, jump 

ahead to the tutorial. Click here to run a shoot. 

Troubleshooting 

Click here to troubleshoot. 

Reference 

If you’re looking for detailed screenshots, button descriptions, or shortcut keys, check 

the reference guides. Click here for reference material. If you’re looking for a list of 

shortcut keys, click here instead. 

Looking for Something Specific? 

Try looking in the Table of Contents or the Index. To view a permanent and collapsible 

Table of Contents to the left of this manual, select View > Navigation Panels > 

Bookmarks from the PDF menu. Just click on a heading to jump to that section. 

Want to Print the Manual? 

The manual is a considerable size, but you can print it if you want a physical copy. 

Simply select File > Print from the PDF menu, or press CTRL – P as a hotkey. 

Installing Studio Solution 

Supported Operating Systems 

Studio Solution is supported on Windows XP, Vista and Windows 7. You can run the 

software on any Mac OS that supports Boot Camp. For more information on running 

Boot Camp, go to Apple’s support page.  

Recommended Operating Requirements 

 Pentium 4, Celeron 1.8GHz or AMD equivalent 

 Microsoft Windows XP, Vista, or Windows 7 with all installed service packs 

 1 GB RAM 

http://www.apple.com/support/bootcamp
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 80 GB hard drive (or more depending on storage requirements) 

 SVGA monitor (24-bit color at 1024x768 resolution) 

 CD-ROM and CD-RW 

 USB connectivity 

 Microsoft Internet Explorer 5.0 or above 

Before Installation 

If you will be running Studio Solution over a network, you must be logged into Windows 

as an Administrator during installation. This is only for installation purposes, and 

afterwards the software can be used without connectivity problems by any user, if they 

have permission to access Shared folders. 

Note: Please make sure the dongle is not installed on the computer prior to installing the 

software. 

Installation 

To install Studio Solution: 

1. Insert the disc into the computer CD drive. 

2. Setup will automatically start the installation process. 

3. If a security window appears, select to Run the install. 

4. The InstallShield Wizard will begin: 

a. Select Next to begin the installation. 

b. Read and accept the terms in the License Agreement. 

c. Select Change to select a location to install Studio Solution.  

i. The default location is C:\Program 

Files\Studio Solution\ 

d. Select Install to begin the installation. 
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e. The installation will set up basic database information for the software. This 

may take a few minutes. 

5. The InstallShield Wizard will complete. Studio Solution is installed! 

Running Studio Solution 
Before running Studio Solution, you must have the USB protection key plugged into a 

USB port and verified. If the key is not working or connected to the computer, you will 

not be able to start the software. 

If you installed Studio Solution into the default directory, you can open it by double 

clicking the Studio Solution icon from your Desktop or from the Start Menu at Start Menu 

> Programs > Studio Solution. 

Supported CD/DVD Software 

When using Windows XP or Vista, the software will automatically use the CD authorizing 

capabilities of the operating system. 

Supported File Formats 

The following file formats are supported: 

 .crw (Canon) 

 .cr2 (Canon) 

 .tif 

 ..bmp 

 .jpg 

 .psd (Adobe) 

 .png

Logging In 

The first time you activate the software, you will automatically login as Admin, with 

access to every part of the software. As the Administrator, you have the option to set 

up the rights and privileges for other Studio Solution users.  

Setting an Admin Password 

The first thing you should do after logging in is set a password to protect your 

Administrative settings. 
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To set a password for the Administrator: 

1. Start the software with the USB protection 

key installed. 

2. Ensure you are in the Manage Studio 

tab. 

3. Select Logout, located at the very top 

right of the software. 

4. You will be returned to the login screen. 

5. Select to login as Admin with no 

password. 

6. Select the Manage Studio tab then select the Employees sub-tab. 

7. Select Admin then select Edit Employee located at the lower left corner of the 

page. 

8. Input a password then select Save. 

9. Your password is now set. 

Logging Into Your Online Account 

If you have an ExpressDigital PhotoReflect account, you can set the software to log into 

it automatically. First, you will need to set your PhotoReflect options here. Once they are 

set, you can select to Automatically log in to Online Account at the login screen to 

connect to your PhotoReflect and Labtricity accounts upon login. The user logging in 

must have access to these accounts to use this feature. 

Logging In as an Employee 

To log in as an employee, they must first have an employee account. The password, if 

required, can be set when the employee is created. The employee’s access and 

permissions in the software is dependent upon the rights assigned to them. Learn more 

about setting up employees here.  
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Overview 

Studio Solution is divided into five tabs to easily manage your photography studio. These 

tabs are located at the bottom of the software screen.  

 

Manage Studio contains all of the day to day studio operation option such as 

Calendars, Products, Printers, Cameras, and other general settings for the software.  

The Photo Library is for organizing and managing your photos and albums. 

The Photo Workshop is for editing and retouching your photos. 

The Orders tab is for managing and printing all orders. 

Client Presentation is a customer-friendly way of running the software while your 

customer watches, appearing as a kiosk for presenting and ordering photos. 

Manage Studio 
Here you will take care of all daily business, such as adding events, customers, 

employees, and setting products, services, and settings. The tabs at the top of the 

screen will manage different aspects of your studio. 

 

Home 

This is your home page. Here you will see all bookings and tasks available for a 

scheduled date. 

Calendar 

This is your studio calendar. You can add bookings, tasks, or calls for specific times and 

dates. These will show up on your homepage. You can also schedule and view 

employee schedules and rooms here. 
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Customers 

Here you will add, view, or edit customer information. This is where their contact 

information will be stored in the software. 

Employees 

Here you will add and register employees of your studio. You can assign events to them, 

control their access to the software, and keep records of their actions. 

Vendors 

Here you will add and monitor vendors and inventory for your studio operations. 

Products 

Here you will add and edit your products, services, templates, packages, and prices, 

including shipping and tax costs. 

Printers 

This is your printer configuration page. Add, edit, or troubleshoot printers here. 

Cameras 

This is your camera configuration page. Add, edit, or troubleshoot cameras here. 

Reports 

Here you will view, export and print various reports, including event, sales, employee, 

and trend information. 

Options 

This is your settings page. Here you will manage all software options. 

Photo Library 
Here you will store, organize, and manage all photos and catalogs. The library is divided 

into three sections, appearing in the software from left to right: Catalog Menu, Catalog 

Viewer, Shopping Cart or Photo Data with Histogram. 
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Catalog Menu 

This is where you will create, organize, publish, and archive your photo catalogs. 

General headings are available upon installation but can be changed at any time. 

Selecting a catalog here will determine which photos appear in the Catalog Viewer. 

Photo Viewer 

This is where you will review, orient, and organize photos within a catalog. You can add, 

retouch, and order individual photos here. 

Shopping Cart 

This is where you will select packages and photos for purchase. Any created package 

groups and products will be available here. 

Photo Data 

This is where you will be able to view a histogram for any image and add tags to a 

photo or catalog. 

Photo Workshop 
Here you will touch up, edit, or manipulate your photos before sending them to print. All 

of the changes made here will be saved as a new file. Your original photo file will 

remain unaffected. There are five different tabs located at the bottom of the screen to 

provide editing: Enhance, Correct (or Picture Style when working with Canon RAW files), 

Color Balance, Drop Out, and View. 
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Enhance 

This is for adding borders, text, and retouching your photos.  

Correct/Picture Style 

This is for adjusting light options such as shadows, brightness, and exposure. Canon 

Picture Styles, will be made available when Canon RAW files are selected for editing. 

Color Balance 

This is for selecting or setting a color profile and adjusting white balance. 

Drop Out 

This is for editing and applying green-screen effects. 

View 

This is what the photo will look like if printed as is. 

Orders 
Here you will view, manage, and print all orders created in the Shopping Cart. There are 

three tabs: New Orders, Pending Orders, and Completed Orders. Order details appear 

below the queues. 
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Client Presentation 
This option will only become available within the Photo Library and Photo Workshop, 

and will change the appearance of the software into a customer-friendly presentation 

tool, complete with ratings, comparisons, music, and a slideshow. The Shopping Cart 

will be available during this mode for creating orders. 
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Setting Software Options 

Before using the software you will need to set many of the basic software options. Let’s 

start with the most basic functions.  

 

 

 

Find and select the Manage Studio tab at the bottom of the software. 

Studio Information 
Find these options in Manage Studio > Options > Studio Information. 

 

The first step is entering 

your studio information. 

Enter your studio name, 

address, and contact 

information and click 

Save. This information will 

be used automatically in 

other parts of the 

software. 
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General Settings 
Find these options in Manage Studio > Options > General Settings. 

Select a heading to change the software options. Below is a list and description of 

each header and its options. 

 

Application Local Settings 

These settings apply only to this computer. 

 Station: Select a unique name for this computer. This will allow you to identify 

specific actions performed on or by this computer by recognizing the Station 

name. Your computer name, as displayed in Windows, can be used as a default. 

 Archive Path: Select or browse to a location to archive past events. Archiving will 

remove the events from the software while keeping them handy in case you 

ever need them again. You can also archive to a disc if your computer supports 

it; select Test Compatibility to check if your computer can write information to a 

CD. If not, you will need to save the data to another location then write with 

other software. 

 Backup Path: Select or browse to a location if you would like to make a backup 

archive to a second drive or location on your network. 

 Restore: Browse to your previously archived events to bring them back into the 

software. 

Note: Your Archive and Restore path must be set to the same location. 
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Application Shared Settings 

These settings apply to all computers on a networked system. 

 Caption Logo Path: Set your logo to appear at the top of the screen during 

Presentation Mode. The height cannot exceed 32 pixels and the width cannot 

exceed 600 pixels. 

 File Management: Select an option for storing catalogs: none, by day, by week, 

by month. All catalogs during the selected time period will be stored in the same 

folder.  

Application General Settings 

Set the general options for the software. A checkmark indicates the option is activated. 

Many of the options are activated upon installation as the default. 

 Allow text to be added on the fly to images and borders in the Photo Workshop: 

while editing photos in the workshop you will be able to quickly add an empty 

text box and format it independently of the image and any borders. 

 Automatically delete an event after it is archived to disc: after archiving an 

event to a backup location, the event will be automatically removed from the 

software without a warning prompt. 

 Fill package with current photo when adding to cart: if you have a photo 

selected and add a package to the cart, the package will be automatically 

populated with that photo. Normally, the package will be blank and you will 

need to click and drag photos into the package slots. 

 Show the „Desktop‟ in the library to browse folders: your computer desktop will 

appear in the catalog list in the Photo Library, so that you can easily browse to 

and add photos from locations on your computer without exiting the software. 

 Enable auto-orientation of captured images if supported: the software will try to 

decide if photos you take are meant to be portraits or landscapes. 

 View a large preview of your photos on a second monitor: this option is only 

available if you have a second monitor or Canon projector attached to your 

computer. Any time you select a photo in the Photo Library, the second monitor 

will display the photo full-screen with a black background. 
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 Use the numeric keypad as shortcut keys for color correcting photos: the 

numeric keypad will be used in the Photo Workshop for basic color correction 

functions. 

 Ignore preview thumbnails embedded in images: the software uses preview 

thumbnails for storing edits, but other software will not recognize these files 

properly and the images you see in Studio Solution will not have the full edits 

when printed or published. If you routinely use different software to edit and 

retouch photos, select this option. 

 Always show the import photos confirmation dialog when importing files: this 

prompts you for confirmation when selecting ―Import All‖ from Add 

Photo>Import. 

 Always show the quick import confirmation dialog when importing photos: if you 

are using quick import, this prompts the user for confirmation when importing 

photos. 

 Always show the burn to disk confirmation dialog when burning files or catalogs: 

this prompts you for confirmation when burning information to disk. 

 Always show the hide photos confirmation dialog when hiding photos: this 

prompts you for confirmation when hiding photos from the catalog. 

 Allow borders to be edited from the Photo Workshop: select to allow imported 

borders to be locked or editable in the workshop. 

Select an image format when using another program to edit images: 

 .bmp  .jpg  .png  .tif 

Select Template Marketplace options: 

 Display template marketplace on the Choose Border dialog in the Photo 

Workshop: when selecting a template in the workshop, you can browse, 

purchase, and download online templates. 

 Purchased Template Download Dialog: select one of the following options: 

o Always show the dialog when a template downloads. 

o Do not show the dialog and do not add purchased templates to the 

current border group. 

o Do not show the dialog and always add purchased templates to the 

current border group. 
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Select Shopping Cart options: 

 Show Service Notes as a branch of the Shopping Cart‟s Tree: you can select items 

in the shopping cart and add, edit, or delete service notes. 

 Show Print Commands and Media in the Shopping Cart menu: you can select 

items in the shopping cart and add, edit, or delete print commands and print 

media settings. 

Select Color Management options: 

 Use Monitor Color Profiles: set the default Windows color profile for photo display 

in both the Photo Library and the Photo Workshop. 

 Working Space: select one of the following color profiles: 

o sRGB ColorSpace 

o Adobe RGB (1998) - Default 

o ProPhoto RGB 

Select options for Prompts and Warnings: 

 Allow free packages without warning: when you add a package with no cost to 

the shopping cart, you will not be reminded that the package is free. 

 Prompt for Administrator password when accessing program settings: if you are 

not logged in as Admin and attempt to change the software settings, you will be 

prompted for the Admin password in order to continue. 

 Prompt for copies when adding packages to cart: if you routinely add more than 

one copy of a package to the shopping cart at a time, select this option to 

prompt you for a number of packages each time you add one to the cart. 

 Prompt for copies for Quick Print packages: if you routinely print more than one 

copy of a package using quick print, select this option to prompt you for a 

number of packages to print each time you use quick print. 

 Display quick print warning message: you will be prompted for confirmation 

when using quick print, to avoid accidentally printing items. 
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Fulfillment Options 

These options affect customer orders. 

 Automatically print orders containing locally fulfilled items: this option works with 

the auto-print function in the Orders tab, and will automatically print all placed 

orders that you fulfill in house. This option is enabled by default. 

 Add default back print information to each order: enable this option to specify 

and print text on the back of all photos. This option is only available for larger 

printers with back print capability. 

To enable back print text: 

1. Select Add default back print information to each order. 

2. Select Edit Back Print Info. 

3. A window appears. Select Store suggested back print text in each order. 

4. Enter the text you would like to appear. Select Insert special text to add 

information such as date/time, names, photo numbers, copyright symbols, 

etc. 

 Add the default package to the shopping cart: enable this option to 

automatically add your default package to every order made. 

 Shipping Settings: select a default shipping method for all orders you fulfill locally, 

and enable Ship all orders back to the company address to have all printed 

orders mailed back to you.  

 Print to Disc Settings: use this to write order information to disc for fulfillment at a 

lab using Labtricity. The studio must have these products configured the same 

way as the receiving lab. Select Test Compatibility to see if your computer 

supports internal disc writing and can automatically burn the information to a 

CD. 

Image Preview Settings 

These options affect preview files. 

 Enable Preview Files: Preview files are reduced-size versions of your photos that 

will load and edit faster than the digital negatives. The Image Preview Setting, 

found in General Settings, is for previews generated for images under Desktop 

and My Computer, on the Photo Library page. Image previews for orders are 
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placed in the folder with the images. These previews are found in the X:drive.  

The default location is C:\ProgramData\ExpressDigital\Common\CachePV.‖ 

Select a new path if desired. 

 Preview Cleaning: it is not necessary to keep preview files for catalogs that are 

no longer being used. The default settings will keep the files for two weeks. Select 

a different time period if desired and a time of day to start purging. Select 

Cleanup Older Previews to instantly purge the computer of preview files that 

exceed the time frame, or select Delete All Previews to instantly purge the 

computer of all preview files. 

Spell Checker Settings 

These options determine how the Spell Checker will correct comment and description 

text fields in the software. 

 Enable Automatic Spell Checking: enable this if you want to perform an 

automatic spell check before saving your information. 

 Apply spell check to street address fields: enable this if you want spell check to 

confirm the spelling of your entries in the street address field. 

 Options: these settings determine the correction levels for your spell checker 

 

                                                    

 

 Dictionaries: this setting allows you to add or delete words used by your 

dictionary. 
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PhotoReflect Account 
PhotoReflect.com is an online storefront for uploading and selling photos. You simply set 

your packages, products, and publish photos through Studio Solution to your site – 

where customers will automatically be notified and able to purchase photos from your 

studio 24/7. Find PhotoReflect options in Manage Studio > Options > PhotoReflect 

Account. 

Select Login Now to login into your PhotoReflect account. Once logged in, you can 

manage all of your account information, set up web products and pricing, manage 

your online portfolio, promotions, and view automatically generated reports of your 

sales and orders. 

Select Sign Up to make an account within the software. This requires an internet 

connection. 

Labtricity Account 
Labtricity is a network of labs that makes ordering professional lab prints and services 

easy. Once you create an account you can send orders to any Labtricity-enabled lab, 

where they will print and mail the photos back to you or ship them directly to your 

customers. Find Labtricity options in Manage Studio > Options > Labtricity Account. 

Select Login Now to log into your Labtricity account. Once logged in, you can manage 

all your account information, select labs, set up lab products and services, and view all 

current lab orders. 

Select Sign Up to create an account within the software. This requires an internet 

connection. 

System Properties 
Find this information in Manage Studio > Options > System Properties. 

This is a list of the computer properties, including used and free space, local paths, 

detected cameras and printers, and software versions. This is information is helpful when 

diagnosing any computer related problem. 
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Calibrate Monitor 
Calibration of your monitor is a vital step in managing the quality of your work in your 

studio. You can perform a monitor calibration using X-Rite Eye-One Match Software in 

Manage Studio> Options > Calibrate Monitor.  

Note: You must have the Eye-One Match Software and hardware installed on your 

computer before you can use this feature.
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Setting Up Your Network 

This software can be used in a network environment, with multiple stations for capturing, 

selling, enhancing, and printing. All of the information from each computer can be 

shared on a simple Windows network, making it easy to switch between stations without 

worrying about losing data.  

This chapter will guide you through getting all of your computers, printers, and cameras 

on a network and talking to each other. 

Typical Networks 
You will first need to determine what kind of network you wish to run. Below is a 

compilation of common network setups for different studios. If you already know which 

kind of network you plan to use, feel free to skip down to Your Network. 

Single Computer Studios 

A typical single computer studio includes one of the following setups: 

Most of these setups will do their printing through any number of local printers to fulfill 

orders. Both tethered and un-tethered cameras can be used in any setup. Tethered 

cameras will import quickly and automatically, but require you to be close to the 

system; un-tethered cameras will require an import step, but work best for mobile 

shoots. 
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Onsite Studios 

A typical onsite studio includes one of the following setups: 

These setups deliver prints on demand. Use local printers for smaller prints onsite and 

send larger prints back to your studio. The computer in this setup works as a preview 

and order station, while cameras can be tethered or un-tethered at the station, or 

roaming around with photographers and manually imported later during the event. 

 

 

Small Studios 

A typical small studio includes one of these setups: 

If one computer station is not enough, the software can 

be used with any number of stations, all capable of 

previewing and selling any photos on the server station. 

The server and client stations will be connected through 

a simple Windows network. Orders can be printed 

locally. 

Large Studios 

A typical large studio includes this setup: 

With a large customer base, you can set up even more 

presentation and sales stations, all connected to several 

different capture stations. These will all connect and sync 

with the server station, allowing all the client stations to work 

simultaneously with updated photos and data.  

  



Setting Up: Your Network 

 

50 

 

Your Network 
Now that you understand the logic, it’s time to set up your own network. 

Find these options in Manage Studio > Options > Network Options. 

Setting Up a Single Computer 

A single computer setup means you are running one copy of the software on one 

computer. The setup requires the installation of the USB dongle. This is the default upon 

installation. A single computer environment means that: 

 This computer will be used by itself. 

 All photos and data will be stored locally or on an attached external HD or RAID. 

 All print requests will be sent to printers connected directly to this computer. 

To set up a Single Computer network: 

1. Click Single Computer on the 

left side of the screen so that 

a check appears. 

2. Select a Photos Folder. This is 

automatically selected and it 

is rare that you would need 

to change it. If you do so, you 

will need to manually copy 

the existing folder contents. 

3. Select a Database 

Connection. This is also 

automatically selected. If you 

change it, the database will need to be migrated to the new location. 

4. Select Apply. 
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Setting Up a Server Computer 

A server computer is necessary if you are running the software on more than one 

computer.  

Note: A dongle must be attached to the server computer to activate the network.  

The server computer will contain all of the photos and data, and will share them with 

the client computers.  

Note: The server computer must be configured before the client computers.  

A server computer means: 

 A computer will be used, as a server, on a network. 

 All photos and data will be stored locally on this computer. 

 Printers are directly connected to this station. 

 Clients can access the photos stored in this station. 

 Clients can access data stored in this station. 

 Clients can send print requests to this station. 

To set this computer as the Server Computer: 

1. Click Server Computer on the left side of the screen so that a check appears. 

2. Select a Photos Folder. This is automatically selected and it is rare that you would 

need to change it. If you do so, you will need to manually copy the existing 

folder contents. 

3. Select a Database. This is also automatically selected. If you change it, the 

database will need to be migrated to the new location. 
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4. Notice the Server Name, IP Address, and Workgroup. When setting up a client, 

you will need to confirm these identifiers to ensure you are connected to the 

correct server. 

 

 

 

5. You will need to enable file sharing in Windows so that the client stations can 

access the photos and data on this computer. Select Enable File Sharing. 

 

 

a. For Windows XP: Follow the Network Setup Wizard to enable file sharing on 

your network. You will need to restart your computer before this takes 

effect. 

b. For Windows Vista: The Network and Sharing Center window appears. Turn 

On the following options: Network discovery, File sharing, Public folder 

sharing, and Printer sharing. Select X to exit this window when finished.  

c. You may also want to disable User Account Control (UAC) in Vista to 

eliminate recurring password and permission prompts. To do this: 

i.  Open the Control Panel and under User Account and Family 

Safety, select Add or remove user accounts. 

ii. Select Go to the main User Accounts page and select Change 

security settings. 

iii. Click to unselect the box next to Use UAC to help protect your 

computer. 

iv. Select OK. UAC is now disabled. 

6. You will need to share the photo folder in Windows so that the client stations can 

access the photos on this computer. Select Share Photo Folder. 
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a. For Windows XP: Select the Sharing tab, and select Share this folder on the 

network. The Share Name should be Photos. Select Allow network users to 

change my files. Select Apply. Select OK. 

b. For Windows Vista: Once you have enabled File Sharing, the Photos folder 

is automatically shared as a subfolder. If you wish to share the folder 

manually, you can disable sharing of public folders and enable sharing 

specifically on your photos folder only by right-clicking on it and selecting 

Share and allowing all users on your network.  

7. If you are running a firewall on this computer, you will need to disable it to allow 

database sharing. Select Disable Firewall. 

a. For Windows XP: The Windows Firewall window appears. Select to turn the 

firewall off, or to enable Studio Solution as an exception. To do this, select 

the Exceptions tab and select Add Program. Select Studio Solution and 

select OK. 

b. For Windows Vista: The Windows Firewall window appears. Select to turn 

the firewall off, or to enable Studio Solution as an exception. To do this, 

select the Exceptions tab and select Add Program. Select Studio Solution 

and select OK. 

8. Select Apply. 

Viewing and Managing Client Stations 

If you are on the Server Station, you can view all clients attached as Stations to the 

Server. 

To view all clients: 

1. Select Server Computer from the left side of the screen so that a check appears. 

2. Select View Clients from the bottom of the server screen. 

3. A window appears showing a list of all connected clients. 

a. The clients are listed by Workstation name and type (client or server). 

b. The Jobs column shows all current print jobs for each client. 

c. The Status column shows all current print jobs sent from each client station. 

Select a command at the top of the window to manage clients: 
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 Restart: restart the printing process for all clients. 

 Stop: stop the printing process for all clients. 

 Power Off: turn off the print server. 

Setting Up a Client Computer 

A client computer is necessary if you are running the software on more than one 

computer. The client can access all of the photos and data on the server computer 

and is typically used as a sales station, capture station, retouch station or reception 

station. The Server Computer must be set up before the Client Computers. A client 

computer means that: 

 This computer will be used on a network. 

 All photos and data will be stored on the server computer. 

 All print requests will be sent to the server computer. 

To set up a Client Computer: 

1. Click Client Computer on the left side of the screen so that a check appears. 

2. Verify that the Server Name, IP Address, and Workgroup are pointed at the 

correct server. 

 

3. The default is to automatically detect the server computer. If you wish to 

connect to the server computer manually, select Manually specify the computer 

name of the server computer and enter the computer address. 

4. Select Test Server to test the connection. If the connection fails, you will need to 

check your network connections and settings. 

5. If all connections are working, select Apply. 

6. Check the Print Server Status, Server Photos Folder, and Database Connection. 

These should all show Connected. If they show Not Connected, return to Setting 

Up a Server Computer and follow the steps in the section. If the connection still 

fails, you will need to check your network connections and settings. 
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7. Your Client Computer has been set up successfully. 

8. Repeat Steps 1 – 7 on all other client stations. 

Connecting Printers 
Now that we’ve finished with basic settings and have the network up and running, it’s 

time to connect and add any printers that you’ll be using. Find printer options in 

Manage Studio > Printers. 

Printers should be directly connected to the server station or through a network hub, so 

that each client can communicate with the server and use the printer. If you are using 

a single computer setup, connect the printers directly to your computer or through a 

network hub. 

There are many different types of printers you can use with the software: 

 Canon Pixma Pro (9000 & 9500 

Mark I and II) 

 Canon IPF Series (5100, 6100, 

6200, 8100, 9100) 

 Any Windows Printer 

 Raster File Printer 

If you have installed the proper printer driver and have the printer connected via USB, 

the software will automatically recognize it. If a printer is not automatically detected, 

select [Add] for that printer type and select your printer from a list. If the printer does not 

appear in the list, please confirm the printer’s detection within the Windows operating 

system. 
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Setting Up a Canon Printer with Direct Connectivity 

Some Canon printers have direct connectivity with the software. You’ll only need to 

plug it in, turn it on, and attach it to the computer. The software will instantly recognize it 

and set it up, no drivers are necessary, when connected directly via USB. 

The following Canon printers support direct connectivity: 

 Pixma Pro 9000, 9500 Mark I and II  IPF 5100, 6100, 6200, 8100, 9100 

To add and set up a Canon printer with direct connectivity via USB: 

1. Attach the printer to the computer. 

2. The printer will be automatically detected and added to the Canon printers list. If 

it is not automatically detected, select [Add Canon Printer] and select your 

printer from the list. 

3. Select [Setup] to the right of the printer. A window appears. 

4. There are four tabs of options: Main, Roll-sizes, Sheet-sizes, and Margin Text. 

a. Main:  

i. Select Enable this printer to activate the printer. This is turned on by 

default. 

ii. Select a Paper Source, Roll Width, Media Type, Media Rule, and 

whether to auto-cut and allow borderless printing. 

iii. Select Advanced Printing Preferences for the Windows printing 

preferences. 

b. Roll-sizes: 

i. Select New to add a new roll-size. Select width, arrangements, 

color profile, and offsets. 

ii. Select a roll-size and select Edit to modify an existing roll-size. Edit 

width, arrangements, color profile, and offsets. 

iii. Select Reset List to set the list to printer defaults. 

iv. Select Delete to delete a roll-size. 

c. Sheet-sizes: 

i. Select a sheet-size and select Edit to modify an existing sheet setup. 

Select width, height, media, arrangements, and a color profile. 
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ii. Select Delete to delete a sheet-size. 

iii. Select Reset List to set the list to printer defaults. 

d. Margin Text: 

i. Select Control options for if and when to print margin text. 

ii. Enter text to appear on lines 1 and 2 at left, center, and right 

justification. 

iii. Select Insert Special Text to enter pre-made text for customers, 

dates, packages, and other information. 

iv. Select Restore Default Text to set the text to printer defaults. 

 

5. Select OK to save printer settings. 

Setting Up a Canon or Windows Printer 

The steps for adding a Canon and Windows printer are the same, except some Canon 

printers will be automatically detected and added to the list.  

To add and set up a Canon or Windows printer: 

1. Attach the printer to the computer. 

2. The printer will be automatically detected and added to the Canon or Windows 

Printers list. If your printer is not automatically detected, select [Add Printer using 

standard Windows Driver] and select your printer from the list. 

3. Select [Setup] to the right of the printer. A window appears. 

4. Select Properties to set up basic Windows printing preferences. 

5. Select Advanced to set advanced options:  

a. Media & Profile:  

i. Select Use a color profile for this device and browse to a color 

profile location if you want to use a specific color profile. 

ii. Select Media Rules and the corresponding media to sent specific 

items to specific printers. 

iii. Set the Bleed amount in pixels and select if you want to Apply 

bleed on wallets & arrangements. 
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b. Margin Text: 

i. Select Control options for if and when to print margin text. 

ii. Enter text to appear on lines 1 and 2 at left, center, and right 

justification. 

iii. Select Insert Special Text to enter pre-made text for customers, 

dates, packages, and other information. 

iv. Select Restore Default Text to set the text to printer defaults. 

6. Select OK. 

7. Select a Page Size. 

8. Select Arrangements for that page size: use Quick Setup to quickly add or delete 

print sizes of one type. Select OK when finished. 

9. Select OK to save printer settings. 

Setting Up a Raster Printer 

A raster image printer will output each print as an image file on your computer. The 

image file size and type can be specified for output. This is especially useful when you 

want to modify the image size and output as another file type. 

To add and set up a raster printer: 

1. Select [Add Raster Printer]. A window appears. 

2. Select the print size of this image printer.  

3. Select Options: 

a. Confirm or change the print size. 

b. Select Enabled to activate this image printer. 

c. Select Copy Settings to copy the settings from another raster printer. 

d. Select Orientation options. 

e. Select the Print Area and Bleed options. 

f. Select the Output Folder, output File Type, Filename Format, and the 

filename and variable to start with. 
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4. Select Media & Profile: 

a. Select Use a color profile for this device and browse to a color profile 

location if you want to use a specific color profile. 

b. Select Media Rules and the corresponding media to sent specific items to 

specific printers. 

5. Select Margin Text: 

a. Select Control options for if and when to print margin text. 

b. Enter text to appear on lines 1 and 2 at left, center, and right justification. 

c. Select Insert Special Text to enter pre-made text for customers, dates, 

packages, and other information. 

d. Select Restore Default Text to set the text to printer defaults. 

6. Select OK to save printer settings. 

Managing Connected Printers 

If you need to edit the settings of any connected printer, simply return to the printers 

tab and select [Setup] for the printer you want to edit. Follow the steps for that printer 

from the guides above. 

Note: Printer settings are not accessible via a Client Station. Since printers are 

connected to the Server Computer, they are only accessible via the Server. 

Connecting Cameras 
The software is almost ready to use, you just need to determine how photos will be 

captured and imported. Find the camera settings in Manage Studio > Cameras. 

Photos can be captured and brought into the software in a number of ways: 

 Tethered Camera: the camera will be directly 

connected to the software through a USB or 

Firewire cable. Each time you take a photo, it 

will appear instantly in the software. 

 WiFi Camera: the camera will wirelessly 

transmit photos to the software as they are 
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captured. If you roam out of range of the network, all new photos will be 

transmitted when you return. 

 Hot Folder Camera: a hot folder is a folder on your computer that is continuously 

sending any new photos from that folder straight to the software. Set a hot folder 

if your camera (or cameras) are importing photos to a specific folder. 

 No Camera: no camera will be connected. All photos will need to be manually 

imported from Compact Flash, file folders, or external drives. 

Setting Up a Tethered Camera 

Any professional Canon compatible cameras can shoot and send photos directly to 

the software while connected through a USB or Firewire cable. 

To set up your tethered camera: 

1. Select Tethered Camera from the left side of the 

software under Select Camera Type. 

2. Connect the camera to the computer with a USB 

or Firewire cable. 

3. Turn the camera on. 

4. Wait for Windows to detect the camera and 

prepare it for use. 

5. If the software does not detect the camera and 

display it on the left side of the software, select Detect Camera. 

6. The camera name will appear in the status bar at the bottom left of the 

software, and at the top center of the Cameras page. 

7. Your camera is now ready to shoot tethered.  

While you are using a tethered camera, you can press SPACE on your keyboard to 

automatically capture and import photos into the Photo Library or Photo Workshop. For 

a detailed guide of capturing and importing photos, go here. 

Setting Up a WiFi Camera 

The software can receive photos wirelessly from any Canon Wireless File Transmitter 

(WFT) using an FTP server. You will need to have a wireless internet connection set up on 

your computer to use a WiFi camera. 
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To set up your WiFi camera: 

Select WiFi Camera from the left side of the software under 

Select Camera Type. 

1. Make sure the Canon WFT is connected to your 

camera. 

2. Turn the camera on. 

3. Use the WFT connection wizard through the camera 

menu. For more details on finding the WFT wizard, refer to the camera manual. 

4. Select FTP as the communication method in the camera wizard. 

5. Enter your wireless network & router settings in the camera wizard. 

6. Once the FTP Server settings appear on your camera, enter the FTP Address and 

FTP Port listed on the Cameras page in the software. You must have Auto-Detect 

Address checked for this option. 

7. Once Login Method appears on your camera, use either ―Anonymous‖ or match 

the username and password that you entered on the Cameras page. You must 

have Anonymous Username checked to login anonymously without a password. 

8. Once Target Folder appears on your camera, select Root Folder. 

9. Complete the Wizard. 

10. Your WiFi camera is now ready.  

A WiFi camera is essentially a tethered camera without a cable. While you are using a 

WiFi camera, you can press SPACE on your keyboard to automatically capture and 

import photos into the Photo Library or Photo Workshop. For a detailed guide of 

capturing and importing photos, go here. 

Setting Up a Hot Folder  

You can set up a folder to automatically import all new photos added to that folder. 

The software will continuously monitor this folder for any photos added by you or a 

camera. 

To set up a hot folder: 

1. In Local Folder, browse to or type in the folder to monitor. 
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2. You can automatically backup every photo to another directory for 

safekeeping. If you want to backup your hot folder photos, browse to or type in 

the backup location in Backup Folder. 

3. Select Apply. 

Importing without a Camera 

To import without a camera, you will need to connect the camera picture card, 

external drive, or browse to the folder containing the photos and manually import 

them. Go here for more information on importing photos. 

Setting Filename Options 

Regardless of how you import photos, you can set the software to generate new 

filenames for all photos you import. Find these options in Manage Studio > Cameras, 

and select Changed File Naming Options from the middle of the screen. 

Select a bubble to set new photo filenames. The following filename options are 

available: 

 Automatic: the unique filenames will be based off the day and time or the 

Filmbar number. You can add a prefix for the filenames in the textbox. An 

example of your format will appear.  

Note: The Filmbar is displayed on the left side of the Photo Workshop window when 

Single is selected at the upper left hand corner of the window. The Filmbar number is 

the number displayed under the image. 

 

 Numbered: the unique filenames will be numbered, starting incrementally from 

the starting number you specify. You can add a prefix for the filenames in the 

textbox. An example of your format will appear. 

 Customer Driven: the unique filenames will be based off the customer ID and 

one of the following: date and time, picture number, or picture name. Select to 

Show the filename dialog for every picture taken if you want to view filename 

info for imported photos.  
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Setting Up Your Products 

Now that the general options are set and your network is working, it’s time to set up 

some products and prices. 

Creating Products 
Find these options in Manage Studio > Products > Packages and Prices. This is where you 

will create and edit all packages, products, and prices for your studio.  

Products are structured like this: package groups will contain individual packages, and 

each package will contain individual products.  

 

Note: Make sure all client stations are closed prior to making any changes to Packages 

and Prices. The clients will automatically update upon launch. 

Creating a Package Group 

Package groups are convenient for holding a number of packages and products 

specific to an event. By creating multiple package groups you can switch between the 

offered groups depending on your event, removing unnecessary packages and clutter 

from the Shopping Cart.  

To create a new package group: 

1. Select + Add New Group from the tabs near the top of the Products window. A 

prompt will appear. 

2. Type in new group name for this package group. 

3. If you want to copy an existing package group, select Copy of and select the 

group you wish to copy from the dropdown menu. 
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4. If you want this package to be available online through your PhotoReflect site, 

select Allow this package to be used with your online storefront. You must be 

logged into your PhotoReflect account for this selection to be active. 

5. If you want to have the option of quickly adding last-minute print items to orders 

in the Shopping Cart, select to show the Add Lab Print Items and/or the Add 

Local Print Items options. 

6. Select OK. 

7. You will be prompted to add package item to this group. Select the type and 

quantities of the items you would like to offer to your customers. Select Cancel to 

add packages later, or read the following sections. 

Editing a Package Group 

To edit a package group, select Edit Package Group near the bottom of the window to 

change the selected package group settings. To delete a package group, select 

Delete Package Group to remove it. You must always have at least one package 

group available for use. 

 

 

Adding Packages 

Packages are subgroups of package groups that can contain any number of individual 

items, for sale for one total price.  

To create a package: 

1. Select the package group you wish to add the package to. 

2. Select Add Product from the options near the bottom of the Products window. A 

prompt appears. 

3. Enter a package name and a price. This is the total price of every product 

included in the package. 

4. Select Discount Pricing if you want to create a volume discount. Volume 

discounts encourage your customers to purchase more pictures per order. Use 
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Add, Edit, and Remove to adjust volume discounts and set prices. The largest 

discount for an order will always be applied automatically. 

5. Select A la Carte Package if you want to allow purchase of individual products 

within this package. 

6. Select Quick Print if you want to print this package immediately upon purchase. 

7. Select High Priority if you want to print this package before other orders in the 

queue. 

8. Select OK. 

Editing a Package 

To edit a package, select [Edit Product] near the top of the window and change the 

selected package settings. To delete a package, select [Remove Product] to remove 

the selected package. Select Expand All or Collapse All to see every item and 

package included in the selected package group. 

Creating a Product 

Products are individual items that are included in a package. You can select the 

number of prints, printing media, any special print commands, templates, and services 

to be automatically applied to a product. 

To add a Product: 

1. Select both the package group and the package you wish to add the product 

to. 

2. Expand the package by selecting the down-arrow to the left of the package 

name. 

3. Select [Add Item]. A prompt appears. 

4. Select Fulfiller to determine who will print the item. You can choose to fulfill the 

item yourself (Local Print), or log into your Labtricity account and select a lab to 

fulfill the item. If you select a lab, the product list will only show items they offer. 

5. Select Print Group to filter the list to a particular print size. 

6. Click on an item to add it to your package. Use the arrows under Count to select 

the number of prints.  
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7. If you wish to add additional items to the package, click on another item and 

select the number of prints. There is no limit to the number of items you may add. 

Select Clear Quantities to reset the list and start over. 

8. When finished, select OK. 

 

 

Editing a Product 

Once you have created a product, it will appear in your selected package with a list of 

possible commands and preferences. Select [Edit Item] to change the product name, 

price, size, fulfillment, or any of the options from the list below. Select [Remove Item] to 

delete it.  

Click on any available link to quickly add or edit a product feature: 

 Fulfillment: Select where the product will be printed (local or lab). This option can 

only be changed by selecting [Edit Item]. 

 Media and Print Commands: Select to add or edit the type of printing material or 

special printing commands. 

 Template: Select to assign a template with this product. Templates can be 

graphics, layouts, overlays, or text.  

To associate a template with this product: 

1. Select Always use a border for this package item. 

2. Select Choose. A window appears. 

3. The top of the window includes all borders currently in the software, while 

the bottom shows borders for sale from the online Template Marketplace. 

Use the tabs and arrow keys to navigate and select a border, then select 

OK. 

4. The Border Name and description field is automatically populated. 
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5. Select the Tile Layout for how the border appears: once, tiled with the 

same photo, or tiled for use with different photos. 

6. Select the Orientation: best fit, landscape, or portrait. 

7. Select the Placement. 

8. If you want to add or edit text, select Use default border text. Select Edit 

Default Border Text to view and enter new text. A template must have text 

included for this option to be available. 

9. Select OK. 

10. This template will always be automatically applied to this product. 

 Services: Select to add or remove existing services to a product. You must have 

created services for options to be available. 

Adding Digital Delivery Products 

A Digital Delivery Product lets a photographer select an entire catalog or specific 

photos in a catalog and within just a few clicks, send the images to CD/DVD or file. 

Preview thumbnails, 

Watermarks, slideshows complete with music, and any additional files can be added to 

the digital media.  

In order to sell your digital media, you need to set up a package to add to your 

package groups. This will allow you to easily add a Digital Media option to your 

shopping cart for a CD you will be creating locally. The Digital Delivery Product can be 

assigned as its own package or added as an additional item to an existing package.  

To add as a Package: 

1. Select Add Product. 

2. Assign the package a unique name and price. 

3. Select OK to save. 

4. Select the new package and select [Add Item]. 

5. Select Digital Delivery Products from the Print Group dropdown list. 

6. To customize this product, select [Edit Item]  to change any of the 

components 
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There are four components for creating a digital delivery product: General, Slideshow, 

Extra Files and Summary. ―General‖ is the general options settings for the digital output, 

such as where the media will be sent, the media format, and media size. The 

―Slideshow‖ component allows you to export an interactive slideshow with the media, 

complete with music and promotional logos/images. The ―Extra Files‖ component 

allows you to export any additional files to the media, such as music or text files. 

―Summary‖ is a quick list of all the features available, and allows you to remove or 

change options. 

              

General 

The first page within the Digital Delivery Wizard is the General component. The Format 

page contains all the vital information necessary for exporting your digital media. There 

are four options on the Format page: ―Destination Information,‖ ―Photo Format,‖ 

―Image Size,‖ and ―Advanced Options.‖ 

 Destination Information: Destination Information is where you set the location for 

the exported media. Click the drop-down box to select a destination. Selecting 

―<Browse Folder>‖ will let you search your computer for a folder or drive. You can 

choose a folder on your computer or network, a storage device, or choose to 

copy the files to a CD or DVD. If you choose a CD or DVD, make sure you have a 

disc in the drive before attempting to burn the media. 



Setting Up: Your Products 

 

69 

 

 Photo Format: Photo Format is where you set how the images will be copied. 

There are three options: Permanently apply attributes, Copy the images, or 

Convert the images to another format while copying.  

o Permanently apply attributes will save all of your current changes in the 

Photo Workshop, but will combine all the layers and copy the images as 

one single image layer.  

o Copying the images will keep all layers intact, and copy the files exactly 

as they are in Studio Solution.  

o Converting the images to another format while copying will only convert 

the format of the images on the new media, the originals will remain in 

their current format, unchanged. If you choose ―Convert the images to 

another format while copying‖ you will be able to click the drop-down 

box and select an image format. If you do not select an option from the 

list, the images will be copied as .JPG files. The other available formats 

are: Windows Bitmap (.BMP), ZSoft (.PCX), Photoshop (.PSD), Portable Net 

Graphics (.PNG), Targa (.TGA), Tagged Image File (.TIF). 

 Photo Size: Photo Size determines the dimensions in pixels of the copied photos. 

There are four size options: Preview Size (smallest size, approx: 640x480 pixels), 

Medium Size (approx 1280x800 pixels), Full Size (largest size, full resolution), and 

Custom Size. To enter a size, click on the drop-down menu under “Choose the 

size of images you would like to save for the customer” and select one of the 

options.‖ 

If you choose a custom size, the ―Width‖ and ―Height‖ boxes will become 

available. Use the arrow keys to increase each dimension by 1 pixel, or click the 

text field and type in a number. Custom sizes will not automatically keep an 

aspect ratio. If you enter a width or height that does not keep the current aspect 

ratio of the images, Studio Solution will fit the larger dimension to the picture and 

crop out any parts of the shorter side that are beyond the specified dimensions. 

 Advanced Options: Advanced Options will allow you to add a watermark to the 

copied images. Watermarks are semi-transparent graphics, repeated over the 

picture to deter image theft and unauthorized copies of the original picture. To add 

a watermark to the copied images, check the box next to “Would you like to add a 

watermark to these images?” Uncheck the box to disable this option. 

  



Setting Up: Your Products 

 

70 

 

Slideshow 

The second page in the Digital Delivery Wizard is the Slideshow component. It is possible 

to export a slideshow of all the photos along with the photos themselves. You can also 

add music and promotional images to the slideshow. 

              

 

To enable a slideshow for the digital media, click the ―Slideshow‖ tab at the top of the 

Digital Delivery Wizard window, and check the box next to ―Would you like to add a 

slideshow to the digital media?‖ Un-checking this box will disable the slideshow option. 

The Slideshow page has four options after enabling the slideshow:  

 To enter the number of seconds for each photo to be shown before switching to 

the next, click the number and type in the desired number of seconds, or use the 

arrow keys to increase or decrease seconds by one. 

 To enable smooth fades between photos, check the box next to “Do you want a 

smooth fade in/out transition in the slideshow?” If the option is enabled, each 

photo will slowly fade to black, and the next will fade in from black. If the option 

is disabled, the slideshow will instantly jump from photo to photo when the time 

has elapsed. 
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 To add a music file to the slideshow, click the “Browse” button under “Select the 

music file you would like played for the slideshow.” Select the file on your 

computer, network, or drive that you would like in the slideshow, and click ―OK.‖ 

Leaving this field blank means no music will be played during the slideshow. 

 

 To add promotional images to the slideshow, click the “Browse” button under “If 

you would like to add promotional images to the slideshow select the directory 

that contains the promotional and stock photos.” Select the directory or folder on 

your computer, network, or drive that contains your stock or promotional images, 

and click ―OK.‖ Now when a slideshow is viewed, the promotional images you 

selected will be shown in the slideshow in between transitions from photos. 

Leaving this field blank means no promotional or stock images will be shown 

during the slideshow. 

 

 

 

Extra Files 

The third page of the Digital Delivery Wizard is the Extra Files step. This step allows you to 

add any additional files to the digital media. For instance, you could attach stock 
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images of templates you can provide, or a price list, or even a copy of the customer’s 

receipt. 

To add extra files to your digital media, click the box next to “Would you like to add 

additional files to the digital media?” The second option will now become available. 

First, place all of the desired files into one folder. Everything in this folder will be added 

as an extra file. You do not need to include the photo files in this folder, they will be 

exported separately. Once you have moved all of your desired files into one folder, 

type the folder location into the empty field or click the browse button to locate it, and 

click ―OK.‖ 

Summary 

The fourth and final page of the Digital Delivery Wizard is the Summary step. This step 

shows a list of all the options you chose in the first three steps and gives you the 

opportunity to check and change them. 

The Summary page is made up of links. There are four headings, one for each section of 

the Digital Delivery Wizard: General, Slideshow, Extra Files, and Summary. Clicking on 

one of these headings, or any of the links under it, will take you back to that page of 

the wizard and allow you to change every option on the page. 
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Notice that the links below each heading include each specific option you have 

already selected. You can quickly scan the choices you have made without returning 

to every page of the wizard to check them.  

The Digital Delivery Wizard saves these settings for all future digital media. Whenever 

you start the Digital Delivery Wizard, the Summary page will always contain the options 

used for burning the last digital media. This allows you to quickly start the wizard, click 

on the Summary page, and burn the media immediately if you want the same options 

selected as last time. If you need to change the location, a watermark, or the music, 

just click the appropriate link, change it, and return to the Summary page to burn the 

media. This will save you a lot of time, since you do not need to complete the entire 

wizard every time you need to create digital media. 
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Adding Services 
Now that you’ve created some products, let’s move on to other product-related 

options. A service is any kind of retouching or editing in addition to normal photo 

editing, such as removing stray hairs or erasing braces. 

Services may be added to any product or order. Each service has a cost that will be 

included in the order total. Find service options in Manage Studio > Products > Studio 

Services. 

Studio services will appear in a list with the description, your price, the lab wholesale 

price, and printing information. You will need to determine the service, the cost, and if it 

will be a pre-print or post-print process. 

 

 

Note: Make sure all client stations are closed prior to making any changes to Studio 

Services. The clients will automatically update upon launch. 

Adding a Local Service 

A local service is something you will provide for the customer on your own time without 

the use of a lab. 

To add a local service: 

Select Add Local Service. 

1. Select a service from the list or create a new service. 

2. Select a pre-print or post-process service. 

3. Select a price.  

4. Select OK. 
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Adding a Lab Service 

A lab service will be provided by one of your Labtricity labs. Each lab will offer different 

services at different prices. You will see the lab’s wholesale cost so that you may mark 

up appropriately. 

To add a lab service: 

1. Select Add Lab Service. 

2. Select a lab from the dropdown box. 

3. Select a service from the available list. 

4. Select OK. 

Editing a Service 

Select Edit or Remove in the Studio Services list to modify or delete an existing service. 

Managing Templates 
Templates are borders, backgrounds, text, overlays, or composites to be applied to 

products. We’ve already covered assigning templates as you create products, so now 

we’ll worry about managing groups and organizing existing templates. Find these 

options in Manage Studio > Products > Templates and Composites.  

Viewing Templates 

Directly under the Studio tabs you will find a list of template tabs. Each tab includes 

multiple templates of that type. Templates are organized in groups, and those groups 

contain all related subgroups. For example: Sample Borders is a group containing 

several subgroups, such as sports, composites, and holidays.  

 

 

 

Use the < and > arrows to the left of the template tabs to jump back or forward within 

the template tabs, and click on a specific title to view template of that type. The left-
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most template title is the current group you are viewing; all group titles to the right are 

subgroups of that group. 

 

 

 

For advanced viewing options, select Options from the top right of the window: 

 Change Group: select a different group to view the templates of that group. 

 Show File Description: select this to list the file description beneath each 

template. 

 View Border Thumbnails or View Border List: select thumbnails to view miniature 

previews of the template, or select list to view a vertical list of file descriptions. 

 View Border Info: select a template and select this option to view the filename, 

path, file size, creation date, and file description of your selected template. 

 Thumbnail Size: select to change the size of the template thumbnails. 

 List: select any template subgroup to view the templates of that group. 
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Adding Groups 

To add a new group: 

1. Select New Group from the bottom of the software.  

2. Select to create a Top Level group that will contain subgroups, or to create a 

Subgroup that will be added to the current group.  

3. Select a name for the group. 

4. Select OK. 

Removing Groups 

To delete the group you are currently viewing: 

1. Select the group you want to remove. 

2. Select Delete Group from the bottom of the software. 

3. Select to delete the current top level group, or to delete the current subgroup 

you are viewing. 

4. Select the name of the group you wish to delete. 

Editing Groups 

To rename a group: 

1. Select the group you want to rename. 

2. Select Edit Group from the bottom of the software. 

3. Select to rename the current top level group, or to rename the current subgroup 

you are viewing. 

4. Select the name of the group you wish to rename. 
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Setting a Default Group 

The default template group will open automatically when you want to select a border 

in any other part of the software. To set a default group, select a group and select 

Make Default from the bottom of the software. 

Creating Templates 

You can create your own templates in the Border Workshop, detailed here. Select New 

Template to automatically open the workshop and start creating a template. 

Importing Templates 

You can import any templates you have downloaded or created into the software.  

To import a template: 

1. Select the group and subgroup you want to add the templates to. 

2. Select Import Template from the bottom of the software. 

3. Browse to the location of the templates. 

4. Select individual templates and select Add Selected to import them. 

5. Select Add All to import all templates in this location. 

6. Select Add All Subdirectories to import all templates in this location and in any 

folders and subdirectories of this location. 

Deleting Templates 

Select an individual template and select Delete Template from the bottom of the 

software to remove it from this group. The file will not be deleted. 

Editing Templates 

To edit an existing template in the Border Workshop, select an individual template and 

select Edit Template from the bottom of the software. The template will open in the 

workshop, where you can edit and save your changes.  
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Shipping Options 
You will need to set up shipping options for different methods and for shipping to 

different countries. This is where you will create and edit all shipping methods, groups, 

and prices. Find these options in Manage Studio > Products > Shipping Options. 

 

Note: Make sure all client stations are closed prior to making any changes to Shipping 

Options. The clients will automatically update upon launch. 

Setting Up the Default Group 

A default shipping group is created automatically. To customize a shipping group: 

1. Set a Handling Cost for each shipment. This 

is your basic cost for packaging and 

shipping and does not include the actual 

mailing costs. 

2. Select [Add Country] to set your shipping 

rules for a particular country, or copy your 

shipping rules from an existing country. 

3. Select Add Shipping to add a shipping 

method and price. A prompt appears. 

4. Select from Pickup, Standard, Priority, 2nd Day, or Overnight. 

5. If you wish to charge a different price for orders over a specific amount, enter 

that amount in the top box and your adjusted price in the bottom box. A new 

rule must be created for each price you wish to charge. 

6. Select Add. 
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Adding a Shipping Group 

Shipping groups make it easy to apply a different set of shipping rules for different 

events. For instance, you would probably charge more for shipping wedding photos 

than for studio portrait photos; simply create two identical shipping methods with 

different prices in different groups and associate the desired shipping group with a 

particular event, without needing to edit or return to this settings page.  

Select [Add Group] to create a new shipping group. Follow the steps above to 

customize it. 

Editing a Shipping Item 

To edit or remove a shipping group, country, or shipping method, select the [Edit] or 

[Delete] options on the right. 

Handling Cost 

Handling costs are optional fees that can be charge to each order. A single cost will be 

applied to all orders. 

To add a Handling Cost, enter an amount then select [Save Handling] at the bottom of 

the page. 

Tax Information 
You will need to set up tax information for your studio. Find these options in Manage 

Studio > Products > Tax Information. 

Note: Make sure all client stations are closed prior to making any changes to Tax 

Information. The clients will automatically update upon launch. 

Local Order Sales Tax 

If you wish to automatically charge sales tax for orders created on this computer, enter 

the sales tax rate. 
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Shipping and Handling Tax 

Most states and provinces charge sales tax on shipping and handling. By default, the 

software will charge sales tax on shipping and handling.  

Note: You must check the box if you do not want to charge the local tax rate for 

shipping and handling on your local orders. 
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Setting Up Your Studio 

Now that the software is set up and you have products ready to go, it’s time to prepare 

your studio for business. We’ll start by adding users, vendors, and customers to your 

database. 

Vendors and Inventory 
Running a studio can require a lot of materials. Setting up your vendors and inventory 

will help you keep track of all your supplies and usage. Find these options in Manage 

Studio > Vendors. 

Adding a Vendor 

Keeping a list of vendors in the software will make it easy to reorder supplies. Find these 

options in Manage Studio > Vendors > Setup Vendors.  

 

 

 

To add a vendor: 

1. Select New Vendor. 

2. Enter a Vendor Name and Account Number. 

3. Enter Contact Details. 

4. Select Save Vendor. 

Editing a Vendor 

All vendors are listed by name with a contact name and phone number. Click on an 

existing vendor name to view the information. Select Delete Vendor from the 

information screen to remove it. 
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Adding an Inventory Item 

Keeping track of your inventory will reduce costs and ensure that you never run out of 

an item. Find these options in Manage Studio > Vendors > View Inventory On Hand. 

 

 

 

To add an inventory item: 

1. Select New Item. 

2. Enter the Item Name and Description. 

3. Select a Vendor from your list of vendors. If you need to set up vendors, scroll up 

to the previous section. 

4. Enter the Vendor SKU. This is the vendor’s serial or product number they use to 

keep track of their products. 

5. Select an Inventory Type or select [Add Type] to create a new one, such as 

Paper or Ink. 

6. Enter your current quantity. 

7. Enter the item cost. 

8. Enter the purchase date manually or select the calendar button and choose a 

date. 

9. Select Save Item. 

Inventory items are listed by name, SKU, quantity purchased, quantity on hand, cost, 

and purchase date. Click an item name to return to the information page and edit or 

delete it.  
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Updating Used Inventory 

It is important to keep track of each used item to ensure that your inventory is accurate. 

Find these options in Manage Studio > Vendors > View Used Inventory. 

 

 

 

To update your used inventory: 

1. Select Enter Used Item, or click an item name from the list. 

2. Select an inventory item. Check the SKU to verify you have the right one. 

3. The new window will show all information for the item. 

4. Enter a reason for using the item. 

5. Enter the quantity used. 

6. Enter the use date manually or select the calendar button and choose a date. 

7. Select Save Item. 

Your current inventory will update automatically with your total, used, and remaining 

items. 

 

Employee Setup 
Any person using the software can be set up as an employee. This will allow the 

Administrator to manage the time of every employee. Each employee can have their 

own login, schedule, permissions, and can be assigned tasks and bookings.  
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Find the employee options in Manage Studio > Employees. 

 

 

Adding a User Role 

We will begin with creating user roles, because each employee will need to be 

assigned one during the employee creation process. User roles determine which parts 

of the software the employee can access. For instance, a manager will probably be 

given access to every part of the software, while an entry-level sales or photographer 

will probably not be given access to system settings, inventory, or networking options. 

To add a user role: 

1. Select Edit Roles from the right side of the window. 

2. A list appears of existing user roles. Select one of these roles to edit, or select New 

Role to add one.  

3. Enter or edit the Role Name. 

4. Set the permissions to determine which features of the software this employee 

can access. Check the list below for more details on each feature. 

5. Select Save Role. 

Editing User Roles 

Click an existing role to edit, rename, or delete it. 

Permissions 

Here is a list of all user role features. Check a permission to allow that role to use the 

feature: 

 Schedule View: has access to view the Calendar tab. 

 Customers View: has access to view the Customers tab. 

 Employee View: has access to view the Employees tab and check in/out. 

 Vendor View: has access to view and use the Vendors tab. 
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 Products View: has access to view and use the Products tab. 

 Printers View: has access to view and use the Printers tab. 

 Cameras View: has access to view and use the Cameras tab. 

 Reports View: has access to view and use the Reports tab. 

 Options View: has access to view and edit the Options tab. 

 Photo Library: has access to view and edit items in the Photo Library. 

 Photo Workshop: has access to view and edit items in the Photo Workshop. 

 Orders: has access to view and edit orders in the Orders tab. 

 Add Task: has access to add and assign tasks. 

 Edit Task: has access to edit existing tasks. 

 Delete Task: has access to delete tasks. 

 Add Customer: has access to create new customers. 

 Edit Customer: has access to edit existing customers.  

 Delete Customer: has access to delete existing customers. Note: This role should 

be limited to the Administrator. 

 Add Employee: has access to create new employees. Note: This role should be 

limited to the Administrator. 

 Edit Employee: has access to edit existing employees. Note: This role should be 

limited to the Administrator. 

 Delete Employee: has access to delete existing employees. Note: This role should 

be limited to the Administrator. 

 Create, Edit, & Delete Role: has access to create, edit and delete roles. Note: This 

role should be limited to the Administrator. 

 Add Note: has access to creating notes for bookings, customers, and employees. 

 Edit Note: has access to editing existing notes for bookings, customers, and 

employees. 

 Delete Note: has access to delete existing notes for bookings, customers, and 

employees. 

 Online: has access to PhotoReflect options. 

 Labtricity: has access to Labtricity options. 
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Suggested Role Setups 

The following are examples of how the roles should be assigned: 

 Administrator: The studio administrator should have all of the permissions 

checked. If a password was not assigned when the software was first installed, it 

should be created and saved before adding other employees. 

 Manager: The manager role can be assigned all permissions with the exception 

of Edit Employee and Create, Edit, & Delete Role. These permissions should be 

left to the studio administrator. 

 Photographer: The photographer role can be assigned all permissions with the 

exception of Add Employee, Edit Employee, Delete Employee and Create, Edit, 

& Delete Role. 

 Sales: A Sales role can be given all permissions with the exception of any 

management related tasks. 

These roles are only suggestions and can be named and assigned any permission that 

can work in your studio. 

Adding an Employee 

Now that we have created or updated a user role, we can add some employees to 

your studio. From Manage Studio > Employees, you can view a list of all existing 

employees, their roles, schedules and an option to sign them in. Let’s start with creating 

an employee. 

To add an employee: 

1. Select New Employee from the right side of the window. 

2. Enter the employee’s name, an employee ID or internal username, and an 

optional password they will use to check in and out of the software. 

3. Select a Studio Role for the employee. Select [Edit Roles] to edit or create a new 

role, following the steps in the previous section. 

4. Select a status for this employee. Select [Add Status] to create a new one. 

5. Enter the employee contact information. 

6. Select Save. 
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You will be taken back to the employee list. Click on an employee’s name to see the 

employee details. Here you will find the employee’s home page, complete with 

contact information, notes, schedule, and all assigned tasks. You will learn more about 

these options later. 

Editing an Employee 

Select an employee’s name from the list to enter their home page. Select Edit 

Employee from the bottom of the window to edit any employee information or assign 

them a different role. Select Delete Employee to remove them. 

Import and Export File 

Information from an external program, in either .csv or .txt format, can be imported in 

the software. This can make the setup faster to complete. 

Once the employee setup has been completed, you should export the data for 

backup purposes. The file can also be used by other external programs as well. 

Customer Setup 
You can store any number of customers in the software, whether they are active, 

inactive, or a lead for a future shoot. Find the customer options in Manage Studio > 

Customers. 

 

 

Adding a Customer 

Customers are listed here alphabetically (by last name) with a contact phone number 

and email. 

To add a new customer: 

1. Select New Customer from the right side of the window. 

2. Enter the customer name, address, and contact information. 
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3. Enter the customer status. Select [Add Status] to create a new one. 

4. Select [Add Family Member] if you want to associate relatives of the customer 

with this account. Enter the relative information and select Add Family Member. 

5. Select Save Customer. 

You will be taken back to the customer list. Here you will find the customer’s home 

page, complete with all bookings, calls, notes, and orders. You will learn more about 

these options later. 

Note: Duplicate customers can be created. Make sure you enter all the pertinent 

information (middle name, email address, etc.) to differentiate the customers. 

Editing a Customer 

Click on a customer’s name to see the customer details. Select Edit Customer from the 

bottom of the window to edit any customer information. Select Delete Customer to 

remove them. 

Import and Export File 

Information from an external program, in either .csv or .txt format, can be imported in 

the software. This can make the setup faster to complete. 

Once the customer setup has been completed, you can export the data for backup 

purposes. The file can also be used by other external programs as well. 
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Using Studio Solution 

Now that we’ve set up the software, your products, and added customers and 

employees, it’s time to get to work. We’ll start with basic functions and navigating 

around the studio. 

Find and select the Manage Studio tab at the bottom of the software. 

Basic Studio Functions 
Although there are many different windows within the studio, these functions are always 

available. 

 

Title Bar 

The title bar is located at the very top of the software, and includes various resizing 

controls and information. 

 Select Studio Solution to bring up the standard Windows menu, where you can 

move, resize, logout, and exit the software. 

 Select _ or [  ] or X to resize or exit the software. 

 Select ? to see the software version. 

User 

Centered directly below the title bar is the current employee’s username and their role. 

Select Logout to log into the software as a different user.  

Back and Forward 

Your current software location is found to the left, above the studio tabs. Your current 

location will be displayed here. If you are editing a specific vendor’s information, your 

location might appear as Vendors > Setup Vendors > Vendor #1, for example.  

Select the < and > arrows to navigate back and forward through your previously 

viewed windows. 
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Search 

Directly above the studio tabs is a large text field with a magnifying glass. This is your 

search function.  

To search for an item: 

1. Type the full or partial name of anything you wish to search for into the text field. 

2. Hit Enter on your keyboard or click the magnifying glass. 

3. The search results page will appear. Items here are organized by type, name, 

and details. 

4. Click on your desired name to go navigate to that item’s details page. 

5. If you want to narrow the search by date, select a search period from the right 

side of the window. If you choose Custom, type or select dates from the 

calendar and select Apply Now. 

6. If you want to narrow the search by type, select an item type from the right side 

of the window. Item types include: All Types, Bookings, Tasks, Calls, Customers, 

Employees, and Photos. 

Studio Tabs 

These tabs take you to different parts of the software.  

Help 

This brings up the user guide. 

Status Bar 

Below the studio window, to the left of the software tabs is the status bar. The status bar 

will alert you to current processes in the software. Learn more about the status bar here. 
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Software Tabs 

These tabs take you outside the studio to different parts of the software.  

Home Page 
Find your home page by clicking the Home button in the studio tabs. Your home page 

gives you a quick view of all bookings and tasks for the selected day. 

 

 

 

Bookings will be listed by customer name, date and time, and with a brief description of 

the job. 

Tasks will be listed by the employee assigned and a brief description of the task. 

Viewing Dates 

You can view your current information for any day by navigating the small calendars on 

the home page and clicking on a date.  

Select the < and > arrows to change months.  

You can view all of the information for multiple days: 

 Click and hold the left mouse button and drag the cursor to 

select any number of consecutive days. 

 Select and hold CTRL and click individual days to select any 

number of inconsecutive days. 
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 Select and hold SHIFT and click individual days to select any number of 

consecutive days. 

Editing a Booking or Task 

View and edit any booking or task that appears on your home page by clicking on the 

name of the event. You will be taken to the appropriate booking, task, or call creation 

page. Here you can edit, delete, or add notes to the event.  

Calendar 
Your calendar will help you schedule and keep track of every single booking, task and 

call for your studio. Find your calendar by clicking the Calendar button in the studio 

tabs. 

There are four different calendars: Tasks and Events, Schedules, Rooms and Employee. 

Tasks and Events show all actions, whether it’s a portrait shoot, cleaning a studio, or 

making a confirmation call to a customer. Schedules show all employee shifts for that 

time period. 

 

Rooms will provide you with a detailed schedule for each room in your studio. The 

Employee view will provide you with a detailed schedule for each employee of your 

studio. Use the small calendars near the right of the window to navigate dates.  

Select the < and > arrows above the calendar view to change the 

week or month.  

 Select the • to automatically go to the current day and 

week or month.  
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Viewing Modes 

The calendar has three viewing modes: day, week, and month. To change the viewing 

mode, select the day, week, or month buttons, located to the right below the 

calendar. 

 Viewing by Day: This will show the selected day (or days, if you selected more 

than one) with an hour-by-hour schedule. The current date (or dates) will appear 

above the large calendar view.  

 Viewing by Week: This will show a full week, listing all bookings, tasks, and calls.  

 Viewing by Month: This will show a full month, listing the top few bookings, tasks, 

and calls. A … will appear in a calendar day if other events exist. You will need to 

switch to viewing by month or day to see all events for that day. 

 Viewing by Custom: Select and hold CTRL and click the mouse button to select 

any number of days from the small calendar located on the right side of the 

screen. The calendar will display these days.  

Tasks and Events Calendar 

Select the Tasks and Events button from the bottom of the window to access this 

calendar. This calendar shows all of your current bookings, tasks, and calls for the studio.  

If you are viewing your tasks and events by day, the day will be divided into three 

columns: 

 Bookings: View and manage all bookings for the day. Using this view will expand 

details of the booking, showing a 

description and estimated 

duration. 

 Tasks: View and manage all 

employee tasks for the day, 

including details and estimated 

duration. 

 Calls: View and manage all calls 

and confirmations for the day. 
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There is no limit to the number of bookings, tasks, or calls you can have at the same 

time or overlapping the same times. They will appear next to each other in the column. 

Adding a Booking 

A booking is any type of photo shoot with a customer. This is a concrete event with a 

date, time, and assigned employee.  

To add a booking from the calendar: 

1. Make sure you are in the Tasks and Events calendar, not the Schedule. 

2. Double-click any day; you can change this in the next step. If you are viewing by 

day, you must click in the Booking column. 

3. Select a customer from the dropdown box.  

a. If you want to search for an existing customer, select Search. Type in part 

of the customer information in the Find box, select the criteria to search 

for in the ―From‖ dropdown box, and select Search. You can also organize 

the list of customers by clicking on a header to sort. When you have found 

the customer, double-click the name or select it and select OK. 

b. If you need to add or edit an existing customer, read the previous section 

on setting up customers. 

4. Choose a date, starting time, and end time for the event. 

5. Enter a name for the event. You must enter a name before saving the booking. 

6. Enter a description for the event. This is optional. 

7. Update or add a status to the event. Examples: booked, completed, complete, 

no-show. 

8. Choose or add a room for the event. 

9. If you want to automatically add a confirmation call for this event to your 

calendar, select Add a reminder call to the calendar for this booking. This call will 

appear on the calendar schedule 24 hours prior to the event. 

10. If you want to make the booking a recurring event, select Recurring Options to 

setup the event. 

11. Assign an employee (or multiple employees) to the event.  

12. Select Save Booking. 
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13. The booking will now appear on your Tasks and Events calendar on the specified 

date and time.  

 

 

Adding a Task 

A task is any maintenance, job, or reminder for an employee of your studio, or just the 

studio itself. Tasks can only be added from the calendar while viewing by day. 

To add a task from the calendar: 

1. Make sure you are in the Tasks and Events calendar, not the Schedule. 

2. Select to View by day. 

3. Double-click any time in any day in the Tasks column; you change this in the next 

step. You must double-click in the Tasks column while viewing by day. 

4. Choose a date, starting time, and end time for the task. 

5. Enter a name for the task. You must enter a name. 

6. Enter a description for the task. This is optional. 

7. Update or add a status to the task. Examples: assigned, completed. 

8. If you want to automatically add a Reminder for this task to your calendar, select 

the checkbox next to Reminder then set the reminder time from the dropdown 

list. This reminder will appear on the prior to the assigned time. 

9. If you want to make the task a recurring event, select Recurring Options to setup 

the task. 
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10. Assign an employee (or multiple employees) to the task. If you need to add or 

edit an existing employee, read the previous section on setting up employees. 

11. Select Save Task. 

12. The task will now appear on your Tasks and Events calendar on the specified 

date and time. 

 

 

Adding a Call 

Note: Calls can only be added from the calendar while viewing by day. 

To add a call from the calendar: 

1. Make sure you are in the Tasks and Events calendar, not the Schedule. 

2. Select to View by day. 

3. Double-click any time in any day in the Calls column; you change the actual 

time and date next. You must double-click in the Calls column while viewing by 

day. 

4. Select a customer from the dropdown box.  

a. If you want to search for an existing customer, select Search. Type in part 

of the customer information in the Find box, select the criteria to search 

for in the ―From” dropdown box, and select Search. You can also organize 

the list of customers by clicking on a header to sort. When you have found 

the customer, double-click the name or select it and select OK. 

 

b. If you need to add or edit an existing customer, read the previous section 

on setting up customers. 

5. Choose a date and time for the call. 
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6. Enter a name for the call. You must enter a name. 

7. Enter details for the call. This is optional. 

8. Update or add a status to the call. Examples: assigned, call again, complete. 

9. Assign an employee to the call. If you need to add or edit an existing employee, 

read the previous section on setting up employees. 

10. Select Save Call. 

11. The call will now appear on your Tasks and Events calendar on the specified 

date and time. 

 

 

Using the Schedules Calendar 

Select the Schedules button from the bottom of the window to access this calendar. 

This calendar shows all of your employee schedules.  

If you are viewing your tasks and events by day, the day will be divided into as many 

columns as employees that are scheduled that day.  

 

To schedule an employee: 

1. Make sure you are in the Schedules calendar. 
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2. Double-click on any day. 

3. Choose an employee from the dropdown box. 

a. If you want to search for an existing employee, select Search. Type in part 

of the employee information in the Find box, select the criteria to search 

for in the “From” dropdown box, and select Search. You can also organize 

the list of employees by clicking on a header to sort. When you have 

found the employee, double-click the name or select it and select OK. 

4. Choose a date, start time, and end time for the shift. 

5. Enter a name for the shift. You must enter a name. 

6. Enter comments for the shift.  

7. Update or add a status to the shift. Examples: assigned, accepted, completed or 

missed. 

8. Select Save Schedule. 

9. The shift will now appear on the Schedules calendar on the specified date and 

time. 

 

Adding Notes to Calendar Items 

Once an item has been added to a calendar, you can add, edit, or view notes 

associated with it. 

To add a note to a calendar item: 

1. Double-click the item to enter the details page. 

2. Select Add Note to the right of the details. 

3. Type a note and select Save Note. 

4. You can also view and remove existing notes, listed by date and time. Select 

[Remove] to delete a note. 
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Moving, Editing, and Deleting Calendar Items 

Once an item has been added to either the Tasks and Events or Schedule calendars, 

you can move, edit, or delete it. 

To quickly move a calendar item, click and hold the left mouse button and drag the 

item to a different time or date. You can also move an item by double-clicking it and 

editing the date and time from the details page. 

To edit a calendar item, double-click it and enter the details page. Here you can edit 

any options for the item.  

To delete a calendar item, double-click it and enter the details page. Select the Delete 

Item button to the right of the details. 

Customers 
The Customers tab will keep track of all your past, current, and possible future 

customers.  

 

 

After selecting the tab, a list of customers will appear, alphabetized by last name, with 

a phone number and email address.  

 Clicking a customer’s email link will open a new message to them in your default 

email program.  

 

 Clicking on a customer’s name will take you to the details page for that 

customer. 

Customer Details 

This is your customer’s home page. It keeps track of all their booking and order info, and 

is where you can view and manage general info, bookings, notes, and calls. The right 
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side of the window will always display the time and date of the event or information. 

The following info will always be displayed: 

 Contact Info: The left of the window will show the customer address, phone 

number, and email address. Clicking the email address will open a new message 

to them in your default email program. The customer status will also be listed 

here (active, inactive, lead, or custom). 

 Current Bookings: These are all future bookings for the customer. Click on the 

name of a booking to view or edit details. 

 Previous Bookings: These are all past bookings. If a booking has been completed 

you can click on [View Photos] to see the photos from that event. If a booking 

has not been completed, click on the name of the booking to view or edit 

details. 

 Calls: These are all current calls scheduled for the customer. Previous calls will not 

appear here. Click on the name of a call to view or edit details. 

 Customer Notes: These are all notes created for the customer. Click [Remove] to 

delete a note. 

 Order: These are all orders for the customer, listed by internal order number. 
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Adding a Customer 

To add a new customer: 

1. Select New Customer from the right side of the window. 

2. Enter the customer name, address, and contact information. 

3. Enter the customer status. Select [Add Status] to create a new one. 

4. Select [Add Family Member] if you want to associate relatives of the customer 

with this account. Enter the relative information and select Add Family Member. 

5. Select Save Customer. 

 

 

Editing a Customer 

Select Edit Customer from the bottom of the window to edit any customer information. 

Select Delete Customer to remove them. 

 

 

Adding a Booking 

To add a booking from the customer details page: 

1. Select Add Booking from the bottom of the window. 

2. Choose a date, starting time, and end time for the event. 

3. Enter a name for the event. You must enter a name. 

4. Enter a description for the event. 
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5. Update or add a status to the event. Examples: booked, completed, complete, 

no-show. 

6. Choose or add a room for the event. 

7.  If you want to automatically add a confirmation call for this event to your 

calendar, select Add a reminder call to the calendar for this booking. This call will 

appear on the calendar scheduled 24 hours prior to the event. 

8. Assign an employee (or multiple employees) to the event. If you need to add or 

edit an existing employee, read the previous section on setting up employees. 

9. Select Save Booking. 

10. The booking will now appear on the customer details page and the calendar. 

 

 

Adding a Note 

To add a note from the customer details page: 

1. Select Add Notes from the bottom of the window. 

2. Type a note and select Save Note. 

3. You can also view and remove existing notes, listed by date and time. Select 

[Remove] to delete a note. 
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Adding a Call 

To add a call from the customer details page: 

1. Select Add Call from the bottom of the window. 

2. Choose a date and time for the call. 

3. Enter a name for the call. You must enter a name. 

4. Enter details for the call. This is optional. 

5. Update or add a status to the call. Examples: assigned, call again, complete. 

6. Assign an employee to the call. If you need to add or edit an existing employee, 

read the previous section on setting up employees. 

7. Select Save Call. 

8. The call will now appear on the customer details page and the calendar. 
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Employees 
The Employees tab will keep track of all your employees and roles. We’ve already 

covered adding new employees and roles, so we’ll start with managing existing ones. 

 

 

After selecting the tab, a list of employees will appear with names, roles, next schedule, 

and check-in status. 

 Clicking Check In or Check Out will record employee actions and shifts. 

 Clicking on an employee’s name will take you to the details page for that 

employee. 

Checking In and Out 

Checking employees in and out will keep a record of who does what within the 

program. A filled circle will appear under the IN column when an employee is checked 

in. An empty circle implies the employee is scheduled but not checked in. 

To check an employee in or out: 

1. Select Check In or Check Out from the Check In/Out status column. 

2. Enter the account password for the employee. This password is set in the 

employee info page. 

3. Select OK. 

4. A filled circle appears in the IN column if they have checked in successfully. If the 

circle is empty, they are not checked in. 
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Employee Details 

This is your employee’s home page. It keeps track of all their information and tasks, and 

is where you can view and manage general info, schedules, notes, and calls. The right 

side of the window will always display the time and date of the event or information. 

The following info will always be displayed: 

 Contact Info: The left of the window will show the employee address, phone 

number, and email address. Clicking the email address will open a new message 

to them in your default email program. The employee status will also be listed 

here (full-time, part-time, temporary, or custom). 

 Tasks: These are all currently assigned tasks for the employee. Click on the name 

of a task to view or edit details. 

 Bookings: These are all past and current bookings for a customer. Click on the 

name of a booking to view or edit details. If a booking has been completed you 

can click on [View Photos] to see the photos from that event.  

 Calls: These are all current calls scheduled for a customer. Previous calls will not 

appear here. Click on the name of a call to view or edit details. 

 Employee Notes: These are all notes created for the employee. Click [Remove] 

to delete a note. 

 Schedules: These are all past and current shifts for the employee. Click on a shift 

name to view or edit schedule details. 

 

 

Editing an Employee 

Select Edit Employee from the bottom of the window to edit any employee information 

or assign them a different role. Select Delete Employee to remove them. 
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Adding a Task 

To assign a task to this employee: 

1. Select Add Task from the bottom of the window. 

2. Choose a date, starting time, and end time for the task. 

3. Enter a name for the task. You must enter a name. 

4. Enter a description for the task. This is optional. 

5. Update or add a status to the task. Examples: assigned, completed. 

6. Assign an employee (or multiple employees) to the task. If you need to add or 

edit an existing employee, read the previous section on setting up employees. 

7. Select Save Task. 

8. The task will now appear on the employee details page and the calendar. 

 

Adding a Note 

To add a note for this employee: 

1. Select Add Notes from the bottom of the window. 

2. Type a note and select Save Note. 

3. You can also view and remove existing notes, listed by date and time. Select 

[Remove] to delete a note. 

Adding a Shift 

To add a shift for this employee: 

1. Select Add Schedule from the bottom of the window. 

2. Choose a date, start time, and end time for the shift. 
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3. Enter a name for the shift. You must enter a name. 

4. Enter comments for the shift. This is optional. 

5. Update or add a status to the shift. Examples: assigned, accepted, completed or 

missed. 

6. Select Save Schedule. 

7. The shift will now appear on the employee details page and the Schedules 

calendar. 

Printing a Schedule 

To print this employee’s schedule: 

1. Select Print Schedule from the bottom of the window. 

2. You will be taken automatically to the Employee Activity section of the Reports 

tab. 

3. Select a Quick Date period from the left to view a schedule for pre-set dates, or 

enter a Start Date and End Date in the text fields. 

4. Select the Employee from the dropdown box. 

5. Select Generate Report. 

6. A report will appear detailing all of this employee’s activity for the time period 

you specified. The very bottom of the report will show all previous, current, and 

upcoming shifts for the time period you selected. 

7. Select Print from the top left of the window to print this schedule. 
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Reports 
The Reports tab will generate various information and reports for your studio that you 

can view and print or export. Every report requires that you choose a time period for 

displaying information. 

 

 

To run a report: 

1. Select a report type from the Reports tab. 

2. Select a time period for the report by selecting a Quick Date from the left of the 

software, or by entering specific start and end dates into the text field by typing 

or selecting dates on the calendar. 

3. Select Generate Report. 

4. To print the report once it has appeared, select Print from the top left of the 

software. 
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Read on for information on the different types of reports. 

Employee Activity 

This report will display all activity for a specific employee, with times, dates, and 

descriptions for: 

 Bookings 

 Tasks 

 Calls 

 Schedules 

Employee Activity Export 

This report will generate a comma-separated value (CSV) file that lists and details all 

activity for a specific employee. This file can be used in any data management 

program that accepts .csv files. Select Save after the report is generated; you cannot 

print this report. 

Employee Export 

This report will generate a comma-separated value (CSV) file that includes all studio 

employees. This file can be used in any data management program that accepts .csv 

files. Select Save after the report is generated; you cannot print this report. 
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Employee Schedules 

This report will display a list of all employee schedules with times, dates and descriptions 

for all their activities. 

Employee Schedules Export 

This report will generate a comma-separated value (CSV) file that includes all studio 

employee schedules. This file can be used in any data management program that 

accepts .csv files. Select Save after the report is generated; you cannot print this report. 

Event Categories 

This report will display all event activity for your studio, with times, dates, and 

descriptions for: 

 All Bookings 

 All Calls 

 All Employee Schedules 

 All Employee Tasks 

Employee Categories Export 

This report will generate a comma-separated value (CSV) file that includes the number 

of events by type and their details. This file can be used in any data management 

program that accepts .csv files. Select Save after the report is generated; you cannot 

print this report. 

Orders Summary Export 

This report will generate a comma-separated value (CSV) file that includes orders and 

their details. This file can be used in any data management program that accepts .csv 

files. Select Save after the report is generated; you cannot print this report. 

Package Export  

This report will generate a comma-separated value (CSV) file that includes all the 

packages sold. This file can be used in any data management program that accepts 

.csv files. Select Save after the report is generated; you cannot print this report. 

Package and Products  

This report will display all purchased packages and products for your specified time 

period. 
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Products Export  

This report will generate a comma-separated value (CSV) file that includes all products 

sold. This file can be used in any data management program that accepts .csv files. 

Select Save after the report is generated; you cannot print this report. 

Sales by Package 

This report will display a summary of all purchased packages and the sales generated 

by each. 

Session Trends 

This report will display a pie chart for the percentage of types of task types. 

Tasks by Type Export  

This report will generate a comma-separated value (CSV) file that includes all tasks by 

type. This file can be used in any data management program that accepts .csv files. 

Select Save after the report is generated; you cannot print this report. 
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Using the Photo Library 

The Photo Library is where all event photos will be viewed, organized, and added to 

orders. Here you can keep track of every photo shoot in the studio.  

Find and select the Photo Library tab at the bottom of the software. 

For a complete reference guide to the Photo Library, including detailed screenshots 

and button locations, go here. 

Navigating the Photo Library 
The library is divided into three areas, appearing in the software from left to right:  

 Catalog Menu: create, organize, publish, and archive photo catalogs.  

 Photo Viewer: review, orient, and organize photos within a catalog. 

 Shopping Cart: select packages and photos for purchase and add to orders. 

 

 

Using the Catalog Menu 
Your catalogs are always located on the far left of the Photo Library. There is a default 

list of catalog types to help you organize your catalogs, including: 
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 PhotoReflect: these are portfolios that will be uploaded to your PhotoReflect site 

as examples of your work, a photo of you, or promotions. You may have up to 

five portfolios here at one time. 

 Portrait: any customer sittings will automatically be 

saved here. Click the + next to a customer’s name to 

see all of their available catalogs. 

 Desktop: this is your computer desktop. Navigate 

through the tree structure to view and edit any 

photos you may have in a different location. 

Click the + next to a catalog type to view all the catalogs 

within it. 

To refresh the catalog list, select Catalogs from the very top 

left of the software and select Refresh. Or hit F5. 

Sorting and Viewing Catalogs 

To sort your catalogs: 

1. Select the Sort menu, located at the very top left of the software. 

2. Select to sort catalogs by Time or by Name. 

3. Select to sort catalogs by ascending or descending order within Time or Name. 

To change catalog viewing options: 

1. Select the View menu, located at the very top left of the software. 

2. Select to view catalogs by: 

 Default: this will view catalogs within one catalog type. 

 Date: this will view according to catalog dates. 

o Select Arrange Catalogs to sort by day, week, or month. 

 Alphabetically: 

o Select Arrange Catalogs to divide catalogs into 4, 6, or 26 groups. 

 Type: this will view according to catalog types, such as wedding or portrait. 
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3. Select and check to show the number of catalogs contained within a larger 

category. 

4. Select and check to show the catalog ID number added to catalog names. 

5. Select and check to show archived catalogs in the list. 

You can also Sort and View catalogs by right-clicking on any catalog and selecting 

View, which contains all of the previous options. 

Finding a Catalog 

To search for a catalog, select Find above the catalog list. Enter the text and type to 

search for, and select whether to search archived photos.  

Adding Catalogs 

To add a catalog to the list: 

1. Select the category type you want to add a catalog to. If you want to add a 

different category type, you can change it in this process. 

2. Select New Catalog, located to the left directly above the catalog list. 

3. If you want to create a new catalog and automatically import photos from your 

quick import location, select and check Create New & Import. 

4. Select Add Photo Catalog. 

a. Select Add Portfolio instead if you want to add a new portfolio to your 

PhotoReflect. 

5. A wizard opens. Select a category type from the drop-down box. 

6. Enter a customer name. You must enter a last name. The first name is optional. 

7. Enter a description, event city, state (two-letter abbreviation), and country. This is 

optional. 

8. Enter an event date. You must enter an event date. 

9. Enter event notes. 

10. Select Next. 

11. Enter customer information. 

12. Select Finish when complete or select Web Options if you would like to enter 

information for PhotoReflect. 
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You can also add catalogs by right-clicking on any catalog type and selecting New 

Catalog, which contains all of the previous options. 

Viewing Catalog Info 

To view catalog info, select a catalog or photo group and select Info above the 

catalog list. You can also right-click a catalog or photo group and select Info for the 

same options.  

Editing Catalog Info 

To edit catalog info: 

1. Select the catalog you wish to edit. 

2. Select Info, located directly above the catalog list. 

3. Edit the catalog info. See Adding Catalogs for a detailed guide. 

4. Select Finish. 

a. Select Next if you want to edit customer info. Then select Finish. 

OR 

1. Select the catalog you wish to edit. 

2. Select Catalogs, located at the very top left of the software. 

3. Select Catalog Info. 

4. Edit the catalog info. 

You can also edit catalog info by right-clicking on the catalog and selecting Catalog 

Info, which contains all of the previous options. 
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Removing Catalogs 

To remove a catalog: 

1. Select the catalog you want to remove. 

2. Select Catalogs, located at the very top left of the software. 

3. Select Remove Catalog. 

4. Confirm that you want to delete the catalog. 

5. Select Yes. 

You can also remove a catalog by right-clicking on the catalog and selecting Remove 

Catalog, which contains all of the previous options. 

Adding a Photo Group to a Catalog 

Photo groups are subcategories of catalogs. For example, one customer could have 

several different photo groups; one for each portrait sitting.  

To add a photo group to an existing catalog: 

1. Select the catalog you want to add photos to. 

2. Select New Catalog, located to the left directly above the catalog list. 

3. If you want to create a new photo group and automatically import photos from 

your quick import location, select and check Create New & Import. 
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4. Select Add Photo Group to and ensure that it lists the correct catalog. 

5. Enter a name for the photo group. You must enter a name. 

6. Enter notes. 

7. Enter the event date. You must enter a date. 

8. Select Finish. 

You can also add photos by right-clicking on a catalog and selecting Add Photos. 

Publishing Catalogs 

Publishing a catalog will upload it to your PhotoReflect site, where customers can view 

and order photos online. If there is a package group assigned to an event, it will be 

uploaded as well. 

To publish a catalog: 

1. Do not turn off the software while publishing. 

2. Select the catalog you want to publish. 

3. Select Catalogs, located at the very top left of the software. 

4. Select Publish Selected. 

5. The status bar at the bottom left of the software will turn blue and show a % of 

publishing. 

6. When a catalog is published, you will see a prompt and all published photo(s) 

will show a ―P‖ in the upper-left hand corner. 

You can also publish a catalog by right-clicking on it and selecting Publish Catalog, 

which contains all of the previous options. 

You can reserve a space for catalogs to be published in the future. Publish an event 

with no photos and customers will at least know they are looking in the right place and 

can return later when the photos are available. 

Unpublishing Catalogs 

To remove a catalog from your online storefront: 

1. Select the catalog you want to unpublish. 

2. Select Catalogs, located at the very top left of the software. 



Using: Photo Library 

 

119 

 

3. Select UnPublish Catalog. 

4. Confirm that you want to unpublish the catalog. 

5. Select Yes. 

You can also unpublish a catalog by right-clicking on it and selecting UnPublish 

Catalog, which contains all of the previous options. 

Batch Publishing and Unpublishing Catalogs 

To publish or unpublish more than one event at a time, select a catalog or group 

containing more than one event or photo group, and follow the previous steps. Select 

which events you want to publish or unpublish and select Publish or Unpublish. 

Archiving Catalogs 

Archiving catalogs will backup your catalogs, data, folders, and photos to another 

location. You can archive to CDs, external hard drives, networks, or any computer 

location big enough to hold the information. Archiving can also open up space on your 

current computer, making it faster to use and easier to navigate.  

You can archive individual photo groups or entire catalogs. To archive a catalog: 

1. Select the catalog or photo group you want to archive. 

2. Select Catalogs, located at the very top left of the software. 

3. Select Archive To. A window appears. 

4. Select a location to archive to. A folder will automatically be created within this 

location. 

5. Select OK. 

a. If you are archiving to a remote media device, such as a CD, the software 

can remind you which media you used when trying to unarchive. Select 

Yes to have this reminder appear. 

 

6. You will be prompted to remove the catalogs that you just archived from the 

software. This will save space on your computer and the files can be unarchived 

at any time.  

7. Select Yes to remove the catalogs. 
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If you set up a quick archive path in Setup, you can select Quick Archive to 

automatically archive the selected catalogs without choosing a location. 

You can also archive or quick archive catalogs or photo groups by right-clicking on the 

catalog or photo group and selecting Archive To, which contains the previous options. 

Unarchiving Catalogs 

To restore archived catalogs or photo groups you will first need to be connected to the 

location or media of the stored data. 

To unarchive a catalog: 

1. Select Catalogs from the very top left of the software. 

2. Select Unarchive From. 

3. A window appears. 

4. Select or browse to the path of the stored catalogs, or select Find to search for it. 

5. Once you have located the catalog, select it. 

6. Select OK. 

If you set up a quick unarchive path in Setup, you can select Quick Unarchive to 

automatically unarchive the selected catalogs without choosing a location. 

You can also unarchive or quick unarchive catalogs or photo groups by right-clicking 

on the catalog or photo group and selecting Unarchive From, which contains the 

previous options. 

Setting Photo Numbers 

Each photo in a catalog will have an individual photo number for identification. When 

first imported, these numbers begin at 1 and are consecutive. As you add and remove 

photos from a catalog, you will create gaps in the numbering. Use the photo 

numbering features to assign a new starting number for additional photos, or to reset all 

of the photo numbers in the catalog. 

To set a starting number for any new photos in the catalog: 

1. Select the catalog you want to number. 

2. Select Catalogs from the very top left of the software. 
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3. Select Set Starting Photo Number. 

4. Type or select the new starting photo number. 

5. Select OK. 

6. Photos added to this catalog will start at this number and count up 

consecutively. 

To reset the photo numbers for a catalog: 

1. Select the catalog you want to reset. 

2. Select Catalogs from the very top left of the software. 

3. Select Reset Photo Numbers. 

4. Type or select the starting photo number.  

5. Select OK. 

6. All photos in this catalog will be reset with new numbers, counting consecutively 

up from the one you selected. 

You can also set starting numbers or reset photo numbers by right-clicking on the 

catalog and selecting Set Starting Photo Number or Reset Photo Numbers, which 

contain the previous options. 

Photo Paths 

You can view the computer folder and paths that contain photo groups and catalogs. 

To open the folder containing the photos: 

1. Right-click on a catalog or photo group. 

2. Select Open Containing Folder. 

3. This is the location and subdirectory containing your selected photos. 

 

To copy the file location containing the photos: 

1. Right-click on a catalog or photo group. 

2. Select Copy Path to Clipboard. 
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3. The location is now saved in your clipboard. Selecting Paste or CTRL-V will paste 

the location of the photos. 

Using the Photo Viewer 
Selecting an event will display the photos in the center of the software. This area is 

called the Photo Viewer. Here you can micromanage catalogs by editing and 

organizing individual photos. The event name, number of photos, location, and event 

date are all located just above the photo viewer. 

 

 

 

To select photos, hold and drag the mouse over any number of photos. Or click them 

individually while holding CTRL or SHIFT. You can also select photos by selecting Photos 

from the very top center of the software and selecting Select All or Deselect All. 

To refresh photos, select Photos from the very top center of the software and select 

Refresh. Or hit F5. 

 

Sorting and Viewing Photos 

To sort photos within a catalog: 

1. Select a catalog or photo group. 
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2. Select Sort from the very top center of the software. 

3. Select to sort photos by: 

 Rating: sort by your assigned 1 to 5 star rating.  

 Time: sort by the time in the photo. 

 Photo Number: sort by the assigned photo numbers.  

 Filename: sort by the photo filename. 

 Full Pathname: sort by the entire computer pathname. 

 File Size: sort by file size. 

 Published: sort by published and unpublished. 

 Archived: sort by archived and unarchived. 

 Exif Comment: sort by Exchangeable Image File information. 

 Sort by Custom: manually click and drag photos to their positions. 

4. Select to sort photos by the previous criteria in either ascending or descending 

order. 

To change photo viewing options: 

1. Select a catalog or photo group.  

2. Select View from the very top center of the software. 

3. Click to place a check next to a viewing selection: 

 Show Photo Filenames: display all photo filename extensions beneath photos. 

 Show Photo Icons: display tiny icons above photos indicating archive, publish, 

printed, enhanced, and hidden status. 

o  - Printed 

o  - Archived 

o  - Enhanced  

o  - Hidden from Publishing 

o  - Published 

 

 Show Photo Number: display photo numbers beneath photos. 
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 Show Photo Rating: display your 1 to 5 star photo rating above photos. 

 Show Hidden Photos: display photos hidden from publishing. 

4. Select to view photos as: 

 Photo Thumbnails: view miniature versions of your photos. 

 Photo Filename List: view a list of filenames with file size and creation time. 

 Photo Info List: view a list of thumbnails with detailed photo information: 

o Filename, Path, Image Size, File Size, Date Last Modified, and the 

Camera Information (displaying range of color) are displayed. 

 

5. Select the size of thumbnails to display: tiny, small, normal, large, largest. 

6. Click to place a check and select to Use Second Monitor for Previews. 

a. If you have a second monitor connected, selecting a photo will 

automatically display a large preview there with a black background. 

7. Click to place a check and select to view High Quality Previews. 

You can also sort and view photos by right-clicking on any photo and selecting View, 

which contains all of the previous options. 

Thumbnail Size 

To select to size of thumbnails to display, select one of the 5 different box sizes: tiny, 

small, normal, large, largest. 

Adding a Photo  

You can import a photo or a group of photos into a catalog at any time. These photos 

will immediately appear in the photo viewer. 

To add photos to a catalog: 

1. Select Add, located above the photo viewer. A drop-down menu will appear. 

2. Select Import and browse to the location of the photos you wish to import. 

3. Select any number of photos by holding and dragging the mouse or manually 

clicking each one holding CTRL or SHIFT. 

4. Select how to copy the files: 
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a. Simply copy the files to the destination without changing the file type. 

b. Or Convert the files to another format while copying. 

i. Select a new file format for the imported photos. 

5. If you want to rename the imported photos, select Rename copied files. 

a. Select a file name prefix. 

b. Select a starting number. 

c. Select Reverse Chronological to rename photos starting with the last first. 

6. Select Delete files after copying them if you want to permanently remove these 

files from this location after importing. 

7. Select Import to import selected photos, or select Import All to import all photos 

in the current location. 

Importing Photos from a Camera 

If you have a tethered or WiFi camera connected and set up in the software, you can 

import photos into the current catalog as they are taken.  

To import photos from a tethered or WiFi camera: 

1. Ensure that the camera is set up properly and connected to the software via USB 

cable or through WiFi. 

2. Take a photo with the camera, or press SPACE on the keyboard. 

3. The photo will automatically be added to the current catalog. 

Importing Photos from a Camera Card 

If you want to import photos from a camera card, you must read the camera card from 

an external card reader. 

To import from an external card reader or drive: 

1. Attach the external card reader or drive to the computer. 

2. Select Import and navigate to the folder containing the photos. 

3. Select Import or Import All to add the photos to the catalog 
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Finding a Photo 

To search for a photo within the catalog: 

1. Select Find, located above the photo 

viewer.  

2. Enter the text and type to search for: 

Filename, Path, Photo Notes, Film Number, 

or Exif Comments. 

3. Select to match only whole words. 

4. Select to match case of words. 

5. Select to search up or down within the current catalog. 

Renaming Photos 

Renaming a photo will also change its filename. To rename a photo, select a photo 

and select Photos from the very top center of the software. Select Rename Photo and 

enter a new name. You can also right-click on a photo and select Edit Photo > Rename 

Photo, which contains the previous options. 

Adding Photographer Notes 

This note will appear in the photo info. To add a photographer note to a photo, select a 

photo and select Photos from the very top center of the software. Select Describe 

Photo and enter a note. You can also right-click on a photo and select Edit Photo > 

Describe Photo, which contains the previous options. 

Removing Photos 

To remove a photo from the catalog: 

1. Select any number of photos. 

2. Select Photos from the very top center of the software. 

3. Select Remove Photo. 

4. Confirm that you want to remove the photo. 

5. Select Delete the picture file(s) as well if you want to permanently delete the 

photo. 

6. Select Yes. 
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You can also right-click on any number of selected photos and select Remove Photo. 

Hiding Photos from Publishing 

Catalogs are usually published all at once. If you want to keep a photo in the catalog 

and photo viewer but don’t want it to be published with the rest of the photos, you can 

hide it from publishing. 

To hide a photo from publishing: 

1. Select any number of photos. 

2. Select Photos from the very top center of the software. 

3. Select Hide from Photo(s). 

4. Confirm that you do not want this photo published on your storefront. 

5. Select Yes. 

6. A small P with an X through it will appear in the upper-right of the photo. This 

shows that the photo will be hidden from all publishing. 

To unhide a photo from publishing, select any number of hidden photos and follow the 

previous options. 

You can also hide and unhide photos by right-clicking on any number of photos and 

selecting Hide Photo(s). 

Rating Photos 

Every photo can be assigned a 1 to 5 star rating. These ratings can signify either your 

favorite photos, or the customer’s favorite photos. 

To rate a photo: 

1. Select any number of photos that you want to have the same rating. 

2. Select Photos from the very top center of the software. 

3. Select Rate Photo. 

4. Select 1 to 5 stars, 1 being fair and 5 being best. 

You can also right-click on any number of photos and select Edit Photo > Rate Photo 

and select a rating. 
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Adding Service Notes 

Service notes are additional services performed on 

photos above and beyond the normal touchups. You 

defined the services of your studio and your labs here.  

 

To add a service to a photo: 

1. Select any number of photos. 

2. Select Photos from the very top center of the software. 

3. Select Service Notes. 

4. Check to select any of your available services to be applied to the photo. 

5. Select OK. 

6. These services will be applied to this photo in any size in any order. 

You can press the \ or right-click on any number of photos and select Edit Photo > 

Service Notes for the previous options.  

Editing Shipping Info 

To edit a customer’s shipping info, select Photos from the very top center of the 

software and select Edit Shipping Info. Edit the billing and shipping info, and change the 

shipping type and cost and select Save Changes. You can press CTRL-H or right-click on 

a photo and select Edit Shipping Info for the previous options. 

Photo Paths 

You can view the computer folder and paths that contain the photos. 

To open the folder containing the photos: 

1. Select Photos from the very top center of the software or right-click on a photo. 

2. Select Open Containing Folder. 

3. This is the location and subdirectory containing your selected photos. 

To copy the file location containing the photos: 

1. Select Photos from the very top center of the software or right-click on a photo. 
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2. Select Copy Path to Clipboard. 

3. The location is now saved in your clipboard. Selecting Paste or CTRL-V will paste 

the location of the photos. 

Viewing Photo Properties 

To see the properties of a selected photo, select Photos from the very top center of the 

software or right-click on a photo, and select Properties. A window with two tabs 

appears. 

The following information is displayed on the properties tab: 

 Filename 

 Path 

 Image Size 

 File Size 

 Date Last 

Modified 

 Orientation 

 Cached status 

 Archived status 

 Published status 

 Hidden status 

 Photographer’s 

Notes 

The Photo Data tab is used for setting queries. A query has a property and a value, and 

is used to organize photos automatically when dealing with large groups. Keep reading 

for a brief example. 

Imagine you are creating composite photos for a soccer team where each player will 

have a team photo and a player photo. Now imagine you are creating composites for 

twenty different teams! You can simplify your search and creation process: 

1. Select Add Data. 

2. Set the Property to Team Name. 

3. Set the Value to Bumblebees and select OK.  

4. Select OK. 

5. When you are creating or using a border, you can assign a border to 

automatically import photos with specific data, such as Team Name, or even 

specific data such as Team Name = Bumblebees or Team Name = Sharks. This 

one query will automatically import the composite photo each time the border is 

applied, saving you precious time. 

You can also view properties by right-clicking on a photo and selecting Properties. 
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Showing Photo Histograms and Data 

If you want to view technical photo data, select Show Data from the top right of the 

software. The following information will be shown on the right side of the workspace: 

 

 Filename 

 Capture Date 

and Time 

 Capture 

Resolution 

 Capture 

Megapixels 

 Photo Histogram 

 EXIF Data 

 Editing Software 

 ISO Info 

 Flash Settings 

 Color Space 

 Photo Notes 

 Photo Rating 

 Photo Number 

 

Select [Click to Add] under photo data to add photographer notes to this photo. 

Select Hide Data from the top left of the software if you do not want to display photo 

data. 

Saving Attributes 

Attributes are a series of edits or settings for a photo that can be saved and applied to 

other photos and catalogs. You can quickly assign and apply up to four different 

attribute settings at once, or create new ones. The Photo Library and the Photo 

Workshop both use the same set of attributes. 

Here is a list of all attributes that will be saved and applied: 

 Color Balance 

 Color Correction (contrast, etc.) 

 Enhancements (vignettes) 

 Cropping 

 Drop Out 

 Services 

 Input Profile 

 Color Mode (sepia, duotone, 

etc.) 

To save attributes: 

1. Select the photo with attributes you want to save. 
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2. Select Attributes from the very top center of the software. 

3. Select Save Attributes to. 

4. Select to: 

 

 Copy the attribute settings to the clipboard. This is only temporary and will 

be overwritten if you use the clipboard again, so use this setting only if you 

will be applying the attributes immediately. Press * as a hotkey for this 

option. 

 Set the photo attributes as the system attributes. Every new photo in the 

software will now have these attributes as a default. 

 Set the photo attributes as the catalog attributes. Every new photo in the 

catalog will now have these attributes as a default. 

 Set the attributes to Custom 1 – 4. These attributes will be saved in the 

software until you manually save over them. 

 Create a New custom setting. With a new custom attribute setting, you 

can leave out specific attributes or only save one or two different 

attributes of a photo. For example, you could copy over the Services and 

a Vignette, but leave the Color Correction and Color Mode the same. 

Applying Attributes 

To apply attributes: 

1. Select any number of photos to apply the attributes to. 

2. Select Attributes from the very top center of the software. 

3. Select to: 

a. Apply Attributes from if you want to apply the attributes only to your 

selected photos. 

b. Apply to All from if you want to apply the attributes to the entire event. 

4. Select to: 

a. Use the attribute settings on the clipboard. Press / as a hotkey for this 

option. 

b. Use the default system attributes. 
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c. Use the default catalog attributes. 

d. Use Custom attributes 1 – 4. 

e. Use a New custom setting you created (it will appear below Custom 1 – 

4). 

Editing Custom Attributes 

To edit custom attributes, select Attributes from the very top center of the software and 

select Save Attributes to > Edit. You can rename or delete your custom attribute 

settings. 

Orienting Photos 

To quickly change the orientation of a photo, select any number of photos and select 

the arrows on each side of Orient, located above the photo viewer. The left arrow 

rotates clockwise and the right arrow rotates counter-clockwise. 

For other orientation options, select Orient from above the photo viewer and select an 

option: 

 Vertical: oriented as a portrait. 

 Horizontal: oriented as a landscape. 

 Vertical Flipped: oriented vertically but upside-down compared to the original. 

 Horizontal Flipped: oriented horizontally but flipped sideways compared to the 

original. 

 Rotate Clockwise: rotate the photo 90° clockwise. Press O as a hotkey. 

 Rotate Counter-Clockwise: rotate the photo 90° counter-clockwise. Press SHIFT - 

O as a hotkey. 

 Flip: flip the photo 180°. 

 Set Crop Orientation: this determines how the image will be cropped to fit on the 

photo. Select Auto to let the software decide on a per photo basis, or select 

Vertical or Horizontal. 

 Set Default Orientation: this determines how photos are automatically oriented. 

Select No Default Orientation to let the software decide on a per photo basis. 
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 Set Tilt Angle: enter a number between 0 and 360 and select to rotate clockwise 

or counter-clockwise. 

You can also orient photos by selecting any number of photos and right-clicking on 

them. Select Orient Photo, which contains all the previous options. 

Enhancing Photos 

To enhance a photo, select any number of photos and select Enhance from above the 

photo viewer. The Photo Workshop will open with these photos. You can also double-

click a photo to enter the Photo Workshop and edit any photos from the event. Click 

here for information on using the Photo Workshop. 

Previewing Photos 

To preview the event photos full-screen, select a photo and select Preview from above 

the photo viewer. The software will switch to Presentation Mode, where you can run 

slideshows, play music, and view the photo with different frames. Click here for detailed 

options during full-screen Presentation Mode. 

Publishing Photos 

To publish a photo: 

1. Do not turn off the software while publishing. 

2. Select any number of photos you want to publish. 

3. Select Publish, located above the photo viewer. 

4. Select Publish Selected. 

5. The status bar at the bottom left of the software will turn blue and show a % of 

publishing. 

6. When a photo is published, you will see a prompt and all published photos will 

show a P in the upper-left hand corner. 

Un-Publishing Photos 

To remove photos from your online storefront: 

1. Select any number of photos you want to unpublish. 

2. Select Publish, located above the photo viewer. 



Using: Photo Library 

 

134 

 

3. Select Un-Publish Selected. 

4. Confirm that you want to unpublish the catalog. 

5. Select Yes. 

Batch Publishing and Un-Publishing Events 

To publish or un-publish more than one event at a time, select Publish from above the 

photo viewer. Select which events you want to publish or un-publish then select Batch 

Publish or Batch Un-publish. 

Copying Photos 

To copy photos from the photo viewer to another location: 

1. Select any number of photos. 

2. Select Copy, located above the photo viewer. A window appears. 

3. Browse to the location of the photos you wish to copy to. 

4. Select how to copy the files: 

a. Simply copy the files to the destination without changing the file type. 

b. Or Convert the files to another format while copying. 

i. Select a new file format for the imported photos. 

5. If you want to rename the imported photos, select Rename copied files. 

a. Select a file name prefix. 

b. Select a starting number. 

c. Select Reverse Chronological to rename photos starting with the last first. 

6. Select Delete files after copying them if you want to permanently remove these 

files from this location after importing. 

7. Select Copy All to copy all photos from the event, or Selected to only copy the 

selected photos. 

Creating Batch Orders 

Batch orders are used to print or order a large group of photos. A batch order will 

create one large order containing the same size prints for a number of different photos. 

These orders can save a lot of time during large-scale portrait sittings, such as school 
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pictures or ID cards, and as one large order they will be printed and ready at the same 

time.  

To create a batch order: 

1. Select any number of photos. 

2. Select Batch from above the photo viewer. A window appears. 

3. Select to: 

a. Print only the selected photos. 

b. Print all photos in this event. 

i. If you selected to print all photos and have selected a catalog 

containing more than one event, select Print all subevents to print 

every event in the catalog. 

4. Select the prints to make for each photo. 

a. Select Add to add a print for each photo. The available items are 

products and package groups you created and assigned here. 

b. Select Remove or Remove All to delete individual or all of the prints. 

5. Select Print each photo with a border if you wish to add a border to each photo. 

a. Select Choose to browse the borders you created and organized here. 

b. Select Match border orientation to image to rotate the border horizontally 

or vertically, depending on the photo. 

c. Select Match border aspect ratio to printsize to resize the border to the 

correct aspect ratio of the print. 

6. Select to: 

a. Create a single order. This will combine every print into one large order. 

Although it may take longer, every print will be ready at the same time. 

b. Create separate orders for each photo. This will divide the order into as 

many orders as there are photos. Each order will contain every different 

print of that particular photo. It is possible that all of your orders will not be 

ready at the same time. 

i. If you selected to create separate orders and you are printing 

more than event, you can select to Create separate orders for 
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each subevent to create separate orders for each event in the 

catalog. 

7. Select Place Orders to send your orders to the printer or lab, or select Save 

Orders to save the orders in the Orders tab to be sent later. 

 

 

Proofing Photos 

Proof sheets are single sheets containing small printout of photos for presenting to 

customers. You can quickly print a pre-made proof sheet, or you can create custom 

proof sheets with advanced options. Press P as a hotkey for proofing photos. 

To quickly create a proof sheet: 

1. Select any number of photos. 

2. Select Proof from above the photo viewer. A window appears. 

3. If you have already created a custom proof template, select a Proof Template. 

Otherwise, this field will remain blank. 

4. Enter a Title for the proof sheet. This title will appear on each page of the proof. 
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5. Select the page size for the proof sheets. 

6. Select the size of the individual photos that will appear on the proof sheet. 

7. Select the orientation: 

a. Portrait or Landscape page will set the entire page. 

b. All portrait proofs will orient every photo as a portrait. 

c. All landscape proofs will orient every photo as a landscape. 

8. Select the number of copies to print. 

9. Select to Print Filenames under each photo. 

10. Select to: 

a. Create a print order: this will be an individual order for just the proof sheet. 

b. Add proof sheet to shopping cart: this will add the proof sheet to the 

shopping cart as part of the current order. 

11. Select Print All to proof every photo in the event, or Print Selected to only proof 

the selected photos. 
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Creating a Custom Proof Sheet 

To create a custom template for proofing photos: 

1. Select any number of photos. 

2. Select Proof from above the photo viewer. A window appears. 

3. Select Advanced Options from the bottom of the window. A new window 

appears with tabs: 

a. Page Setup: set the basic functions for your template. 

i. Enter a template name. Select Save if you want to save this 

template for later. 

ii. Select to orient the proof as a portrait, landscape, or custom. If you 

select Custom, select … next to Custom Layout at the bottom of 

the window and load a pre-made border proof sheet. 

iii. Select the page size, color, and media of the paper you will be 

printing. 

iv. Select the margins and select … to load any background or 

overlay images, such as a watermark. 

b. Images: set the individual photo properties for the template. 

i. Select an image size for the photos from the dropdown box, or 

select custom and enter a number of rows and columns. 

ii. Select the photo orientation, the padding between photos, and 

how to align the last row. 

iii. Select properties for the photos, including shadows, and frames. 

c. Header and Footer: this text will appear on the top and bottom of your 

proof sheets, respectively. 

i. Select to show the header or footer. 

ii. Select the text alignment and font. 

iii. Select Insert Special Text to add in specific information such as 

dates, filenames, customer data, or catalog info. 

d. Labels: this text will appear beneath each photo. 

i. Select to Show Labels. 



Using: Photo Library 

 

139 

 

ii. Select the position, alignment, and font. 

iii. Select Insert Special Text if desired. 

4. Select OK when finished with all the tabs. 

Using the Shopping Cart 
The shopping cart is where you will create and modify orders before sending them to 

print. You can create new orders to print immediately or save orders for later.  

Find the shopping cart in the Photo Library, Photo Workshop, and in Presentation Mode, 

always located at the very right of the software. The shopping cart will remain the same 

while using the software, saving items and settings while navigating through different 

areas of the program.  

Once an item is added to the shopping cart, a preview image will appear next to the 

quantity, package type, price, and services. You can change or edit any item or 

packages after it has been added to the cart. 

Showing and Hiding the Cart 

The shopping cart is hidden by default to leave more room 

for organizing and editing photos. To show or hide the 

shopping cart, select Show Cart or Hide Cart from the very 

top right of the software while in the Photo Library, Photo 

Workshop, or in Presentation Mode. 

For a complete reference guide to the Shopping Cart, 

including detailed screenshots and button locations, go 

here. 

Navigating the Cart 

The top of the shopping cart shows the default package 

group associated with this event. You set your default 

packages here.  

Below the package group is where all ordered items will 

appear as preview images.  
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Select + or – to expand or collapse the images below an item. 

Showing and Hiding Prices 

If a customer is present and you don’t want to display the prices of your packages, 

right-click on any package or item and select Show Prices. A checkmark indicates 

whether this option is active. 

Viewing Package Groups 

All of your packages are located at the top of the shopping cart. Your default package 

group is displayed for each event. Only 9 items will be displayed at once, to view 

additional items in this package group select More from the bottom of the package 

window in the cart. Select Prev to return to the previous packages. 

Changing Package Groups 

Although only your default package group will be displayed for each event, you can 

switch between your different package groups from the shopping cart.  

To manually navigate through all your package groups, select Prev and More from the 

bottom of the package window in the cart. 

To change the default package group, select Add Package from the bottom of the 

cart and select Change Default Group. Select the package group you want to display 

and use as the default. 

Adding an Item to the Cart 

To add an item to the cart as part of the packages you set up: 

1. Select the photo or photos you want to add to the cart.  

2. Select the package you want to add for this photo from 

the product list at the top of the shopping cart. If you 

selected more than one photo, the package will be 

added for each photo. 

3. Select the number of this package you want to add for 

your photo. 

 

OR: 
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1. Select the photo or photos you want to add to the cart. 

2. Select Add Package from the bottom of the shopping cart. 

3. Select the package you want to add for this photo from the list. If you selected 

more than one photo, the package will be added for each photo 

OR: 

1. Select a package you want to add from the product list at the top of the 

shopping cart. 

2. A number of blank frames will appear in the shopping cart for this package. 

3. Select and drag photos from your workspace into the blank frames in the 

shopping cart. 

Adding Items with the Keypad 

You can use the numbers or number keypad on your keyboard to quickly add items 

and their quantities to the cart. Each package has a number to the left, from 1 – 9.  

To add an item using the number keypad: 

1. Select the photo or photos you want to add to the cart. 

2. Select the keyboard number that corresponds to the package you want to add. 

3. Select a keyboard number to select a quantity of this package. If you selected 

more than one photo, the package will be added for each photo. 

Adding an A La Carte Item to the Cart 

A la Carte items are single items and not part of a package you have set up. To add an 

a la Carte item to the cart: 

1. Select the photo or photos you want to add to the cart. 

2. Hold and drag the photos into an empty space in the shopping cart. A window 

appears. 

3. Select the item type and quantity for your photo.  

a. Use the dropdown menu at the top of the window to view specific print 

sizes. 

b. You can select multiple, different items at the same time for your photo. 
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c. If you selected more than one photo, these items will be added for each 

photo. 

d. Select Clear Quantities to start over. 

4. Select OK. 

Placing an Order 

Once you have every package and item set, you can send the order to your orders 

workspace and off to printing. 

 

 

To place an order: 

1. Select Place Order, located below the packages area in the shopping cart. 

2. A window appears showing the receipt. 

3. Select Automatically Print Receipt to print an order receipt when an order is 

placed. 

4. Select Shipping to edit and verify all billing and shipping information. 

5. Select OK to send the order.  

a. If there is an error communicating with your studio management software, 

or the printer is offline, the order will be saved in the orders workspace for 

later. Click here for more information about using the orders workspace. 

Saving an Order 

If you want to save an order to your orders workspace without sending it off to print, 

select Save Order, located below the packages area in the shopping cart. The order 

will appear in the Pending Orders tab and can be reopened and edited at any time, or 

just sent off to print. Click here for more information about using the orders workspace. 
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Replacing an Item 

If you want to use a different photo but keep the package you selected, select the 

new photo from your workspace and hold and drag it over the old photo. The new 

photo will replace the old one in the package. 

Removing a Single Item 

You can remove single items from the cart without deleting the package it belongs to 

by right-clicking on the item and selecting Remove Item, or by selecting an item and 

selecting Remove Item from the bottom of the cart. 

Removing a Package 

You can remove an entire package and all of the contained items from the cart by 

right-clicking on the package or any item in it and selecting Remove Package. 

Clearing the Order 

If you want to clear all packages and items in the cart and start over, select Clear 

Order from the bottom of the cart. 

Changing Cropping for an Item 

The software will automatically determine how to crop the photos you add to the cart. 

If you want to change the cropping from vertical to horizontal, or vice versa, select the 

photo in the cart and select Change Cropping from the bottom of the cart. 

Adding or Subtracting Copies of Packages 

You can add or subtract the number of packages for photos already in the shopping 

cart. To change the number of packages: 

 

1. Select Copies, located next to any package in the cart. 

2. Select the new number of total packages for this item. 

a. Select More and enter a number if your number does not appear. 
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Adding Services to an Item 

If services have already been added to a photo, 

they will appear in the cart next to Services 

immediately after adding the item. To add or edit 

services for an item in the cart: 

 

1. Select Add next to Services, located beneath any item in the cart. 

2. Select the service to add to this item. 

3. Select OK. 

You can press the \ or right-click on any number of photos and select Service Notes for 

the previous options. 

Changing Media for an Item 

To change the printing media for an item: 

1. Right-click on the item in the cart and select Change Media. A window appears. 

2. Select a media type from the list, or select Add to type in a media. 

3. Select OK. 

Changing Print Commands for an Item 

To change the print commands for an item: 

1. Right-click on the item in the cart and select Change Print Commands. A window 

appears. 

2. Select a print command from the list, or select Add to type in a print command. 

3. Select OK. 

Editing Shipping Info 

To edit a customer’s shipping info, right-click on and select Edit Shipping Info. Edit the 

billing and shipping info, and change the shipping type and cost and select Save 

Changes. You can also press CTRL-H for the previous options. 
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Photo Paths 

You can view the computer folder and paths that contain the photos. 

To open the folder containing the photos: 

1. Right-click on a photo. 

2. Select Open Containing Folder. 

3. This is the location and subdirectory containing your selected photos. 

To copy the file location containing the photos: 

1. Right-click on a photo. 

2. Select Copy Path to Clipboard. 

3. The location is now saved in your clipboard. Selecting Paste or CTRL-V will paste 

the photos. 
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Using the Orders Workspace 

The Orders Workspace is where you can monitor all new, pending, and completed 

orders. The status of every order is available here, from creation to printing to being 

shipped out to the customer.  

Every order here has been sent through your online storefront, or was created through 

the shopping cart. Find and select the Orders tab from the bottom of the software. 

For a complete reference guide to the Orders Workspace, including detailed 

screenshots and button locations, go here. 

Navigating the Orders Workspace 
The orders workspace is made up of three different tabs, located at the very top left of 

the software: 

 New Orders: here are all orders that have been created or saved, but not yet 

printed. 

 Pending Orders: here are all orders that have been sent to print locally or at a 

lab, but are not yet finished or need to be shipped. 

 Completed Orders: here are all orders that have been printed and shipped. 

 

 

 

Located below the list of orders, in any tab, is the order info window. This window will 

display all current information about any order you have selected.  
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Viewing Orders 
Although there is a new, a pending, and a completed orders tab, the organization and 

options available for each tab are the same. 

Sorting Orders 

Once an order enters a tab, the following information is shown in the order list, from left 

to right: 

 Order ID: this is your order’s identifier, tied to your lab account.  

 Type: each order can be either a local order or a web order.  

 Customer: shorthand version of the customer purchasing the order. 

 Order Time: date and time the order was placed. 

 Status: displays the current status of your order, such as printing, waiting to print, 

saved, or shipped. 

 Status Time: date and time of the most current status. 

 Age: how long ago the order was placed. 

 Payment: cost of the order. 

 Fulfillment: orders can be fulfilled locally by you or a lab. 

 

Click on any of the previous headers to sort the order list by that type. 
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Finding Orders 

You can search for orders by order ID. To find an order, select find orders from the 

bottom of the software or right-click on the order list and select Find Order. Enter the 

entire order ID into the text field and select Find.  

Note: You must enter the order ID exactly as it appears in the software. 

Viewing Older Orders 

You can view older orders by selecting View from the very top center of the software 

and selecting an order age. Any orders up to and including the age you select will 

appear. These options are only available for completed orders. 

 Select All to view every order you’ve had in the studio.  

Refreshing the Order List 

Select Refresh from the very top center of the screen to refresh the orders and ensure 

your list is up to date. 

Viewing Order Information 

Selecting any order will display the following order information in the bottom half of the 

window: 

 Customer Information: the customer’s name, address, and contact information. 

 Order: the order number and date received. 

 Shipping Information: where the order will be sent when finished. 

 Item List: the item list displays the purchased items, the quantity, photo details, 

and the fulfillment method. All photo notes and services will appear here. 

Clicking the filename link for a photo will display a preview image of the photo.  

 Order Summary: the total cost and payment. 

 Order History: all order statuses and times. 
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Printing Orders 
Read on for information on sending orders to print. 

Printing an Order 

If Auto Print is disabled, you will need to manually send orders to print.  

To print a single order: select the order and select print order from the bottom of the 

software, or right-click an order and select Print Order. 

To print multiple orders: select any number of orders using CTRL or SHIFT and select print 

order from the bottom of the software, or right-click on any of the order and select Print 

Order. 

To print all orders: select print all orders from the bottom of the software, or right-click 

the order list and select Print All Orders. 

Printing an Order to CD 

To print an order to CD: 

1. Ensure that there is a CD in your disc drive. 

2. Select any number of orders. 

3. Select print to cd from the bottom of the software, or right-click the order and 

select Print to CD. 

4. The order will be saved to the CD. 

5. Ship or deliver the CD. 
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Reprinting Orders 

You can reprint orders that have already been fulfilled. To reprint an order, go to the 

Completed Orders tab and select an order, then select print order from the bottom of 

the software or right-click the order and select Print Order. You will be prompted to 

confirm that you wish to print a copy of this order. 

Viewing the Print Queue 

You can monitor and edit the printing status of any local orders that have been sent to 

print. Select Print Queue from the very top of the screen to view and edit the print 

queue. 

Select the Pending Jobs or Completed Jobs tab to see all pending and completed jobs 

with a preview, status, and start time. The bottom of the queue shows how many jobs 

are in the queue, and the number of printers available and currently in use. Select 

return to the order page at any time to leave the print queue. 

Select an option from the left side of the window to modify a pending print job: 

 Delete Print Job: remove selected print job from the queue. 

 Suspend Print Job: temporarily stop selected print job. 

 Resume Print Job: resume the selected suspended print job. 

 Restart Print Job: restart selected print job from the beginning. 

 Reprint Archived Job: find and reprint an old print job. 

 Scan for Printers: search for available printers. 

To move a job up or down in the queue, select a job and select an option from the 

right side of the window. 

Using Auto Print 

Auto Print will automatically send all local orders straight to the print queue and begin 

printing. To turn auto print on, select and check Auto Print from the very top center of 

the software. Selecting Auto Print again will uncheck and disable auto printing. 
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Managing Orders 

Marking Orders Shipped 

Any new or pending order can be marked as shipped and sent to the Completed 

Orders tab. Shipped orders will be treated as finished orders. To mark an order as 

shipped, select the order and select mark order shipped from the bottom of the 

software, or right-click the order and select Mark Order Shipped. 

Cancelling Orders 

If an order has been sent to print but has not yet printed, you can cancel it and remove 

it from the print queue. Select the order from the Pending Orders tab and select cancel 

print from the bottom of the software, or right-click the order and select Cancel Print. 

Deleting Orders 

To completely delete an order from the software, select the order and select delete 

order from the bottom of the software, or right-click on an order and select Delete 

Order. You will be prompted for confirmation. A deleted order will be completely 

removed from every part of the software and is unrecoverable. 

Batching and Unbatching Orders 

You can group individual orders together and treat them all as one large print order. 

This is useful when you have many separate orders that need to be ready at the same 

time, such as school pictures. 

To batch orders: 

1. Select any number of orders using CTRL or SHIFT. 

2. Right-click on one of the selected orders and select Batch Orders. 

3. The orders are still separate, but will be treated as one large order when sent off 

to printing. 

4. You can add additional orders to the batch by using CTRL to select the batch 

and the new order and repeating the previous steps. 

A batched order will be collapsed and given an internal batch order ID. Select + or – to 

expand or collapsed the contained orders. You can print individual orders contained 
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within a batch by expanding the batch, selecting the individual order, and selecting 

Print Order. 

 

 

Note: Batched orders selected for printing may appear as “Queued for Processing” in 

the Completed Orders tab but the individual order will display printed. 

Printing an Order Proof 

An order proof is a printed sheet with small previews of photos. We’ve already covered 

printing proofs of entire photo catalogs, but often you will only want to print a proof of 

photos that the customer has ordered.  

To print an order proof: 

1. Select the order you want to print a proof for. 

2. Select print order proof from the bottom of the software, or right-click on the 

order and select Print Order Proof. 

3. A window appears. 

4. Select the page size. This is the size of the sheet you will be printing on. 

5. Select the orientation: portrait or landscape. If you are only printing one image, 

select to use the image default orientation. 

6. Select a media. Leave this dropdown menu blank to use the default media. 

7. Select … to choose a page color. White is the default page color. 

8. Select Print all proofs on a single sheet (per order) to fit every photo proof for an 

order on a single sheet. 

9. Select the number of rows and columns. This option is disabled if you are printing 

all proofs on a single sheet. 

10. Select Square Cells to organize the proofs in equal squares for a symmetrical 

presentation. 
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Printing an Order Form 

An order form is a copy of the order information displayed in the bottom half of the 

orders workspace. To print an order form, right-click on the order then select Print Order 

Form. 

Printing a Simple Receipt 

A simple receipt is a quick, low-resolution receipt with only text and basic information, 

including: 

 Company info 

 Order ID 

 Date and time 

 Packages and package cost 

 Taxes 

 Total cost 

 

To print a simple receipt, right-click on the order then select Print Simple Receipt. 
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Editing & Proofing an Order 
You can quickly edit and proof photos from the Orders tab before sending orders off to 

print. Order proofing will open the photos in a version of the Photo Workshop that 

includes additional options and a navigation bar for easily moving between photos, 

pages, and orders. 

To edit and proof an order, select an order and select edit & proof from the bottom of 

the software, or right-click on an order and select Edit & Proof Order. The order proofing 

window will appear. 

For more information on editing and correction tools, click here to read about the 

Photo Workshop. 

Navigating while Editing & Proofing 

The middle of the Order Proofing page is identical to the Photo Workshop and has all of 

the same features, tools, and options. Use the Enhance, Correct, Color Balance, and 

Drop Out tabs at the bottom of the software to switch between the Photo Workshop 

toolsets, detailed here. 

The current order ID will be displayed at the top center of the window. 

The navigation bar at the bottom of the software is designed for moving quickly 

between photos, pages of photos, and entire orders. The left side moves back through 

photos and the right side moves forward through photos.  



Using: Orders Workspace 

 

155 

 

 

 

 

 Select the Home or End buttons to go to the first and last photos in the order, 

respectively. 

 Select close to return to the Orders tab. You will be prompted to save any 

changes. 

 Select save order to save all changes to the order and return to the Orders tab. 

 Select begin editing to display editing tools. Select finish editing to hide the tools. 

Auto Editing Orders 

Enabling auto edit will display the Photo Workshop toolsets the entire time while in Order 

Proofing. Enable auto editing by selecting and checking auto edit from the top of the 

software. 

Auto edit is enabled by default. Disable auto editing by selecting and unchecking auto 

edit from the top of the software.  

Viewing Photos 

Select view from the top of the software to select viewing options: 

 # Photos: select the number of photos to view at once. Press SHIFT - # as a hotkey 

to display # photos. 

 Auto View Photos: let the software decide how many photos to display. Enabled 

by default. 

 Show Less or More photos: press – or + as hotkeys to show less or more photos. 

 Show Lab Name: show the fulfillment type and name below each photo. 

 Show Filename: show the filename below each photo. 

 Show Item Description: show the product information below each photo. 

 Show Editing Guides: display grid lines and aspect ratio lines while editing. 

 Soft Proof with Printer Profile: display the photo with the printer color profile. 

 High Quality Preview: view higher quality images. Enabled by default. 
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 Order Proof or Photo Proof Mode: order proof displays all photos and all toolsets. 

Photo proof displays only correction and color balance tools. 

 Show and Choose Reference Image: you can select an image to show alongside 

each photo you are editing. While you may move between photos and orders, 

the reference image will remain locked. Select Choose Reference Image to 

browse for an image. Select Show Reference Image or press R to hide and 

display the image. 

Orienting Photos 

For information on orienting photos, click here. 

Saving and Applying Attributes 

For information on attributes, click here. 

Changing Order Properties 

While in Order Proofing you can change the properties of a selected item: 

1. Select an item. 

2. Select Properties from the top of the software, or right-click on a photo. 

3. Select to: 

 Change Product: Select from Lab Products or press CTRL – SHIFT – R, or Select 

from Local Products or press CTRL – R. 

 Change Filename: replace the item with another on file. Press ALT – F as a 

hotkey. 

 Change Quantity: change the number of packages for this item. Press Q as a 

hotkey. 

 Change Media: change the type of printing media for this item. Press M as a 

hotkey. 

 Service Notes: add or edit services for this item. Press \ as a hotkey. 

 Order Comment: add an order comment to this item. This comment will 

appear in the order information window on the Orders tab. 

 Edit Shipping Info: edit customer billing and shipping information. 
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To change an order property, select a photo and select Properties from the top of the 

software, or right-click on a photo for the previous options. 

Undoing and Redoing Changes 

To undo or redo changes to a photo or order, select Undo from the top of the software 

and select one of the options, or press the corresponding hotkey. 

 Undo or CTRL – Z 

 Redo or CTRL – Y 

 Undo Photo Changes or CTRL – U 

 Undo Order Changes or CTRL – O 

Saving Orders 

To save your selection as a new order: 

1. Select a package or product. 

2. Select Print from the top of the software. 

3. Select Save Selection as New Order, or press CTRL – S as a hotkey. 

4. The item will be saved in the Orders tab as a new order. 

To save the current order as a new order, select Print from the top of the software and 

select Save Current Order as New Order, or press ALT – S as a hotkey. The new order will 

be saved the Orders tab. 

To save the current order, select Print from the top of the software and select Save 

Current Order, or press S as a hotkey. You can also select save order from the bottom 

right of the software. 

Printing Orders 

To print your selection as a new order: 

1. Select a package or product. 

2. Select Print from the top of the software. 

3. Select Print Selection as New Order, or press CTRL – P as a hotkey. 

4. The item will be printed and a new order added to the Orders tab. 

To print the current order, select Print from the top of the software and select Print 

Current Order. 
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Using Presentation Mode 

Presentation Mode combines features from each other part of the software for an easy-

to-use interface, free of distractions. You can show slideshows, play background music, 

compare photos within a catalog, preview photos in digital frames, and purchase 

packages. 

The Presentation Mode is made for walking customers through selecting and rating their 

photos, choosing services, and purchasing packages, all during the same session. 

 

 

 

To activate Presentation Mode, you must have a catalog open in either the Photo 

Library or the Photo Workshop. Turn on Presentation Mode by selecting the Client 

Presentation tab at the bottom of the software. 

Select exit presentation mode from the very top right of the software to exit 

Presentation Mode. 

For a complete reference guide to Presentation Mode, including detailed screenshots 

and button locations, go here. 
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Opening the Photo Library and Photo Workshop 
You can use both the Photo Library and the Photo Workshop without exiting 

Presentation Mode.  

To open the Photo Library, select choose another catalog from the bottom of the 

workspace. 

To open the Photo Workshop, select enhance selected photo from the bottom of the 

workspace. 

Navigating in Presentation Mode 
The software will automatically be maximized to full-screen, so that no other programs 

will interrupt the session. The software itself will hide all other tabs. 

The top of the workspace has a single toolbar for viewing and adjusting photos. 

 

 

 

The bottom of the workspace has a single toolbar for navigating between photos, 

catalogs, and editing. 

 

 

Viewing Photos in Presentation Mode 

Viewing Individual Photos 

To switch between photos within the current catalog, select an option from the 

navigation menu at the bottom of the workspace: 
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 Home: view the first photo in the album. 

 Previous: view the previous photo in the album. 

 Next: view the next photo in the album. 

 End: view the last photo in the album. 

You can also use the mouse wheel to quickly move through a catalog. 

Viewing Multiple Photos 

To view multiple photos at a time, select view from the top of the software and select a 

number of photos to view, or press SHIFT – 1 through SHIFT – 0 as hotkeys. 

To view more or less photos, select view from the top of the software and select View 

Less Photos or press – as a hotkey, or select View More Photos or press + as a hotkey. 

Viewing Photo Information 

To view filenames beneath photos, select view from the top of the software and select 

and check Show Filenames. 

To view photo numbers beneath photos, select view from the top of the software and 

select and check Show Photo Numbers. 

Viewing High Quality Previews 

To view high quality previews of your photos, select view from the top of the menu and 

select and check High Quality Preview. These images have more detail and are easier 

to edit. 

Managing Photos in Presentation Mode 

Changing the Aspect Ratio 

To change the aspect ratio of all photos in Presentation Mode, select view from the top 

of the software and select Viewing Aspect. You set up your viewing aspects here; select 

one from the list. 
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Sorting Photos 

To sort photos in Presentation Mode: 

1. Select view from the top of the software. 

2. Select to sort photos by: 

 Rating: sort by your assigned 1 to 5 star rating.  

 Photo Number: sort by the assigned photo numbers.  

 Filename: sort by the photo filename. 

 Full Pathname: sort by the entire computer pathname. 

 File Size: sort by file size. 

 Published: sort by published and unpublished. 

 Archived: sort by archived and unarchived. 

 Exif Comment: sort by Exchangeable Image File information. 

 Sort by Custom: manually click and drag photos to their positions. 

3. Select to sort photos by the previous criteria in either ascending or descending 

order. 

Rating Photos 

Every photo can be assigned a 1 to 5 star rating. These ratings can signify either your 

favorite photos, or the customer’s favorite photos. 

To rate a photo: 

1. Select any number of photos that you want to have the same rating. 

2. Select rating from the very top center of the software. 

3. Select 1 to 5 stars, 1 being fair and 5 being best. 

You can also rate photos by pressing F1 through F5 as hotkeys, with F1 being fair and F5 

being best, or by clicking a number of stars at the top of the software. 

Orienting Photos 

To orient selected photos, select orientation from the top of the software. Orientation 

options are detailed here. 
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Adding Services 

Service notes are additional services performed on photos above and beyond the 

normal touchups.  

To add a service to a photo: 

1. Select any number of photos. 

2. Select service notes from the bottom of the software. 

3. Check to select any of your available services to be applied to the photo. 

4. Select OK. 

5. These services will be applied to this photo in any size in any order. 

You can also add or edit services by pressing \ as a hotkey. 

Comparing Photos 

You can lock specific photos in Presentation Mode to compare it to other photos as 

you move through the catalog. 

To lock a photo for comparing, select a photo and select compare from the top of the 

software, or right-click a photo. A red dog-ear will appear in the upper-right hand 

corner of the photo when it is locked. Select unlock from the top of the software to 

unlock a photo. 

While a photo is locked, you can move freely through the album, but your locked 

photos will remain in the workspace. At any time you can quickly unlock and lock other 

photos. 
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Playing Background Music 

You can play background music to set a classy and calming atmosphere for your 

customers as they preview their photos. 

To play music: 

1. Select music from the top of the software. 

2. Select Play Music Folder or Play Music File and select the music you want to play. 

 

a. Selecting a folder will loop all music files in the folder. 

b. Selecting a file will loop the single music file over and over. 

 

3. Select Choose Music Folder or Choose Music File to search for and select your 

own music. 

To turn off music, select music from the top of the software and select and check off. 

Using the Shopping Cart 
The shopping cart is where you will create and modify 

orders before sending them to print. You can create 

new orders to print immediately or save orders for later.  

Find the shopping cart in the Photo Library, Photo 

Workshop, and in Presentation Mode, always located at 

the very right of the software. The shopping cart will 

remain the same while using the software, saving items 

and settings while navigating through different areas of 

the program.  

You can hide your packages and prices within the 

shopping cart by selecting hide packages from above 

the shopping cart when the cart is displayed. 

For a detailed guide to using the shopping cart, click here. 



Using: Presentation Mode 

 

164 

 

Running a Slideshow 
You can view a catalog as a slideshow presentation, complete with music and digital 

frames. The slideshow will preview photos at fullscreen with a black background and 

few software tools. 

To run a slideshow, select fullscreen from the 

top of the software or double-click a photo.  

 Press ENTER to begin and stop the 

slideshow. 

 Select a photo or press ESC as a 

hotkey to return to normal Presentation 

Mode. 

Slideshow options: 

 Auto: select auto to run an automatic 

slideshow. Select slideshow intervals and to gently fade photos in and out as a 

transition. 

 Music: select music options, detailed here. 

 Choose: select additional viewing options: 

o Single Picture Mode: when viewing multiple photos with frames, the 

current photo will appear in every frame. Normally, different photos from 

the catalog will appear with it. 

o Show Filenames: view filenames beneath the photo. 

o Show Image Numbers: view photo numbers beneath the photo. 

o Show Rating: view photo ratings beneath the photo. 

o Choose Font: select a font for any text appearing beneath the photo. 

o Sort Photos: sort photos with options detailed here. 

o Frames: select frame styles and size to preview what the photo will look 

like in a number of different frames and locations. Simple is the last option 

and the default black border. 

 Close: return to normal Presentation Mode. 



Using: Photo Workshop 

 

165 

 

Using the Photo Workshop 

The Photo Workshop is where you will enhance, correct, and edit all of your photos 

before printing. The Photo Workshop works internally within the software and does not 

require any additional software to run, making it quick and easy to edit, retouch, and 

save changes to any photos in the software. 

Find and select the Photo Workshop tab at the bottom of the software.  

For a complete reference guide to the Photo Workshop, including detailed screenshots 

and button locations, go here. 

Navigating the Photo Workshop 
The Photo Workshop workspace is separated into three areas, appearing in the 

software from left to right: 

 Photo Bar: select, view, and mange photos within the workshop. 

 Workspace: select toolsets tabs, tools, and edit photos.  

 Shopping Cart: select packages and photos for purchase and add to orders. 
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Viewing Photos 
Once in the workshop you can view, sort, and manage photos, using many of the same 

features from the Photo Library, without needing to exit the Photo Workshop tab.  

Viewing Modes 

There are two different viewing modes in the workshop. Select Single or Multiple from 

the very top left of the software to choose one: 

 Single: the photo bar appears at the left side of the software for selecting and 

navigating through photos. Use the arrows at the very top left and very bottom 

left to scroll between photos within the current catalog. Selecting a photo will 

display it in the workspace for editing. 

 Multiple: the photo bar does not appear. All photos in the current catalog will 

appear in the workspace as smaller images. You can edit any or all of the photos 

at once while editing to apply the edits to all of the selected photos. 

 

 

 

Double-clicking on a photo while in multiple mode will switch to Single mode with the 

selected photo in the workspace. 

Viewing Fullscreen 

To view the current workspace photo as a fullscreen preview on a black background, 

select Fullscreen from the top of the software. Click anywhere to return to the 

workshop. 
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Viewing a Slideshow 

To view a slideshow of all photos in the catalog, select Catalog from the bottom left of 

the software and select Slideshow. The software will switch to Presentation Mode, where 

you can run slideshows, play music, and view the photo with different frames. Click here 

for detailed options during full-screen Presentation Mode. 

Viewing without Tools 

To view your photos without the Photo Workshop tools displayed, select the View tab 

from the bottom of the software. Select another toolset tab to view editing tools. 

Viewing Front and Back 

Some photos will have a front and a back when printed. To switch between viewing the 

front and back of the photo, select View from the top of the software and select either 

Front or Back. 

Viewing High Quality Previews 

To view high quality preview images, select View from the top of the software and 

select and check High Quality Preview. These images have more detail and are easier 

to edit. 

Viewing with a Printer Profile 

You can view photos as soft proofs with your printer profile to get a better idea of what 

the printed product will look like. To view photos with a printer profile, select View from 

the top of the software and select Soft Proof with Printer Profile, and select or browse to 

a printer profile. 

Viewing and Setting Aspect Ratios 

Every photo in the workshop is displayed cropped to an aspect ratio. The default 

aspect ratio will depend on your camera settings, but once an aspect ratio is set for a 

photo it will be saved.  

To view the current photo with a different aspect ratio: 

1. Select a photo. 

2. Select View from the top of the software. 
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3. Select Viewing Aspect. 

4. Select a viewing aspect from the list. All viewing aspects included in your 

packages will appear in the list. 

OR: 

1. Select a photo. 

2. At the top right of the window is a viewing aspect with arrows on each side. 

3. Select the < and > arrows to cycle through the available aspect ratios. 

You can also add, edit, and remove aspect ratios from the list. To set up available 

aspect ratios: 

1. Select View from the top of the software. 

2. Select Setup Aspect Ratio List. 

3. A window appears. 

4. Select Add to create a new aspect ratio. 

a. Select a name, width, and height. 

5. Select an aspect ratio and select Edit to edit an existing aspect ratio. 

a. Select a name, width, and height. 

6. Select an aspect ratio and select Remove to delete it. 

7. Select Reset List to revert to the default list. 

8. Select Move Up or Move Down to change position of an aspect ratio in the list. 

9. Select and check Automatically add package aspect ratios to list to have all 

aspect ratios from your packages added to the list. This option is enabled by 

default. 

10. Select OK. 
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Viewing Guides 

You can turn on guides to help while editing photos.  

To turn on guides: 

 

1. Select View from the top of the software. 

2. Select Guides.  

3. Select and check Show Guides, or press CTRL - ; 

as a hotkey.  

4. There are two guides available, check the one 

you wish to use: 

a. School: for school portraits. This guide will 

show dotted lines for the 4x6, 5x7, and 

8x10 aspect ratios, and an oval and line 

for centering student faces in the frame. 

b. Standard: for aspect ratios. This guide will show dotted lines for the 4x6, 

5x7, and 8x10 aspect ratios. 

Clearing Photos from the Workspace 

To clear the workspace, select View from the top of the software and select Clear, or 

press ESC as a hotkey. 

Sorting Photos 

To sort photos in the Photo Workshop: 

1. Select Sort from the top of the software. 

2. Select to sort photos by: 

 Rating: sort by your assigned 1 to 5 star rating.  

 Time: sort by the time stamp on each photo. 

 Photo Number: sort by the assigned photo numbers.  

 Filename: sort by the photo filename. 

 Full Pathname: sort by the entire computer pathname. 
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 File Size: sort by file size. 

 Published: sort by published and unpublished. 

 Archived: sort by archived and unarchived. 

 Exif Comment: sort by Exchangeable Image File information. 

 Sort by Custom: manually click and drag photos to their positions. 

3. Select to sort photos by the previous criteria in either ascending or descending 

order. 

You can also sort photos by right-clicking on a photo in the photo bar and selecting 

View, or by selecting Catalog from the bottom left of the software and selecting Sort 

Photos, which contain the previous options. 

Finding Photos 

To search for a photo in the photo bar: 

1. Select Catalog from the bottom left of the software and select Find Photo, or 

press CTRL – F as a hotkey. 

2. Enter the text and type to search for: Filename, Path, Photo Notes, Film Number, 

or Exif Comments. 

3. Select to match only whole words. 

4. Select to match case of words. 

5. Select to search up or down within the photo bar. 

6. Select Find. 

To search for additional photos with the same search criteria, select Catalog from the 

bottom left of the software and select Find Next Photo or press F3 as a hotkey, or select 

Find Previous Photo or press SHIFT – F3 as a hotkey; the software will search the previous 

and next photos in the photo bar matching your search criteria. 

Refreshing Photos 

To refresh photos in the photo bar, select Catalogs and select Refresh Photos, or press  

CTRL – F5 as a hotkey. You can also right-click a photo in the photo bar and select 

Refresh. 
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Showing Photo Information 

Showing and Setting Photo Numbers 

To show photo numbers above photos in the photo bar, select View from the top of the 

software and select and check Show Photo Numbers. 

To set a starting photo number for all new photos added to the catalog, select Catalog 

from the bottom left of the software and select Set Starting Photo Number. All existing 

photo numbers will remain the same. 

To reset the photo numbers for every photo in the catalog, select Catalog from the 

bottom left of the software and select Reset Photo Numbers. You will be prompted to 

enter a starting number for the photos. 

Showing Photo Icons 

To show photo icons above photos in the photo bar, select Catalog from the bottom 

left of the software and select and check Show Photo Icon. Possible photo icons: 

  - Printed 

  - Archived 

  - Enhanced  

  - Hidden from Publishing 

  - Published 

Showing and Setting Photo Ratings 

To show photo ratings above photos in the photo bar, select Catalog from the bottom 

left of the software and select and check Show Photo Rating. 

To set a photo rating: 

1. Select any number of photos that you want to have the same rating. 

2. Right-click on one of the selected photos. 

3. Select Edit Photo > Rate Photo. 

4. Select 1 to 5 stars, 1 being fair and 5 being best. 
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Showing and Setting Filenames 

To show photo filenames below photos in the photo bar, right-click a photo in the 

photo bar and select View > Show Filenames. 

To rename a photo, right-click on a photo in the photo bar and select Edit Photo > 

Rename Photo. This will be the new photo filename. 

To set filenames for all new photos imported into the catalog from a camera: 

1. Select Catalog from the bottom left of the software. 

2. Select Set Capture Filenames. 

3. Type a prefix for the Customer Identifier. 

4. Select a starting Picture Number. 

5. An example of your filename will appear next to Resulting filename. 

6. Select OK. 

Showing and Copying Photo Paths 

To view the entire filename path below photos in the photo bar, right-click a photo and 

select View > Show Paths. 

You can also view the computer folder and paths that contain selected photos. 

To open the folder containing the photos: 

1. Right-click on a photo in the photo bar. 

2. Select Open Containing Folder. 

3. This is the location and subdirectory containing your selected photo. 

To copy the file location containing the photos: 

1. Right-click on a catalog photo in the photo bar. 

2. Select Copy Path to Clipboard. 

3. The location is now saved in your clipboard. Selecting Paste or CTRL-V will paste 

the location of the photos. 
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Showing and Setting Info Tooltips 

To display a tooltip containing photo comments while mousing over a photo in the 

photo bar, right-click a photo and select View > Show Info Tooltip. 

To set a note for a photo, right-click a photo in the photo bar and select Edit Photo > 

Describe Photo. Type a note and select OK. 

Showing Photo Properties 

To show and edit photo properties, right-click a photo in the photo bar and select 

Properties. Click here detailed information on photo properties. 

Showing Photo Histograms and Data 

To show technical photo data, select Show Data from the top right of the software. The 

following information will be shown on the right side of the workspace: 

 

 Filename 

 Capture Date 

and Time 

 Capture 

Resolution 

 Capture 

Megapixels 

 Photo Histogram 

 EXIF Data 

 Editing Software 

 ISO Info 

 Flash Settings 

 Color Space 

 Photo Notes 

 Photo Rating 

 Photo Number 

 

Select [Click to Add] under photo data to add photographer notes to this photo. 

Select Hide Data from the top left of the software if you do not want to display photo 

data. 

Importing Photos 
You can automatically import photos into the workshop by opening a catalog in the 

Photo Library and selecting the Photo Workshop tab from the bottom of the software. 

The selected catalog will automatically open in the Photo Workshop. 
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Importing a Photo 

To import a photo into the current catalog: 

1. Select Photos from the top of the software. 

2. Select Import. A window appears. 

3. Browse to the location of the photos you wish to import. 

4. Select any number of photos by holding and dragging the mouse or manually 

clicking each one holding CTRL or SHIFT. 

5. Select how to copy the files: 

a. Simply copy the files to the destination without changing the file type. 

b. Or Convert the files to another format while copying. 

i. Select a new file format for the imported photos. 

6. If you want to rename the imported photos, select Rename copied files. 

a. Select a file name prefix. 

b. Select a starting number. 

c. Select Reverse Chronological to rename photos starting with the last first. 

 

7. Select Delete files after copying them if you want to permanently remove these 

files from this location after importing. 

8. Select Import to import selected photos, or select Import All to import all photos 

in the current location. 

You can also import photos by pressing the hotkey CTRL – I and following the previous 

steps. 

 



Using: Photo Workshop 

 

175 

 

 

Using Quick Import 

Quick import will automatically search and import photos from a predefined location.  

To set up quick import: 

1. Select Photos from the top of the software. 

2. Select Quick Import Setup, or press SHIFT – I as a hotkey. 

3. A window appears. 

4. Browse to the location for automatically importing photos. 

5. Select how to copy the files: 

a. Simply copy the files to the destination without changing the file type. 

b. Or Convert the files to another format while copying. 

i. Select a new file format for the imported photos. 

6. If you want to rename the imported photos, select Rename copied files. 

a. Select a file name prefix. 

b. Select a starting number. 

c. Select Reverse Chronological to rename photos starting with the last first. 

7. Select Delete files after copying them if you want to permanently remove these 

files from this location after importing. 
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8. Select Recurse Subdirectories if you want to import all photos from subfolders 

and subdirectories in this location. 

9. Select OK. 

To use quick import: 

1. Select Photos from the top of the software. 

2. Select Quick Import, or press I as a hotkey. 

3. Photos will be automatically imported from the location defined in quick import 

setup. 

4. You will be prompted for confirmation when importing these photos. 

5. The photos will be added to the current catalog. 

Importing Photos from a Camera 

If you have a tethered or WiFi camera connected and set up in the software, you can 

import photos into the current catalog as they are taken.  

To import photos from a tethered or WiFi camera as they are captured: 

1. Ensure that the camera is set up properly and connected to the software via USB 

cable or through WiFi. 

2. Take a photo with the camera, or press SPACE on the keyboard. 

3. The photo will automatically be added to the current catalog. 

OR: 

1. Ensure that the camera is set up properly and connected to the software via USB 

cable or through WiFi. 

2. Select Live View at the top of the software.  

3. A window appears showing the view of the connected camera. 

4. Select Shutter from the new window or select Take Picture from the top of the 

software to take a photo. 

5. The photo will be automatically added to the current catalog. 
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Creating a Catalog 

To create a catalog in the workshop: 

1. Select Catalog from the bottom left of the software. 

2. If you want to create a new catalog and automatically import photos from your 

quick import location, select and check Create New & Import. 

3. Select Create New. 

4. Select Add Photo Catalog. 

5. A wizard opens. Select a category type from the drop-down box. 

6. Enter an event name. You must enter an event name. 

7. Enter a description, event city, state, and country. This is optional. 

8. Enter an event date. You must enter an event date. 

9. Enter event notes. 

10. Select Next. 

11. Enter customer information. 

a. If you are using 3rd-party studio management software, enter in your 

customer and session values. These must match in both softwares. 

12. Select Finish. 

Creating a Photo Group 

Photo groups are subcategories of catalogs. For example, one customer could have 

several different photo groups; one for each portrait sitting.  

To add a photo group to an existing catalog in the workshop: 

1. Select Catalog from the bottom left of the software. 

2. If you want to create a new photo group and automatically import photos from 

your quick import location, select and check Create New & Import. 

3. Select Add Photo Group to and ensure that it lists the correct catalog. 

4. Enter a name for the photo group. You must enter a name. 

5. Enter notes. 

6. Enter the event date. You must enter a date. 
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7. If you are using 3rd-party studio management software, enter your session ID. 

8. Select Finish. 

Managing Photos 
Read on for guides to managing your photos in the Photo Workshop. 

Selecting Photos 

Often you will want to edit multiple photos at once. To select multiple photos, hold CTRL 

or SHIFT and select the photos from the photo bar. 

To select all photos, right-click on any photo in the photo bar and select Select All. 

To deselect all photos, right-click on any photo in the photo bar and select Deselect All. 

Applying and Saving Attributes 

Attributes are a series of edits or settings for a photo that can be saved and applied to 

other photos and catalogs. You can quickly assign and apply up to four different 

attribute settings at once, or create new ones. The Photo Library and the Photo 

Workshop both use the same set of attributes. 

To apply or save attributes, select a photo and select Attributes from the top of the 

software. Here is a detailed guide to attributes. 

To reset attributes for a photo: 

1. Select a photo. 

2. Select Attributes from the top of the software.  

3. Select Reset Current to revert to the currently applied attributes.  

4. Select Reset System Defaults to revert to the default software attributes. 

Applying Services 

You can apply and edit services from the Photo Workshop.  

To apply or edit services: 

1. Select a photo. 
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2. Select Attributes from the top of the software. 

3. Select Service Notes. 

4. Select to add or remove a photo service for the selected photo. 

5. Select to add a service comment or additional service. 

6. Select OK. 

You can also apply and edit services for a photo by right-clicking the photo in the 

photo bar and selecting Edit Photo > Service Notes. 

Orienting Photos 

You can change the orientation of photos within the photo bar. These options are the 

same as Photo Library orientation options, found here. 

Editing Shipping Info 

To edit a customer’s shipping info, right-click on any photo in the photo bar and select 

Shipping Info, or press CTRL – H as a hotkey. Edit the billing and shipping info, and 

change the shipping type and cost and select Save Changes.  

Removing Photos 

To remove a photo from the catalog, right-click a photo in the photo bar and select 

Remove Photo. A prompt will appear for confirmation. If you want to permanently 

delete the photo file, select Delete the picture file(s) as well. Select OK. 

Saving Changes and Photos 

Once you are finished editing a photo, you’ll want to save it. The save options are 

located in the basic toolset menu. You must be viewing the toolsets to save the current 

photo. Select a save option: 

 

 Save changes: save the changes to the current photo, replacing the current 

photo in the catalog. 

 Save as new photo: save the changes as a new photo that will be added to the 

catalog, leaving the original in the catalog unchanged. 
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 Save to: select save to for the previous options, or to save to file. Saving to file will 

bring up a window. Browse to the location you want to save in, enter a filename, 

and select Save. 

Editing Photos 
Click here for guides to editing photos and using the different toolsets. 

Using the Shopping Cart 
The shopping cart is where you will create and modify orders before sending them to 

print. You can create new orders to print immediately or save orders for later.  

Find the shopping cart in the Photo Library, Photo Workshop, and in Presentation Mode, 

always located at the very right of the software. The shopping cart will remain the same 

while using the software, saving items and settings while navigating through different 

areas of the program.  

For a detailed guide to using the shopping cart, click here. 
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Using Toolsets in the Photo Workshop 

Once you have imported or captured photos into the Photo Workshop, you can use a 

series of tabs and toolsets to edit, enhance, or adjust every aspect of a photo. The 

following toolsets are available: 

 Basic Toolset: this toolset is always visible either to the left or above the photo 

workspace. It includes moving, scaling, orientation, and zoom options. 

 Enhance Toolset: this toolset includes basic photo effects such as frames, 

borders, color softwares, vignettes, and all retouching tools. 

 Correct Toolset: this toolset includes tools for correcting brightness, contrast, 

exposure, tones, and redeye. 

 Picture Style: this toolset includes tools for correcting photos using EOS Picture 

Styles. 

 Color Balance Toolset: this toolset includes color profiles and tools for correcting 

lighting and color balance. 

 Drop Out Toolset: this toolset includes chroma key settings for shooting with green 

screen. 

 

 

 

Editing photos in the Photo Workshop will not affect the saved photo files. Your edits will 

be saved and applied separately, keeping your original files intact and making it 

possible to remove edits at any time by reverting to the original photo file. 

Using the Basic Toolset 
The basic toolset is always displayed in the Photo Workshop when toolsets are visible, 

either at the left of the workspace (portraits) or above the workspace (landscapes). Use 

the basic toolset for adjusting location, size, and orientation of photos in the workspace.  
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Basic toolset options are, in order: Move, Scale, Orientation, and Zoom.  

 

Saving Changes 

The software will not save correction settings for a photo if you select another photo. To 

save your settings for a photo, use the save options detailed here. 

Moving a Photo 

Photos will often be larger than the sheet and will need to be centered in 

some way. You can move a photo around within the sheet size. 

Basic move options include: 

 Select an arrow on the move tool to move the photo in that direction. 

 Select the box in the middle of the tool to center the photo. 

Select Move to open a dropdown menu with additional options: 

 Select Reset X or Y Position to set X and Y to 0. 

 Select an X or Y offset to move the photo left (negative) or right (positive). 

You can also move a photo by clicking and holding the left mouse button over the 

photo and moving the mouse. 

Scaling a Photo 

Scaling a photo will increase or decrease the size within the sheet size. 

Basic scale options include: 

 Select the – arrow to decrease the photo size. 

 Select the + arrow to increase the photo size. 

 Select the box in the middle of the tool to revert to the original size. 

Select Scale to open a dropdown menu with additional options: 
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 Select Reset Scale to revert to the original size. 

 Select Reset Scale and Position to revert to the original size and center the 

photo. Press CTRL – R as a hotkey. 

 Select a % to increase or decrease the photo size. 

You can also scale a photo by moving the mouse wheel up and down. 

Orienting a Photo 

You can change the orientation of photos in the workspace. 

Basic orientation options include: 

 Select the clockwise or counter-clockwise arrows to rotate the 

photo 90° in that direction. 

 Select the vertical orientation box to view the photo vertically. Select the box 

again to rotate it 180°. 

 Select the horizontal orientation box to view the photo horizontally. Select the 

box again to rotate it 180°. 

Select Orientation to open a dropdown menu with additional options: 

 Vertical: oriented vertically. 

 Horizontal: oriented horizontally. 

 Vertical Flipped: oriented vertically but upside-down compared to the original. 

 Horizontal Flipped: oriented horizontally but flipped sideways compared to the 

original. 

 Rotate Clockwise: rotate the photo 90° clockwise. Press O as a hotkey. 

 Rotate Counter-Clockwise: rotate the photo 90° counter-clockwise. Press SHIFT - 

O as a hotkey. 

 Flip: flip the photo 180°. 

 Set Crop Orientation: this determines how the image will be cropped to fit on the 

photo. Select Auto to let the software decide on a per photo basis, or select 

Vertical or Horizontal. 

 Set Default Orientation: this determines how photos are automatically oriented. 

Select No Default Orientation to let the software decide on a per photo basis. 
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 Set Tilt Angle: enter a number between 0 and 360 and select to rotate clockwise 

or counter-clockwise. 

 Advanced Tilt: for manually creating a tilt angle. Click and drag either the photo 

or the scroll bar to adjust the tilt angle. Using advanced tilt can change the size 

of your image as the frame will crop to eliminate blank space. Select apply 

changes to save your tilt. 

 

 

Zooming 

Zooming in or out on a photo does not change the size of the photo. It 

changes the size of the image viewed on your monitor. Use zooming for 

editing small features and retouching. 

Basic zoom options include: 

 Select an aspect ratio around the zoom tool to zoom in that amount, or select 

Zoom and select one from the list: 

o 1:1, Actual Size: represents the actual size of the image, pixel for pixel. 

Press Z as a hotkey. 
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o 2x: Represents an image 200% larger than the image size displayed in the 

window or press SHIFT – Z as a hotkey. 

o 3x: Represents an image 300% larger than the image size displayed in the 

window or press ALT – Z as a hotkey. 

o 4x: Represents an image 400% larger than the image size displayed in the 

window or press ALT – SHIFT – Z as a hotkey. 

To zoom out, right-click the mouse on the photo. 

Select Zoom to bring up a dropdown menu with additional options: 

 High Quality Zoom: select and check this option to view zoomed photos as high 

quality images. 

 Floating Loupe: select and check this option to zoom in with a floating 

magnifying glass. This option is enabled by default. Disabling this option will zoom 

in on the entire photo within the sheet.  

 

 

Using the Enhance Toolset 
The enhance toolset includes tools for retouching and enhancing photos. To open the 

enhance toolset, select the Enhance tab from the bottom of the Photo Workshop 

workspace. The enhance tools will appear either to the right or below the workspace. 
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Enhance toolset options are, in order: Color, Borders, Sheets, Focus, Vignettes, and 

Retouching. 

 

 

Saving Changes 

The software will not save enhancement settings for a photo if you select another photo. 

To save your settings for a photo, use the save options detailed here. 

Retouching a Photo 

Studio Solution has its own integrated workshop for retouching and 

cleaning up photos. You can use either the software’s Retouch 

Workshop, or Adobe Photoshop.  

To set the default retouch, click retouch in the retouch tool and select to check either 

Use Retouch Workshop or Use Adobe Photoshop. 

To open your selected retouching workshop, select the brush icon in the retouch tool. 

 Using the Retouch Workshop: the photo will be automatically opened in the 

Retouch Workshop. Click here for a guide to using the Retouch Workshop. 

 Using Adobe Photoshop: the software will automatically open Adobe Photoshop 

and import the photo. A small window will appear with a Save Retouched Photo 

button. When you are finished retouching, select Save Retouched Photo to save 

the photo and automatically import it back into Studio Solution. Adobe 

Photoshop will remain open. Adobe Photoshop must be installed to use this 

feature. 
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Applying Colors 

You can change and apply color schemes to photos. Applying a color 

does not permanently change the photo; a color scheme can be 

changed or removed at any time by returning to the workshop. 

Select one of the color schemes to apply it to the photo: 

 Color: resets the color scheme to the original color of the digital negative. 

 Black & White: sets the color to grayscale. 

 Sepia: sets the color to sepia tones. Aged black & white photos naturally fade to 

this color over time. 

 Retro: sets the color to retro tones. Aged color photos naturally fade to this color 

over time. 

 Duotones: the photo is turned to grayscale with a subtle color tone applied. 

Select from: 

o Ruby, Bronze, Tarnished, Emerald, Turquoise, Selenium Blue, Vineyard, and 

Rose. 

Adding a Frame 

You can add a small frame around the edge of your photo. To add a frame: 

1. Select View from the top of the software. 

2. Select Frame. 

3. Select a frame color: 

a. White, Black, or Gray. 

4. Select None to remove the frame. 

Adding a Texture 

You can apply a paper texture to the photo to create the appearance of different 

Canon media. To add a paper texture: 

1. Select View from the top of the software. 

2. Select Paper Textures. 

3. Select a texture: 
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a. Polished, Satin, Canvas, Velvet, Watercolor, Glossy, or Heavy Canvas. 

4. Select None to remove the texture. 

Applying a Border 

Borders are backgrounds, text, overlays, or composites to be applied to 

products. All borders exist on a different layer from the photo and can 

always be turned off and removed by returning to the workshop. 

To search for and add a border to the photo: 

1. Select the magnifying glass from the borders tool. 

2. A window appears. 

3. The top of the window includes all of your local borders. Use the tabs and arrows 

to navigate between groups. Click here for more information on border options. 

4. Select OK when you have selected a border. 

5. The border will be applied to the photo. If the border is a different aspect ratio, 

that aspect ratio will be automatically applied to the photo. 

You can also search for and add a border by pressing B as a hotkey. 
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Using Basic Border Functions 

Basic border options include: 

 Turning borders on: select on from the border tool, or select borders and select 

Border On. Press HOME as a hotkey. Your most recently used border will appear. 

 Turning borders off: select off from the border tool, or select borders and select 

Border off. Press END as a hotkey. 

 Refreshing borders: select borders from the border tool and select Refresh 

Borders. 

 Reset current border settings: select borders from the border tool and select 

Reset Border. Press ALT – R as a hotkey. 

Switching between Borders in the Current Group 

To switch between templates in the current border group: 

 Select the < and > arrows in the borders tool. The borders will cycle back or 

forward through the current group, applying each to the photo.  

OR: 

1. Select borders from the borders tool to open a dropdown menu. 

2. Select Borders. 

3. Select a border from the current group. 

4. The border will be applied to the photo. If the border is a different aspect ratio, 

that aspect ratio will be automatically applied to the photo. 

Setting the Border Group and Directory 

To activate border groups: 

1. Select borders from the borders tool to open a dropdown menu. 

2. Select Set Border Group. 

3. Select and check to activate a border group. You can have multiple border 

groups activated at once. 

To set the border directory: 



Using: Photo Workshop Toolsets 

 

190 

 

1. Select borders from the borders tool to open a dropdown menu. 

2. Select Set Borders Directory. 

3. Select a directory where your borders are located. 

4. Select OK. 

Adding and Editing Border Text 

Text is considered a border. To add text to a photo without text: 

1. Select text from the borders tool. 

2. A window appears. 

3. Select your text settings, detailed here. 

OR: 

1. Select borders from the border menu. 

2. Select Edit Border. 

3. Select Add Border Text or Edit Border Text. 

4. Select your text settings, detailed here. 

 

You can also add or edit border text by pressing CTRL – T as a hotkey. 

If a photo has a border applied that includes text, you can edit the text in that border 

by following the previous steps. 

To add text to a photo that already has a border applied that includes text, you will 

need to edit the border in the Border Workshop and add an additional text field. Click 

here for a guide. 

Editing Borders 

You can edit some border properties from the Photo Workshop, or open the Border 

Workshop to quickly edit any border property. 

To edit the current border in the Border Workshop: 

1. Apply a border to your photo. 
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2. Select the pencil icon from the border tool. 

3. The border will open as an editable border in the Border Workshop. 

4. Click here for guides to using the Border Workshop. 

OR: 

1. Select borders from the border tool. 

2. Select Edit Border. 

3. Select Edit in Border Workshop. 

4. The border will open as an editable border in the Border Workshop. 

5. Click here for guides to using the Border Workshop. 

You can also open and edit the current border in by pressing CTRL – W as a hotkey. 

To add a shape to the border: 

1. Select borders from the border tool. 

2. Select Add Border Shape.  

3. Select a border shape from the list or select Add New Shape to create a new 

one. Press CTRL – P as a hotkey for adding new shapes. 

4. Select your shape settings, detailed here. 

 

Some borders will have colors you can edit. To edit border colors: 

1. Select borders from the border tool. 

2. Select Edit Border Colors, or press CTRL – E as a hotkey.  

3. Select your border colors. 

Some borders will have graphics you can edit. To edit graphics: 

1. Select borders from the border tool. 

2. Select Edit Graphic Lists, or press ALT – E as a hotkey. 

3. Select your graphics. 
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Saving Borders 

You can save a border after editing it in any way. 

To replace the border with your border changes, select borders from the border tool 

and select Save Border. 

To save your border changes as a new border, leaving the original border intact: 

1. Select borders from the border tool. 

2. Select Save as New Border. A window appears. 

3. Select the filename and location for the new border. 

4. Select a description. 

5. Select which border group to add the new border to. 

6. Select OK. 

Cropping Photos 

You can quickly crop a photo down to a specific photo aspect.  

To crop the current photo to an aspect ratio: 

1. Select a photo. 

2. Select the sheets tool to open a dropdown menu. 

3. Select an aspect ratio to crop the photo to. 

a. The aspect ratios listed can be set up here. 

Creating a Composite Sheet 

You can quickly create a composite sheet of multiple photos on one sheet size: 

To create a composite sheet: 

1. Select the sheets tool to open a dropdown menu. 

2. Select Composite Sheet. A window appears. 

3. Select the sheet size. Select Custom from the dropdown menu to enter a custom 

Width and Height in inches. 



Using: Photo Workshop Toolsets 

 

193 

 

4. Select to arrange the sheet as a portrait or landscape. 

5. Select the cell arrangement: 

a. Specify by the Width and Height to create photo sizes of that size, in 

inches. 

i. Select Cell Orientation: best fit, vertical, or horizontal. 

b. Specify by the Number of Rows and Columns to select size by the number 

of cells total. 

i. Select Square Cells to make each cell size an equal square. 

6. Select the Photo Orientation: use the existing orientation, or rotate photos 

clockwise or counter-clockwise to match cells. 

7. Select Create. 

8. Click and drag photos from the photo bar into the composite. 

Adjusting Focus 

Use focus to sharpen a photo for a crisp look, or to soften an image to 

create a gentle glow. 

Focus options include: 

 Select + to sharpen the photo by 1 point. 

 Select the triangle to set the focus to 5 points. 

 

 Select – to soften the photo by one point. 

 Select the circle to set the focus to -5 points. 

 Select the box to reset the focus to the digital negative settings. 

 Select focus to open a dropdown menu with preset focus values. 

Applying a Vignette 

A vignette is an effect where the photo edges will gradually fade to 

white or black. 

 Select the white-bordered box to apply a white vignette.  

o Select min, med, or max to change the intensity of the vignette. 
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 Select the black-bordered box to apply a black vignette. 

o Select min, med, or max to change the intensity of the vignette. 

 Select the middle box to remove any vignette. 

Using the Correct Toolset 
The correct toolset includes tools for adjusting basic light and exposure settings. To open 

the correct toolset, select the Correct tab from the bottom of the Photo Workshop 

workspace. The correct tools will appear either to the right or below the workspace. 

Enhance toolset options are, in order: Contrast, Exposure, Shadows, Color, Tone, and 

Redeye. 

It is recommended that you color balance photos before adjusting light and exposure, 

if necessary. Click here for a guide on color balance. 
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Saving Changes 

The software will not save correction settings for a photo if you select another photo. To 

save your settings for a photo, use the save options detailed here. 

Steps to Correcting 

Here is our recommended order for correcting photos: 

1. Exposure 

2. Shadows  

3. Color 

4. Contrast 

5. Redeye 

6. Tone 

Saving Attributes 

All of your correction settings can be saved and applied to any number of other photos 

and catalogs. Click here for a guide to saving and applying attributes. 

Adjusting Contrast 

Adjusting the contrast will lighten the light colors and darken the dark 

colors.  

Contrast options include: 

 Select + to increase the contrast by 1 point. 

 Select – to decrease the contrast by 1 point. 

 Select the box to reset the contrast to 0. 

 Select A to have the software use the photo histogram to automatically adjust 

contrast. 

 Select contrast to open a dropdown menu with preset values. 

To manually enter a contrast value, select the contrast number below the tool and 

manually type in a value. 



Using: Photo Workshop Toolsets 

 

196 

 

Adjusting Exposure 

You can adjust the exposure of a photo by plus or minus 2 stops. 

Exposure options include: 

 Select + to increase the exposure by .25 points, up to 2. 

 Select – to decrease the exposure by .25 points, down to -2. 

 Select the box to reset the exposure to 1. 

 Select exposure to open a dropdown menu with preset values. 

To manually enter an exposure value, select the exposure number below the tool and 

manually type in a value. 

Adjusting Shadows 

Use the shadows tool to lighten darker areas or darken lighter areas, targeting the 

shadows.  

Shadows options include: 

 Select + to brighten shadows by 10 points, up to 80. 

 Select – to darken shadows by 10 points, down to -80. 

 Select the box to reset the shadows to 0. 

 Select shadows to open a dropdown menu with preset values. 

To manually enter a shadows value, select the shadows number below the tool and 

manually type in a value. 

Adjusting Color 

You can adjust the color saturation of a photo by adding or reducing 

color.  

Color options include: 

 Select + to increase the saturation by 5 points, up to 400. 

 Select – to decrease the saturation by 5 points, down to -100. 

 Select the box to reset the saturation to 0. 
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 Select color to open a dropdown menu with preset values. 

To manually enter a saturation value, select the color number below the tool and 

manually type in a value. 

Adjusting Tone 

Use the tone tool to add warm or cool tones to a photo.  

Tone options include: 

 Select warm to increase the warm tones by 1 point. 

 Select cool to increase the cool tones by 1 point. 

 

 Select the box to reset the tones to 0. 

 Select tone to open a dropdown menu with preset values. 

To manually enter a tone value, select the exposure number below the tool and 

manually type in a value. Warm tones are positive numbers, cool tones are negative 

numbers. 

Adjusting Redeye 

The redeye tool helps to eliminate redeye glare. It is recommended to 

adjust redeye before tone, as the redeye tool looks for red in an image 

and might interfere with your tone settings. 

To adjust redeye: 

1. Select the eye icon in the redeye tool. This will automatically adjust redeye. 

2. If some redeye still remains, select the + tool and click the redeye in the photo to 

remove it. 

3. If some reds were removed accidentally, select the – tool and click the area in 

the photo to return the colors. 

4. Select the box in the redeye tool to remove all redeye adjustments. 

5. The word corrected will appear below the redeye tool after adjusting redeye. 
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Using EOS Picture Styles Toolset 
The EOS Picture Style Toolset includes tools for adjusting light and exposure 

setting specific to Canon RAW files. 

The EOS Picture Style Toolset options are, in order: picture style, contrast, 

exposure, sharpness, saturation, color tone, filter effect and tone effect.                                                                                                

Adjusting EOS Picture Styles 

Choosing a Picture Style is like choosing between different types of film. There 

are six different initial Picture Style settings, each with a different look and 

feel. Picture Styles create consistent, repeatable color, contrast, saturation 

and sharpening. The Picture Styles are also user adjustable for critical and 

unique results. Start by selecting a Picture Style just as you would a film type. 

Standard 

The ―Standard‖ Picture Style is set to produce the vivid colors and contrast level that 

people tend to prefer for general photographic subjects. It provides the optimal 

sharpness for printing image without post-processing and makes it possible to produce 

beautifully finished prints for a broad array of subjects, from snapshots to sports shooting, 

with no retouching. 

The ―Standard‖ Picture Style is the default Picture Style setting for all present EOS 

DIGITAL lineups. Color uniformity is ensured, even if the model changes. 

Portrait 

People are one of the most difficult subjects to reproduce photographically because 

skin color can vary significantly depending on lighting conditions and exposure 

balance. The ―Portrait‖ Picture Style adjusts the color tone magenta-to-yellow close to 

red range and adds brightness. Skin color is reproduced in light pink with the correct 

exposure. It is particularly well-suited for shooting people. To keep the soft and natural 

feeling of skin, sharpness is set modestly. 

Landscape 

Deep blue sky and vibrant green leaves call for more vivid colors. The ―Landscape‖ 

Picture Style changes the color respectively; blue to a vivid and deep color, green to a 

vivid and bright color. 
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This style also uses a stronger sharpness setting to bring out details in mountains, trees, 

buildings, and other subjects in the distance. 

Neutral 

The ―Neutral― setting is suitable for expressing subtle nuances within vivid colors, even for 

objects with considerable contrast, when wishing to convey delicate textures. 

Contrast and saturation settings are moderated, so there is less risk of overexposure and 

color saturation compared to other Picture Styles, resulting in a more restrained and 

calmer expression. 

Richer detail is retained as data, so corrections can easily be rendered using Digital 

Photo Professional or Adobe® Photoshop®, etc. for JPEG output as well. 

Faithful 

The ―Faithful‖ setting enables reproduction of images that are colorimetrically almost 

identical to the actual colors shot under standard daylight conditions. 

By maintaining the colors of the subject, the colors remain true even in highlight areas, 

so the expression of the colors is strong, giving a reliable impression that is close to what 

is seen with the naked eye. The colors are absolutely true to life, ensuring faithful 

reproduction—no matter how subdued or vivid. 

This setting is also suitable for replicating existing photographs and product 

photography, where the original colors must be accurately expressed. 

Monochrome 

Monochrome photography is a means of boldly expressing form, light and shadow. The 

―Monochrome‖ Picture Style isn’t merely zero-saturation image processing; it’s a faithful 

successor to monochrome film. Sharpness is set relatively strongly. Sepia, blue or other 

toning effect is applicable to create a monochrome image in that color. Also, red, 

green or other filter effect can be applied to control the color. The ―Monochrome‖ 

Picture Style can give you a thrill of monochrome shooting and bring to completion all 

within a camera. 

Customization of Picture Styles 

By using the ―Detailed Setting‖ function, you can refine the six preset styles. Depending 

on shooting situations, it is possible to adjust the camera settings and reflect the 
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photographer’s color taste. In addition to the six preset styles, three more Picture Styles 

can be registered through a connection to a computer. 

For more information on Picture Styles visit: 

http://www.canon.co.jp/imaging/picturestyle/index.html 

Adjusting Contrast 

Adjusting the contrast will lighten the light colors and darken the dark colors.  

Contrast options include: 

 Select + to increase the contrast by 1 point. 

 Select – to decrease the contrast by 1 point. 

 Select the box to reset the contrast to 0. 

 Select contrast to open a dropdown menu with preset values. 

To manually enter a contrast value, select the contrast number below the tool and 

manually type in a value. 

Adjusting Exposure 

You can adjust the exposure of a photo by plus or minus 3 stops. 

Exposure options include: 

 Select + to increase the exposure by .25 points, up to 3. 

 Select – to decrease the exposure by .25 points, down to -3. 

 Select the box to reset the exposure to 0. 

 Select exposure to open a dropdown menu with preset values. 

To manually enter an exposure value, select the exposure number below the tool and 

manually type in a value. 

Adjusting Sharpness 

You can adjust the sharpness of a photo up to 7 points. 

Sharpness options include: 

 Select  to increase the sharpness by 1 point, up to 7. 

http://www.canon.co.jp/imaging/picturestyle/index.html
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 Select  to decrease the sharpness by 1, down to 0. 

 Select the box to reset the sharpness to 0. 

 Select sharpness to open a dropdown menu with preset values. 

To manually enter a sharpness value, select the sharpness number below the tool and 

manually type in a value. 

Adjusting Saturation 

You can adjust the saturation of a photo by plus or minus 4 points. 

Saturation options include: 

 Select + to increase the saturation by 1 point, up to 4. 

 Select – to decrease the saturation by 1points, down to -4. 

 Select the box to reset the saturation to 0. 

 Select saturation to open a dropdown menu with preset values. 

To manually enter a saturation value, select the saturation number below the tool and 

manually type in a value. 

Adjusting Color Tone 

You can adjust the color tone of a photo by plus or minus 4 points. 

Color tone options include: 

 Select + to increase the color tone by 1 point, up to 4. 

 Select – to decrease the color tone by 1points, down to -4. 

 Select the box to reset the color tone to 0. 

 Select color tone to open a dropdown menu with preset values. 

To manually enter a color tone value, select the color tone number below the tool and 

manually type in a value. 

Adjusting Filter Effect 

You can apply a black and white filter effect to a photo by 

selecting one of four filter types 
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Filter effects include: 

 Select Yellow to apply a yellow effect. 

 Select Orange to apply a orange effect. 

 Select Red to apply a red effect. 

 Select Green to apply a green effect. 

 Select None to restore the photo. 

Adjusting Tone Effect 

You can apply a black and white tone filter effect to a photo by selecting one of four 

tone types 

Tone effects include:  

 Select Sepia to apply a sepia effect. 

 Select Blue to apply a blue effect. 

 Select Violet to apply a violet effect. 

 Select Green to apply a green effect. 

 Select None to restore the photo. 

Using the Color Balance Toolset 
The color balance toolset includes tools for adjusting and selecting white balance 

settings, color profiles, and stored color settings. These settings will correctly balance the 

color of your photos. 

To open the color balance toolset, select the Color Balance tab from the bottom of the 

Photo Workshop workspace. The color balance tools will appear either to the right of 

the workspace. 

Color balance toolset options are, in order: Preset Lighting, Preset Balances, Color 

Balance, and Color Profiles. 
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Saving Changes 

The software will not save color balance settings for a photo if you select another photo. 

To save your settings for a photo, use the save options detailed here. 

Using Preset Color Balances 

Select a preset color balance to automatically compensate for lighting conditions. 

There are four preset balances for the most basic types of lighting conditions:  

 Daylight/Incandescent: compensates for the additional cyan and 

magenta in daylight and incandescent bulbs. 

 Flash/Strobe: compensates for the additional red and yellow from 

camera flashes. 

 Fluorescent: compensates for the additional red and yellow from fluorescent 

bulbs. 

 Tungsten: compensates for the additional red and yellow from tungsten bulbs. 

Select None to remove the preset color balance from your photo.  

You can also select color balance to open a dropdown menu with all of your preset 

and attribute settings. 

Applying Attributes 

The C1 through C4 buttons correspond to your saved attribute settings.  

To save your color balance attributes: 

1. Set the color balance for your photo. 

2. Click on the numbers between the color swatches. 

3. A new color balance tool appears. 

4. Adjust the color balance by dragging the bars or typing values into the text 

boxes. 
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5. Select Save Changes As and select Custom 1, 2, 3, or 4. 

6. Select Apply. 

7. C1, C2, C3, or C4 will now hold your color balance settings. 

To apply your color balance attributes, select C1 through C4, depending on where you 

saved your attributes. 

Manually Adjusting Color Balance 

To manually set the color balance: 

Click a color swatch to add that color to the photo. The colors on the right 

are the colors associated with the numbers, from 1 to 255. 

OR: 

Click on the numbers between the color swatches.  

1. A new color balance tool appears. 

2. Adjust the color balance by dragging the bars or typing values into the 

text boxes. 

3. Select Save Changes As and select Image Only. 

Automatically Adjusting Color Balance 

You can automatically adjust color balance by choosing a neutral point 

of a photo and saving those attributes to apply to all photos in the event. 

Ideally you would shoot a gray or white card along with your photos to 

guarantee a neutral area for accurate color balance. 

To automatically adjust color balance: 

1. Select the eyedropper tool above click balance. 

2. Select a neutral area (black, white, or gray) in the photo. 

3. The color will be adjusted automatically. Save these attributes if you want to 

apply them to additional photos. 
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Selecting a Color Profile 

Use this option to select the color profile used when capturing photos. This will usually be 

the camera color profile. This is not where you set the printer or monitor color profiles. 

Select color profile to choose your profile: 

 Automatic: the software will automatically apply any known color profiles based 

on the Canon default profiles on each device. 

 None: the software will use the standard sRGB color space and will not apply a 

color profile. 

 Adobe RGB: set the color space to Adobe RGB color space. 

 Custom: select a color profile from another location. Windows has a 

recommended location for storing these files: system32\spool\drivers\color. 

 

 

 

Using the Drop Out Toolset 
The drop out toolset is for shooting green screen photography with backdrops, 

replacing the backdrop color with other backgrounds or images. You can select 

between choma key backdrops of blue or green. 

To open the drop out toolset, select the Drop Out tab from the bottom of the Photo 

Workshop workspace. The drop out tools will appear either to the right or below the 

workspace. 

Drop Out toolset options are, in order: Borders, Presets, Backdrop Color, Hue Percent, 

Shadows, and Protection. 
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Saving Changes 

The software will not save drop out settings for a photo if you select another photo. To 

save your settings for a photo, use the save options detailed here. 

Applying Borders 

Border options in the Photo Workshop are detailed here. 

Selecting the Chroma Key Backdrop 

The first step in green screen editing is to select either the green or blue 

swatch that corresponds to your backdrop. Select A to have the 

software determine your backdrop color automatically. 

It is important that customers do not wear the same color clothing as your backdrop, as 

the drop out tools will completely remove any of that color from the photo. 

Applying Presets 

The software comes with a variety of different preset options to simplify 

the drop out process. Each preset will automatically change the rest of 

the drop out settings in the toolset. 

Select the < or > arrows to switch between presets, or select presets to open a 

dropdown menu and select one from the list: 

 Shadows Off Completely: removes all shadows. The shadows option is turned off 

and edge control is set to 0. 

 Shadows Off (Method 2): removes all shadows. The shadows option is turned on, 

but the threshold is set to the maximum of 50. 

 Shadows Off, Protect Hair: removes shadows while not deleting stray hair. The 

shadows option is turned on, but the edge control is set to 30. 

 Default: resets all drop out settings to the default. Shadows are turned on and the 

threshold is set to 10. 
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 Shadows On, Remove Noise: removes roughly 80% of shadows and extraneous 

noise. The shadows option is turned on, but the threshold is set to 12. 

 Shadows On Completely: all shadows will appear. The shadows option is turned 

on and the threshold is set to 0. 

You can select a preset and use the advanced controls to modify any individual 

setting. 

Adjusting Hue Percent 

The hue percent tool determines the range of colors within your backdrop 

color that should be removed. A higher hue percent will remove more 

green or blue, depending on your backdrop. 

Basic hue percent options include: 

 Select + to increase the hue percent by 5, up to 60. 

 Select – to decrease the hue percent by 5, down to 0. 

 Select the box in the hue percent tool to reset to the default value of 36. 

 Select hue percent to open a dropdown menu with preset values. 

To manually enter a hue percent value, select the hue percent number below the tool 

and manually type in a value.  

Adjusting Shadows 

Lighting conditions are often difficult and will leave shadows on the 

background after the backdrop is removed. The shadows tool will 

remove unwanted shadows from the photo. 

 If shadows are turned off, the software will attempt to show only the foreground 

image. 

 If shadows are turned on, the shadows cast on the backdrop will be transferred 

to your new background. 

Select expanded to allow lighter colors to appear along with shadows, such as smoke, 

clouds, and translucent surfaces such as glass and water. This option is only available if 

shadows are turned on. 
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Adjusting Threshold 

The threshold tool is for cleaning up unwanted noise in a photo. A higher 

threshold will remove more noise. 

Basic threshold options include: 

 Select + to increase the threshold by 5, up to 50. 

 Select – to decrease the threshold by 5, down to 0. 

 Select the box in the threshold tool to reset to the default value of 10. 

 Select threshold to open a dropdown menu with preset values. 

To manually enter a threshold value, select the hue percent number below the tool and 

manually type in a value.  

Adjusting Protection 

Sometimes dark objects will accidentally be removed in the drop out process, or the 

backdrop will be reflected on lighter clothing and hair. The protect tool will prevent 

green halos and accidental drop outs. 

Select the following options for protect white if the backdrop is 

reflecting; select protect black if dark areas are being removed with the 

drop out process. A higher protection will leave more of those colors in 

the photo. 

Basic protection options include: 

 Select + to increase the protection by 1, up to 10. 

 Select – to decrease the protection by 1, down to 0. 

 Select the box in the protection tool to determine protection automatically. 

 Select protection to open a dropdown menu with preset values. 

To manually enter a protection value, select the protection number below the tool and 

manually type in a value.  
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Using the Border Workshop 

Borders can be as simple as a text box or graphic overlay, or as complex as a series of 

montages, overlapping images, layered graphics and photos, and photo queries. Use 

the Border Workshop to create brand new borders for your studio, or just to edit and 

adjust existing borders.  

Find the Border Workshop in Manage Studio > Products > Templates and Composites. 

Select new template from the bottom of the software to create a new border, or select 

a border and select edit template to open that border in the workshop. 

Borders are layered objects, with each text, graphic, or photo as its own individual 

layer. Each item can be moved and edited independently, or shown in front of or 

behind other objects.  

For a complete reference guide to the Border Workshop, including detailed screenshots 

and button locations, go here. 

Navigating the Border Workshop 
The Border Workshop workspace is separated into two areas: 

 Workspace: view, add, and edit border items. 

 Border Items List: a list of each individual border item as a layer that can be 

arranged in any order. 

The top of the workshop will show the current border name and description. Select 

cancel changes at any time to exit the Border Workshop without saving. 
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Viewing in the Border Workshop 

Viewing Front or Back 

Borders can have both a front and back. The back of a border is often used for 

information and identification, but can be as complex as the front.  

Select Front or Back from the top left of the software to view and edit the front or back 

of your border. A • will appear to indicate which side you are currently viewing. 

If your border does not have a back, you can select Back to create one.  

Selecting Items 

To select items in the workspace, choose select from the right 

toolbar. You can now click and right-click on items in the 

workspace.  

 Select and drag an item to move it around the workspace. 

 Select and drag edges of the item to stretch it. 

 Use the mouse wheel to resize the object with the same 

proportions. 

Panning within the Border 

To use pan mode, select Pan from the right toolbar. Panning is quickly moving and 

viewing by clicking and dragging an area in the direction you want to move it. This is a 

viewing option and will not actually move the border. You cannot select items while 

panning. 

Zooming In 

To zoom in on areas of the border, select zoom from the right toolbar. 

 Left-click on an area of the border to zoom in.  

 Right-click to zoom out. 

 Click and drag a box around an area to zoom in and fill the workspace with that 

area. 
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You can also zoom in and out by selecting zoom and using the mouse wheel or by 

right-clicking an area and selecting Zoom > Zoom In or Zoom Out from the dropdown 

menu. 

Viewing at Page Size 

To view the entire border area, select fit page from the right toolbar. The border will be 

displayed at whatever zoom is necessary to view the entire border. 

You can also view at page size by right-clicking any border item and selecting Zoom > 

Zoom Reset from the dropdown menu. 

Viewing at Actual Size 

To view the border at actual size in pixels, select actual size from the right toolbar. The 

border will be displayed and zoomed in to show the full editable size. 

You can also view actual size by right-clicking any border item and selecting Zoom > 

Zoom Actual Size from the dropdown menu. 

Viewing and Editing Border Properties 

At any time in the workshop you can view and edit the border properties. To view and 

edit border properties: 

1. Select border properties from the left toolbar. A window appears. 

2. Enter a border description. 

3. Enter a filename and location for the border. 

4. Select the page size for the border. 

a. Select Custom to enter your own width and height in pixels. 

5. Select the orientation: horizontal or vertical. 

6. Select the resolution in pixels per inch. 

7. Select Choose… to change the page color. 

8. Select and check Rotate 180° when printing to have the back rotated. This is 

useful if you want the back of the border to be flipped upside down compared 

to the front. This option is only available if the border has a back. 

9. Select the photo orientation. 
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10. Select when a prompt will appear asking for text and information: when loaded, 

or when you select to edit text and information. 

11. Select to leave text fields empty when loaded or to use the last value available. 

12. Select OK. 

You can also edit the border properties by right-clicking on the border items list and 

selecting Border Properties from the dropdown menu. 

Viewing and Editing Item Properties 

At any time in the workshop you can view and edit the properties of a selected item. To 

view and edit item properties: 

1. Select an item from the workspace or the border items list. 

2. Select item properties from the right toolbar. A window appears. 

3. This window contains all of the options you set when creating the item. For guides 

to item properties, go here and locate your item. 

You can also edit item properties by double-clicking any item or by right-clicking any 

item in the workspace or border items list and selecting Properties from the dropdown 

menu. 

Viewing the Using the Border Items List 

The border items list keeps track of every border object as a layer in the border. Every 

item in the border items list corresponds to an active item in your border workspace, 

and will list items by your descriptions when creating items. 

The bottom of the border items list displays measurements for the currently selected 

item, including: 

 The current X and Y location of the cursor. 

 The X and Y locations of the currently selected item’s top-left and bottom-right 

corners, in that order. 

 The width and height of the currently selected item. 
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The top of the list is the background of the border. Items will always appear in the 

border workspace beneath items listed below it in the border list. 

The bottom of the list is the front of the border. Items will always appear in the border 

workspace on top of items listed above it in the border list. 

 Selecting any item in the border items list will select it in 

the workspace as well. 

 Right-clicking any item in the border item list will bring up 

the same options as right-clicking the item in the border 

workspace. 

 Double-clicking any item in the border item list will bring 

up the item properties. 

To rearrange items in the border items list: 

1. Select a border item in the list. 

2. Hold and drag the item to a new location in the list. 

3. The item will now appear in a different order in the workspace. 

Viewing and Using the Grid 

You can display a grid for aligning border items. To view the grid, select Options from 

the top of the software and select and check Show Grid. 

To edit grid options: 

1. Select Options from the top of the software. 

2. Select Grid Options, or press CTRL – G as a hotkey. 

3. Select Display Grid to show the grid. 

4. Select Snap to Grid to have items snap to grid lines when moved. 

5. Select the Grid Units: inches, pixels, cm, or mm. 

6. Select the size of your grid. 

7. Select OK. 
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Select Options and select Auto Alignment to display guiding lines to help when trying to 

line up border items. 

Viewing Test Photos 

You can import any photo into a photo placeholder to preview the border. To assign a 

test photo, right-click any photo item and select Set Test Photo from the dropdown 

menu. To clear the photo, right-click the photo item and select Clear Test Photo. 

Viewing Test Forms 

You can preview all photo queries and textbox prompts that will appear when the 

border is applied to a photo. To preview text fields, select test form from the right 

toolbar. 

 

 

Editing Items in the Border Workshop 

Basic Editing Tools 

For basic editing options, select an option from the left toolbar, or select Edit from the 

top of the software and select an option: 

 Duplicate or CTRL - D: copy and paste an exact duplicate of 

the item, including item description. 

 Cut or CTRL - X: copy an item to the clipboard and delete it. 

 Copy or CTRL – C: copy an item to the clipboard. 

 Paste or CTRL – V: paste the current item from the clipboard. 

 Delete or DEL: delete the current item.  

To undo or redo an action, select Undo or Redo from the top of the software. 
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Editing Border Font 

To edit the font properties of any text item, select font from the right toolbar. A window 

appears with basic font properties. Select properties and select OK when finished. 

Filling and Fitting the Page 

You can increase the size of any border item to fill the width, height, or the entire area 

of the page size. 

To fill and fit an item to the page size: 

1. Select a border item. 

2. Select fill & fit page from the right toolbar. 

3. Select an option: 

a. Fill Entire Page: the item width and height will match the page size and be 

centered. Proportions will be changed if this option is selected. 

b. Fill Width: the item width will match the page size width. 

c. Fill Height: the item height will match the page size height. 

d. Fit Within Page: the item will match the width or height of the page size, 

without changing proportions. 

You can also right-click an item and select Fill & Fit from the dropdown menu for the 

previous options. 

Making Items the Same  

You can adjust the size, position, and font of an item to copy an existing border item. 

To make an item the same as an existing item: 

1. Select the border item you want to modify. 

a. You can select any number of items to modify at once using CTRL or SHIFT, 

but the item you want to copy must be selected last. 

2. Hold CTRL and select the border item you want to copy. 

3. While both items are selected, select make same from the right toolbar. 

4. Select an option: 
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a. Make Same Size: make the item the same size as the last item. 

b. Make Same Size and Position: make the item the same size as the last item 

and move the item to the same location as the last item. These items will 

now overlap and it will be easiest to select one from the border items list. 

c. Make Same Width: make the item the same width as the last item. 

d. Make Same Height: make the item the same height as the last item. 

e. Make Same Font: copy the font properties of the last item and apply 

them. 

You can also right-click one of the selected items and select Make Same from the 

dropdown menu for the previous options. The last item will always be the one copied. 

Centering Items 

You can center an item or a group of items to the page. 

To center an item: 

1. Select a border item. 

a. You can use CTRL or SHIFT to select any number of border items. They will 

be treated as one large group when centered. 

2. Select center from the right toolbar. 

3. Select to center an object: 

a. Horizontally within the page. 

b. Vertically within the page. 

c. Both horizontally and vertically within the page. 

You can right-click an item and select Center from the dropdown menu for the previous 

options. 

Aligning Items 

You can align items to other items on the page. 

To align an item: 

1. Select a border item. 
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a. You can use CTRL or SHIFT to select any number of border items. They will 

all be aligned to the last item selected. 

2. Hold CTRL and select the border item you want to align with. 

3. Select align from the right toolbar. 

4. Select an option to align the item to that edge of the last item selected: 

a. Left, Center, Right, Top, Middle, Bottom. 

You can also right-click an item and select Align from the dropdown menu for the 

previous options. The last item selected will always be used for alignment. 

Spacing Items 

You can space items equal distances from each other on the page. You must select at 

least three items to apply spaces. 

To space items: 

1. Use CTRL or SHIFT to select at least three items you want to space apart. 

2. Select space from the right toolbar. 

3. Select an option: 

a. Gaps Horizontally: space the items apart horizontally with equal gaps 

between the edges. 

b. Gaps Vertically: space the items apart vertically with equal gaps 

between the edges. 

c. Centers Horizontally: space the items apart horizontally with equal 

distance between the centers. 

d. Centers Vertically: space the items apart vertically with equal distance 

between the centers. 

You can also right-click selected items and select Space from the dropdown menu for 

the previous options.  
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Changing Item Order 

You can change the order of item layers within a border.  

To change item order: 

1. Select a border item. 

2. Select order from the right toolbar. 

3. Select an option: 

a. Send to Back: make this item the very back layer of the border. 

b. Bring to Front: make this item the very front layer of the border. 

c. Send Backward: send this item one layer towards the back. 

d. Bring Forward: bring this item one layer towards the front. 

To rearrange items in the border items list: 

1. Select a border item in the list. 

2. Hold and drag the item to a new location in the list. 

3. The item will now appear in a different order in the workspace. 

You can also right-click an item and select Order from the dropdown menu for the 

previous options. 

Rotating Items 

You can rotate items by preset or custom angles: 

1. Select a border item. 

2. Select rotate from the right toolbar. 

3. Select an option: 

a. Reset: reset the orientation to the original angle. 

b. 90° clockwise. 

c. 90° counter clockwise. 

d. 180°. 

e. Angle…: view and select the angle and which direction to rotate. 
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You can also right-click an item and select Rotate from the dropdown menu for the 

previous options. 

Hiding Items 

You can hide items from view. You can still select and move the item through a dotted 

outline, but it will be transparent. Use this to line up items or see what lies beneath. 

To hide an item: 

1. Right-click a border item. 

2. Select Hide Object. 

3. An H will appear next to the item name in the border items list.  

4. Right-click the item and select Show Object to show it again. 

Locking Items 

You can lock items from editing. The item will still be visible, but cannot be selected or 

edited. Use this to keep from accidentally moving or editing an item. 

To lock an item: 

1. Right-click a border item. 

2. Select Lock Object. 

3. An L will appear next to the item name in the border items list. 

4. Right-click the item and select Unlock Object to make it editable again. 

Linking Items 

You can link items to each other so that when one is moved, they all move together. 

To link an item: 

1. Right-click any number of border items. 

2. Select Link Object. 

3. Right-click the item and select Unlink Object to remove it from the linked group. 
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Saving Changes and Borders 

You can save your border changes as the current border or save the border as a 

completely new border. Select save changes or save as new border from the bottom 

of the software. If you select to save as a new border, you will need to rename and 

specify the location to save your border. 

Adding Border Items 
Read on for guides to adding items to your border. 

Selecting Position and Size 

Every border item can have a preset size and position upon creation. You will set these 

options in the window that appears after selecting to add an item. 

To adjust position and size: 

1. Select the Position and Size tab from the top of the window. 

2. Select the Units to work with: inches, pixels, cm, or mm. 

3. Select the X and Y position of the top left corner of your item. 

4. Select the width and height of your item. 

5. Select to align your item with the page. Click here for alignment options. 

6. Select to have your item fill and fit to the page. Click here for fill & fit options. 

To use X and Y coordinates for adjusting position and size: 

1. Top: select a Y coordinate for the top edge of your item. 

2. Left: select an X coordinate for the left edge of your item. 

3. Bottom: select a Y coordinate for the bottom edge of your item. 

4. Right: select an X coordinate for the right edge of your item. 

Select OK only when you have selected all of the new item options, not just the position 

and size options. 
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Adding a Photo Item 

A photo item is a placeholder for the border where photos can be dragged and 

dropped into after the border has been applied.  

Each photo placeholder will have its own photo # assigned to it. If you have assign 

multiple photo placeholders to Photo 2, for example, then once a photo has been 

added to one of the Photo 2 placeholders, it will be automatically added to all of the 

other Photo 2 placeholders. 

To add a photo placeholder to your border: 

1. Select add photo from the left toolbar. 

2. A window appears. 

3. Select the Photo # to use as this photo.  

a. Remember that photo placeholders with the same # will automatically 

add the same photo to all of those placeholders. 

b. Select Lookup to browse photos and graphics already used in this border. 

4. Select Transparency options: 

a. Simple: set a preset % for transparency. 0% is opaque and 100% is invisible. 

b. Predefined Mask: select Edit to choose a predefined vignette or 

transparency setting. 

c. Chroma-key: select a green or blue screen background 

d. High-Key: select a white background 

e. Low-key: select a black background 

5. Select Movement options: 

a. Adjustable: moving and scaling within an image cell 

b. Fixed: fixed position 

c. Floating: free movement throughout the border template 

d. Relative: moves relative to a previous object 

6. Select and check Advanced options: 

a. Allow photo to overlap composite objects: the photo will overlap other 

photos in a composite. 
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b. Display image on screen as guide but do not print: the image will display 

as guide for placement. 

c. Draw a frame around the photo: create a frame around the photo. 

d. Draw a drop shadow: create a drop shadow under the photo. 

e. Require photo to be manually selected: you must manually select and 

drag a photo into the placeholder, it will not be automatically populated 

with the current photo. 

f. Rotation: select a rotation angle to rotate the placeholder clockwise. 

g. Rotate photo only when printing: orientation is changed when printing 

only. 

h. Test Photo: select a browse for a photo to display as a guide while editing 

the border.  

7. Select Position and Size options, found here. 

8. Select OK. 

You can also add a photo item by selecting Add from the top of the software and 

selecting Photo, which contains the previous options. 

Adding a Multiple Photo Item 

You can add a composite item to the border that will contain a number of different 

photos, but count as one item. Each photo in the composite will contain a separate 

placeholder #. 

To add a photo composite to your border: 

1. Select add multiple photos from the left toolbar. 

2. A window appears. 

3. Select the Photos tab for basic photo options: 

a. Select the number of rows and columns, or a fixed number of photos. 

b. Select to look up photos by query. Click here for more information on 

queries. 

c. Select the aspect ratio of each photo. 

d. Select the area to fill, photo arrangement, orientation, spacing, 

overlapping, and uneven photo distribution. 
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4. Select the Labels tab to set visible labels as guides for each photo. 

a. Select Show Labels. 

b. Enter the text to show, or select Insert Special Text to select a data type. 

c. Select font properties. 

5. Select the Options tab for more options: 

a. Select Transparency options: 

i. None: draw entire photo 

ii. Simple: set a preset % for transparency. 0% is opaque and 100% is 

invisible. 

iii. Predefined Mask: select Edit to choose a predefined vignette or 

transparency setting. 

iv. Chroma-key: select a green or blue screen background 

b. Select Advanced options: 

i. Select to draw frames around the photos. 

ii. Select to draw shadows. 

6. Select Position and Size options, found here. 

7. Select OK. 

You can also add a composite item by selecting Add from the top of the software and 

selecting Multiple Photos, which contains the previous options. 

Adding a Graphic Item 

You can add graphics and other images to the border: 

1. Select add graphic from the left toolbar. 

2. A window appears. 

3. Select or browse to a graphic to add. 

a. Select Lookup to browse photos and graphics already used in this border. 

b. Select Graphic List to add more than one graphic for this item. 

4. Select Transparency options: 

a. None: draw the entire image. 
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b. Simple: set a preset % for transparency. 0% is opaque and 100% is invisible. 

c. Drop out a specific color: remove a color as a transparent area. 

d. Use image alpha channel (32-bit targa or png) 

5. Select Movement options. 

6. Select Advanced options: 

a. Allow photo to overlap composite objects 

b. Display image on screen as guide but do not print 

c. Select to draw frames around the photos. 

d. Select to draw shadows. 

7. Select Position and Size options, found here. 

You can also add a graphic by selecting Add from the top of the software and 

selecting Graphic, which contains all of the previous options. 

Adding Text 

You can add text items to your border: 

1. Select add text from the left toolbar. 

2. A window appears. 

3. Enter the text for the item.  

a. Select Insert Special Text to select a data type. 

4. Select font properties. 

5. Select Color Attributes. 

6. Select Movement options. 

7. Select the alignment, character spacing, and line spacing. 

8. Select Advanced options: 

a. Select to Display text on screen as guide but do not print 

b. Select to draw an outline around the text. 

c. Select to draw shadows beneath or inside the text. 

d. Select Rotation 
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e. Select to wrap words. 

f. Select to make the text editable. This is enabled by default. 

9. Select Position and Size options, found here. 

10. Select OK. 

You can also add text by selecting Add from the top of the software and selecting Text, 

which contains the previous options. 

Adding an Effect 

You can add a preset effect as an item which can then be set on top of another item 

to create a unique effect. 

The following effects are available: 

 Brightness 

 Color 

 Darken 

 Duo Tone  

 Duo Tone Color 

 Grayscale 

 Hue 

 Invert RGB 

 Negate RGB 

 Overlay 

 Sepia Tone 

 Saturation 

 Watermark 

 Antique 

 Blur 

 Monochrome 

To apply an effect: 

1. Select add effect from the left toolbar. 

2. A window appears. 

3. Select the effect type from the dropdown menu. 

4. Select Transparency options: 

a. Predefined Mask: select Edit to choose a predefined vignette or 

transparency setting. 

5. Select Movement options. 

6. Select the effect-specific Advanced options: 

a. Select Invert Mask to invert the transparent area of any mask you have 

selected. 

7. Select Position and Size options, found here. 
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8. Select OK. 

Once you have created an effect, use the make same tool to apply the effect to a 

specific item, or the fill & fit tool to apply it to the entire border. 

You can also apply an effect by selecting Add from the top of the software and 

selecting Effect and selecting an effect type, which contains the previous options. 

Adding a Custom Shape 

You can add a custom shape to the border. Custom shapes are graphics with optional 

text that you can create, edit, and save for later use.  

To add a custom shape: 

1. Select Add from the top of the software. 

2. Select Shape. 

3. Select a shape from the list. 

4. A window appears. 

5. Select graphic options, found here. 

6. Select text options, found here. 

7. Select Position and Size options, found here. 

8. Select OK. 

If you are adding a saved custom shape, you can add it by selecting Add from the top 

of the software and selecting Add Custom Object and selecting your shape from the 

list. 

To save your custom shape in the software: 

1. Select your shape. 

2. Select Add from the top of the software. 

3. Select Save Custom Object. A window appears. 

4. Select a name for your shape. 

5. Select Add. 

6. Select OK. 
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To edit saved custom shapes: 

1. Select Add from the top of the software. 

2. Select Edit Custom Objects. A window appears. 

3. Select an object from the list and select to move it up or down the list or delete it. 

4. Select OK. 

Adding a Line 

You can add a line as a shape to the border: 

1. Select Add from the top of the software. 

2. Select Line. 

3. A window appears. 

4. Select the following options: 

 

 Type 

 Weight 

 Style 

 Color 

 Opacity 

 Joints 

 Start Style 

 End Style 

 Visibility 

 

5. Select Drawing Mode to create a new line, or Editing Mode to edit an existing 

line. 

6. Select Done when finished creating and editing your line. 

Adding a Barcode 

Barcodes provide a reliable way to track data for prints. For example, you can add a 

back to a border and apply a barcode to it. Simply scan the final print for pricing, order 

number, or any other photo data. You must have a barcode scanner to read and scan 

barcodes. 

To add a barcode to a border: 

1. Select Add from the top of the software. 

2. Select Barcode. 
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3. A window appears. 

4. You can encode any information into the barcode. 

a. Select a barcode format from the dropdown menu. 

b. Select Insert Special Text to add photo data types to the barcode. 

c. Select Show Text to display the text below the barcode. 

5. You can add multiple different types of data into the barcode by separating 

each type with a space. 

6. Your barcode will be generated below in the viewer. 

7. Select OK. 

Using Photo Queries 
When using photo composites, you will need to add multiple photos to each border 

after a shoot. This can become a very time consuming process, and photo queries will 

eliminate a lot of the work. A photo query is basically a search function tied a photo 

placeholder that will search the for specific photo types to automatically fill the 

placeholder.  

For example, if you are shooting a bunch of different sports teams and creating sport 

composites, you will probably need a team photo for each composite. Simply create a 

photo query within the photo placeholder where the team photo would go for each 

player, and set it to search for a photo type of Team within the catalog. Then use photo 

data, detailed here, to add the Team type to your team photo.  

 

The team photo in the current catalog will now be automatically imported for each 

player when you add that player’s photo to their team composite.  

To add a query to a photo placeholder: 

1. Select add photo from the left toolbar. 

2. Select Lookup. 

3. Select Queries. 

4. Select a predefined query, or select Type = ??? to add your own. 
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5. Replace ??? with a photo type that you added in photo properties, found here. 

6. Create the rest of your photo item and select OK. 

7. When this border is applied to a photo, this placeholder will automatically search 

for and populate the placeholder with a photo matching the photo type within 

that catalog. 
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Using the Retouch Workshop 

The Retouch Workshop provides a workspace for making any necessary retouches and 

edits to a photo. The workshop has an extensive series of tools for fixing even the 

smallest details of a photo. 

Find the Retouch Workshop by selecting the Photo Workshop tab from the bottom of 

the software, and selecting the Enhance tab from the bottom of the workspace. Select 

the photo you wish to retouch, and select the Retouch tool from the enhance toolset. 

Ensure that you have Use Retouch Workshop enabled with a check. 

Navigating the Retouch Workshop 
The Retouch Workshop is a workspace surrounded on all sides by tools. 

 The left toolbar includes all retouch tools, and undo and redo options. 

 The right toolbar includes different retouch methods and navigation options. 

 The top toolbar includes retouch settings specific to the selected retouch tool 

and method. 

 The bottom of the workspace includes all save options. 
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Panning 

Select pan from the right toolbar to click and drag the photo around. This is most helpful 

when you are zoomed in for editing small details. 

Zooming In 

Select zoom from the right toolbar to zoom in and out. 

 Left-click on an area of the border to zoom in.  

 Right-click to zoom out. 

 Click and drag a box around an area to zoom in and fill the workspace with that 

area. 

You can also zoom in and out by selecting zoom and using the mouse wheel. 

Fitting the Page 

Select fit page from the right toolbar to view the entire photo at the size of the 

workspace. 

Viewing at Actual Size 

Select actual size from the right toolbar to view the photo at full size in pixels. 

Before Retouching 
Before you start retouching, remember that all retouches will not be applied to the 

digital negative of your photo. Retouches are saved to a separate preview file and 

applied to your photo only when sent to print. Your original photo file will always be safe 

and can be reloaded at any time.  

Applying and Removing 

Select applying or removing from the right toolbar to determine whether you are 

adding or removing an effect. 
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Saving Retouches 

Select save retouches from the bottom of the workspace to save your retouches to the 

current photo and return to the Photo Workshop. 

Select save as new to save this photo as a new photo in the current catalog and return 

to the Photo Workshop, leaving your original photo intact and in the catalog. 

Understanding the Retouch Settings 
Each retouch tool and retouch method will have its own specific set of settings for 

retouching photos. These settings will be displayed on the top toolbar after selecting a 

retouch tool or method. 

Read on for a list of all retouch settings. 

Opacity 

Select the tool opacity. 100% is opaque and 0% is invisible. 

Choose Source 

Some tools will require you to first select an area of the photo. Select choose source 

and select an area in the photo. 

Size 

Select your brush or method size. 

Feather 

Feather is the gradient applied to the edge of you tool to soften edges. A higher 

feather is a softer and more gradual edge. 

Flow 

Flow is the percentage of pixels in the area that will receive the retouch. A higher flow 

applies the retouch to more pixels in the area. 
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Healing Effect 

Selecting and checking healing effect will let you select a specific area of the photo to 

use when blending. This setting is only available with the blemish tool. 

Color 

Select the color to be applied. 

Amount 

Select the intensity of an effect. A higher number is more intense. 

Radius 

Select the size of the radius for blurring photos. 

RGB 

Select an exact color with the RGB profile tools. 

Eyedropper 

Select the eyedropper and click on an area of the photo to save the RGB values in the 

RGB profile. 

Contrast 

Adjust the contrast. A higher contrast darkens the darks and lightens the lights. 

Brightness 

Adjust the brightness. A higher number is brighter 

Using the Retouch Methods 
Retouch methods determine how your selected tool will be applied. Think of the 

retouch tools as paint, and the methods as different sizes of paintbrushes. Select your 

retouch method from the right toolbar. 
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Brush 

This is the default software method. The brush is a circle that you can hold and drag to 

apply retouches. Adjust the size, feather, and flow and click to use the brush. 

Lasso 

Use the lasso to draw an area that will have the selected retouch applied to it. This 

method will apply the current retouch method and tool when creating the lasso, so 

select your method and tool beforehand. 

Poly Lasso 

Use the poly lasso to draw a polygon area that will have the selected retouch applied 

to it. This method will apply the current retouch method and tool when creating the 

polygon, so select your method and tool beforehand. 

Rectangle 

Use the rectangle to draw a box that will have the selected retouch applied to it. This 

method will apply the current retouch method and tool when creating the rectangle, 

so select your method and tool beforehand. 

Oval 

Use the oval to draw an ellipse that will have the selected retouch applied to it. This 

method will apply the current retouch method and tool when creating the oval, so 

select your method and tool beforehand. 

Fill All 

This method will apply the tool and settings to the entire photo. 

Clear All 

This method will clear the tool and settings from the entire photo. 

Using the Retouch Tools 
Read on for a brief description of all retouch tools. 
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Clone 

Use the clone tool to replace an area of a photo using another area of the photo as a 

source. Select opacity and choose a source. 

Blemish 

Use the blemish tool to blend an area of a photo with the surrounding area. Select 

opacity, and select healing effect to select a source for blending. 

Paint 

Use the paint tool to paint a selected color. Select opacity and the color. 

Dodge 

Use the dodge tool to lighten an area and increase contrast. Select the dodge 

amount. 

Burn 

Use the burn tool to darken an area and increase contrast. Select the burn amount. 

Sharpen 

Use the sharpen tool to increase focus of an area for a crisper look. Select opacity and 

an amount. 

Blur 

Use the blur tool to decrease focus of an area for a softer look. Select opacity and a 

radius. 

Color Saturation 

Use the color saturation tool to increase and decrease the amount of color in selected 

areas. Select a color amount. 

Color Balance 

Use the color balance tool to adjust RGB values for selected areas. Select opacity and 

the value. Use the eyedropper to import values from an area of the photo. 
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Color Accents 

Use the color accents tool to convert the photo into a black & white image. Select 

opacity, contrast, and brightness. 

Redeye 

Use the redeye tool to manually remove any red glare. Click the areas with redeye to 

remove the glare. 
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Running a Shoot 

So far we’ve walked you through setting up your studio, using the different functions, 

managing photos, editing photos, and creating orders. This section will guide you 

through running an entire shoot, from the moment the customer schedules a booking to 

the moment you send the order off for printing. 

If you’re already familiar with some of the steps, feel free to click a link and jump ahead 

to a later step: 

1. Adding a Customer. 

2. Creating a Booking. 

3. Setting Up Your Camera. 

4. Starting the Shoot. 

5. Capturing and Importing Photos. 

6. Retouching Photos. 

7. Presenting Photos. 

8. Creating an Order. 

9. Printing an Order. 

 

Each step has its own guides for using tools and navigating the software, so don’t worry 

if you’ve never used the software before. All specific directions for using tools will be 

written in red for easy reading. 

Now let’s start at the beginning. 

Adding a Customer 
If a customer comes into your studio or calls to make an appointment, you’ll first need 

to enter them into the customer database. 
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Select the Manage Studio tab from the bottom of the software and select the 

Customers tab from the top of the studio. 

 

 

 

The customer tab will display a list of all studio customers. If you are adding a booking 

for an existing customer, just select them from the list. For this shoot, we’re going to add 

a new customer. 

 Select New Customer from the right side of the window. 

 

 

 

This is the customer information page. Here you will find all address and contact 

information for this customer. 

 

Enter the following information about the customer and select Save Customer: 

 Name 

 Address 

 City 

 State 

 Zipcode 

 Phone Number 

 Status 

 Email 
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You will be returned to the customer information page. Your new customer will appear 

in the list. 

 

 

Creating a Booking 
You must have added the customer to the software before you can add a booking.  

 Select the Manage Studio tab from the bottom of the software and select 

the Customers tab from the top of the studio.  

 Select the customer for the booking. 
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This is your customer’s details page. When you create a booking, it will appear under 

the Current Bookings heading. 

 Select Add Booking from the bottom of the software.  

 

 

 

This is the booking information page. Here you will set the date, time, and booking 

descriptions. 

 Select the calendar next to Choose Date to select the date of the 

booking. 

 Select a Start Time and End Time. 

 Enter a name for the booking. You must enter a name. 

 Enter a description for the booking. This is optional. 

 Set the Update Status to Booked. 

 Select a room for the booking, if applicable. 

 Select and check Schedule Call. This will remind us to confirm the booking 

the day before it is scheduled to take place. 

 

 

If you will not be the employee handling the booking, you can assign another 

employee to handle the shoot by selecting [Assign Employee]. 
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 Select Save Booking. 

You will be returned to the customer details page. Your new booking will appear under 

the Current Bookings column. 

 

 

Setting Up Your Camera 
Most studios will be using a tethered or wireless camera that can instantly import photos 

into the software as they are captured. 

If you will be importing from a folder or from a camera media card, skip ahead to 

capturing and importing photos. 

Setting Up a Tethered Camera 

Any Canon EOS DSLR cameras can shoot and send photos directly to the software 

while connected through a USB or firewire cable. 

Follow these steps to set up your tethered camera for the shoot: 

1. Select the Manage Studio tab from the bottom of the software and select the 

Cameras from the top of the studio. 

2. Select Tethered Camera from the left side of the software under Select Camera 

Type. 

3. Connect the camera to the computer with a USB cable. 

4. Turn the camera on. 

5. Wait for Windows to detect the camera and prepare it for use. 

6. If the software does not detect the camera and display it on the left side of the 

software, select Detect Camera. 

7. The camera name will appear in the status bar at the bottom left of the 

software, and at the top center of the Cameras page. 
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8. Your camera is now ready to shoot tethered.  

Setting Up a WiFi Camera 

The software can receive photos wirelessly from any Canon Wireless File Transmitter 

(WFT) using an FTP server. You will need to have a wireless internet connection set up on 

your computer to use a WiFi camera. 

Follow these steps to set up your WiFi camera for the shoot: 

1. Select the Manage Studio tab from the bottom of the software and select the 

Cameras from the top of the studio. 

2. Select WiFi Camera from the left side of the software under Select Camera Type. 

3. Make sure the WFT is connected to your camera. 

4. Turn the camera on. 

5. Use the WFT connection wizard through the camera menu. For more details on 

finding the WFT wizard, refer to the camera manual. 

6. Select FTP as the communication method in the camera wizard. 

7. Enter your wireless network & router settings in the camera wizard. 

8. Once the FTP Server settings appear on your camera, enter the FTP Address and 

FTP Port listed on the Cameras page in the software. You must have Auto-Detect 

Address checked for this option. 

9. Once Login Method appears on your camera, use either ―Anonymous‖ or match 

the username and password defined below. You must have Anonymous 

Username checked to login anonymously without a password. 

10. Once Target Folder appears on your camera, select Root Folder. 

11. Complete the Wizard. 

12. Your WiFi camera is now ready to shoot wirelessly. 

 

Ensure that your camera has been detected and appears in the software in both the 

Cameras studio tab and in the status bar, located at the very bottom left of the 

software. 
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Starting the Shoot 
Your customer is entered into the studio and ready to go, your booking has been 

created, and your camera is connected and ready to shoot; let’s start the booking. 

Select the Manage Studio tab from the bottom of the software and select the 

Home tab from the top of the studio. 

 

 

 

Your booking should appear on your home page with the customer name, booking 

time, and booking information. 

Select the customer‟s name to go to the booking information page.  

 

 

 

If you could not find the booking on your home page or you are starting the booking 

early, select the Customers tab from the top of the studio and click on the customer 
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name in the list. Then click on the booking name to open the booking information 

page. 

Select the Go to Session button on the right side of the software. 

 

 

 

The booking will open automatically with a new catalog in the Photo Workshop. The 

catalog created is under Portraits, titled with the customer’s name, last name first. The 

photo group within the catalog is titled with the booking information you entered. 

 

 

Capturing and Importing Photos 
Once you have started the booking, you will be in the Photo Workshop, with a new 

catalog and photo group open for your customer. Verify that you are in the right 

catalog by checking the catalog and photo group from the top of the Photo Workshop 

workspace. 

 

Press the camera shutter or press SPACE on the keyboard as a hotkey to 

automatically take a photo. 
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The photo will automatically appear in the Photo Workshop workspace.  

 Finish taking your photos. 

 

 

Live View 

When Live View is activated on a tethered camera, two additional selections will 

appear on the top menu: 

                      

 Live View: When the Live View mode is activated on the camera and Live 

View is selected from the top menu, a new window will appear on the 

desktop. This window allows you to see the live feed as it is fed from the 

camera. 
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 Take Picture: Selecting Take Picture allows you to operate the shutter on 

the camera. A status indicator for the Auto Focus (AF-ON) will turn on 

when it is enabled. 

Importing Photos 

If your camera isn’t connected to the software and you need to manually import 

photos, follow these steps: 

 Get the photos from your camera into a location this computer can 

reach, whether it’s a network location, a file on this computer, or a media 

card attached to the computer via a card reader. 

 Return to the booking in the Photo Workshop. 

 Select Photos from the top of the Photo Workshop workspace. 
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 Select Import. 

 Navigate to the location of your photos and select Import All. 

All of your photos will be automatically added into the Photo Workshop. 

Retouching Photos 
Now that you have captured or imported all of the photos, it’s the ideal time to quickly 

retouch and edit them in the Photo Workshop. We will assume that the customer you 

just took photos of is going to hang around for a little bit to preview and proof the 

photos you took, so right now we’ll just worry about minor adjustments. 

If you are not familiar with the retouching tools, click here for the Photo Workshop tools 

and here for the Retouch Workshop tools. 

 Select the Enhance tab to make quick adjustments, such as centering the 

subject, scaling the photos, or fixing orientation. 

 Select the Correct tab to lighten, darken or add contrast. 

 Select the Color Balance tab to set the white balance. 

 Save all changes to each photo. 

 

If the customer is not waiting on you, feel free to take your time and make major 

adjustments and edits. 

Presenting Photos 
Once you have finished fixing any technical problems with photos, it’s time to present 

the photos to the customer. For this we’ll switch to Presentation Mode for a cleaner and 

friendlier look, free of distractions. 
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If you left the Photo Workshop, you need to reopen the booking in the Photo Library or 

the Photo Workshop. 

 Select the Manage Studio tab from the bottom of the software and select 

the Customers tab from the top of the studio. Select the customer name 

and ensure that the booking was properly saved.  

 

 

 

The booking should appear under Current Bookings or Previous Bookings with a time 

and link to view photos. 

 Select [View Photos] to open the photos in the Photo Library.  

Make sure this is the correct photo group and catalog. If so, let’s assume the customer is 

here and ready to preview their photos. It’s time to switch over to Presentation Mode. 

 Select Client Presentation from the bottom of the software. 

 

 

 

Presentation Mode will open. If you need to select a different catalog or photo group, 

select choose another catalog from the bottom of the workspace. 

At any time you can open a selected photo and catalog in a presentation-friendly 

version of the Photo Workshop to enhance a photo at the customer’s request. Select 

enhance selected photo from the bottom of the workspace. 

Select View from the top of the software to view a specific number of photos, or 

press – and + as hotkeys for viewing less and more photos. 
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Double-click a photo to preview that photo fullscreen. Once in fullscreen, use 

the arrow keys on your keyboard to switch photos. 

Click here for more details on how to present photos to your customers. 

Creating an Order 
After previewing their photos, your customer has chosen a number of favorites and is 

ready to place an order with you. This order can be placed in the Photo Library, Photo 

Workshop, or in Presentation Mode. 

Since we have been presenting and previewing photos in the customer-friendly 

Presentation Mode, we will make the order here. 

 Select Show Cart from the top right of the workspace to show the shopping cart. 
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If you do not want to display prices of packages, right-click any item in the shopping 

cart and select to uncheck Show Prices. This can be done when the customer is not 

around; the option will be saved. 

Adding Items to the Cart 

If you need to change your current package group, select the prev and more buttons 

from the package section of the cart, or select add package from the bottom of the 

cart and select a group from the dropdown menu. 

Once your customer has decided on which packages to order, you can add them to 

the cart. 

 Select a photo to add and select a package. The package #s 

correspond to 1 – 9 on your keyboard as hotkeys. 

 

 

 

 Select how many of that package to add to the cart. 
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When the packages are selected and added to the cart, you can add any last minute 

photo services. 

 

 

 

 Select add next to Services and select a service from the list. 

 

Placing the Order 

Once the order is ready to go, select place order in the shopping cart. A receipt will 

appear for printing. 

 Select to print the receipt to complete the sale. 

 Select Shipping to edit and verify billing and shipping information. 

The customer’s order has been placed.  

 Collect and process payment. 
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Printing an Order 
To send your customer’s order to print, open the Orders workspace. 

 

 

 

 Select the Orders tab from the bottom of the software, and select the 

New Orders tab from the top of the workspace. 

 

 

 

If you have auto print enabled, the order was already sent to print when it first entered 

the Orders workspace. Look for it in the Pending Orders tab if it was recently sent and 

might still be printing, or the Completed Orders tab if it has finished printing. 

If auto print is not enabled, select your order and select print order from the 

bottom of the workspace. 

 

 

 

Once the order has printed, it needs to be prepared and shipped to the customer. 

Take whatever steps necessary to prepare the order for shipping or pickup. 

 Select the order in the Completed Orders tab and select mark order 

shipped from the bottom of the workspace. 
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The order is now considered finished and shipped. 

 

 

More Information 
For more information on any particular area of a shoot, consult the sections on using 

that part of the program, or check the table of contents and index for quick reference. 
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Advanced Border Workshop 

The following section offers more detailed information on how to use the Border 

Workshop Borders are graphical designs you can add to the photos you take. Borders 

can be, but are not limited to, simple graphical overlays. Borders can also be more 

complex layouts, such as montages, repeated pictures, overlapping images, layered 

graphics, moveable graphics, and other custom arrangements.  

You can think of borders as layers of objects. You can think of layers as clear acetate 

sheets containing graphics or text layered on top of one another. Each graphic, 

picture, and text are on a different layer. The objects on each layer can overlap 

objects on other layers. Another analogy for this concept is paper cutouts laid on a 

page and arranged to make a design.  
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As the above illustration shows, the border starts with a base layer of a solid color, then 

layers are stacked on top of another to form a composite. Each text, image, and 

graphic resides on its own layer. 

The Border Workshop allows you to define border templates you can use repeatedly on 

photos in your catalog. You can specify the number of photos you want to use on the 

page, the graphic you want to use as the border, the text you want to appear, and 

effects you want to use.  

 

You can create your own graphics to use as borders, and use the Border Workshop to 

add the border graphic to the template. Or, you can simply create new borders by 

editing borders you already have to make them more suited to your needs. 

Note: If you are creating your own graphic borders, you need graphics software that 

can create targa files. Targa files are graphic files that allow a photograph to show 

through a border by using an alpha channel.  

Border Workshop Menu 
There are several options available in the Border Workshop that are only available via 

the Border Workshop menu. This menu allows the user to access both the front and 
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back view of a template via tabs. This menu also provides the user with a way to turn on 

a grid system or activate an auto alignment system, which is used in the creation 

process. Finally, users can access the undo and redo options. 

Front & Back Tab 

The Border Workshop provides a way for users to access both the front side and 

backside of a template. This feature is important to photographers who use borders 

and templates that have backs. For example, sport and event photographers may 

offer photo trading card products or small photo business cards. This unique Border 

Workshop feature allows professional users to access the back of templates to create 

products that customers want. 

The first option available on the border Workshop menu is the Front tab and Back tab. 

These options are available in the upper left portion of the Border Workshop screen. 

In order to visualize the purpose of this feature, imaging you are a sport photographer 

that is shooting the local Little League baseball teams. One of the most popular 

product offerings is a small trading card that the players can take out and trade with 

their friends, just like people do with professional Major League baseball cards.  

In order to make the cards more realistic, it is important that there is a front side of the 

card and a backside to the card. The front side includes a photo of the player and a 

baseball related graphic. For example, the following border is a front side of a baseball 

trading card. 
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The front side of the border contains important information such as the subject’s 

individual photo, team name and the subject’s first and last name. 

However, the information on the back of the card varies greatly. This graphic-centric 

template includes statistical information. In the case of a Little League baseball player, 

the subject’s first and last name, height, weight and field position are included. 

Information such as times at bat, batting average, age, RBIs, and homeruns can also be 

included to individualize the player’s information.  

Here is an example of the back of a trading card: 
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It is possible to add a back to any border or template. This Border Workshop feature is 

available by selecting the ―Back‖ tab while creating or editing any border. The 

application will ask the photographer if they would like to create a back for the border. 

Specifically, the application will indicate, ―This border does not have a back. Would you 

like to create a back now?‖ To create a back, select ―Yes.‖ To exit the window without 

altering the back settings, select ―No.‖ 

Add 

The Add menu allows you to quickly add items to your border. The menu options 

include: ―Photo,‖ ―Multiple Photos,‖ ―Graphic,‖ ―Text,‖ ―Effect,‖ ―Shape,‖ ―Barcode,‖ 

―Line,‖ ―Save Custom Object,‖ ―Edit Custom Object,‖ ―Add Custom Object.‖ 
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The following is a list of each option, followed with a brief description. 

Photo 

When creating border templates, you need a placeholder for one or more photos. You 

add photo placeholders to the border template in the position where you want a 

photo to appear. These photo placeholders are called image cells. In most cases, you 

will probably have only one image cell because the border is designed for only one 

photo. 

Multiple Photos 

Adding multiple photos using the Add Photo tool lets you create layouts where photos 

are positioned anywhere on the page. However, there may be times when you want to 

have multiple photos on the page in a row/column format as in a composite. 

Graphic 

Most borders contain a graphic, whether it is a decorative border that surrounds the 

photo or a simple logo in the corner of the page. Once the Graphic Object window 

appears, click the Browse button to select the graphic file you want to appear on the 

page. 

Text 

You can add either static text or variable text to a border. Static text appears as-is 

when the border is applied to a photo. When you apply a border to a photo that 

contains variable text, you are prompted to enter text to replace the variable. For 

example, you might have a static text label ―Name:‖ and a text variable for the name. 

When you apply the border to a photo, the application prompts you to enter the name 

of the person in the photo so his or her name appears.  

Effect 

You can add an effect object to overlay other objects in your template. The effect 

object takes on the effect you specify, such as grayscale or color saturation. When you 

layer the effect object on top of another object on the page, the effect is ―applied‖ to 

the object. 

Shape 
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You can add a shape object to your border, complete with transparency and text. It is 

possible to add and modify shadows, outlines, placement, and rotation. Once you 

select the ―Shape‖ option from the drop-down menu, another drop-down menu will 

appear with available shapes. 

 

 

Some shapes have multiple versions of the shape available in additional drop-down 

menus. Once you have selected your desired shape, you will be taken to the ―Shape 

Object‖ menu, where you can modify every part of the shape. 
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Barcode 

You can add a barcode object to your border by selecting the ―Barcode‖ option in the 

Add menu. A barcode provides a reliable way to keep track of data, allowing you to 

simply scan the code to determine price, order number, or any data desired. 

 

Once you have selected a barcode, the ―Barcode Object‖ window will appear. There 

are two tabs, a ―General‖ tab and a ―Size and Position‖ tab. 

From the General tab, first select the barcode format you will be using. Click the drop-

down menu next to ―Barcode Format‖ and select your desired format from the list. 

The empty text field at the top will determine what data is put into the barcode. This 

can be anything from the date, to an order number, to price, to a combination of all of 

those things.  

You can even type custom information into the text field. There is also an option 

available for predetermined data options. Click the ―Insert Special Text‖ button to see 

the available data. You may choose as many types of data as you want to be 

included in the barcode. 
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Many of the data options are queries. A query is a search function that will search and 

find the appropriate data. This data is entered when the border is first applied, or from 

various information in Studio Solution. For instance, the barcode below has a query for 

the order ID.  
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Although the Order ID was never entered in the border, as soon as the order was 

created, the query was made. When the border is applied to a photo, the query 

―%OrderId%‖ searches for the order ID and puts it into the barcode. The end result is this: 

 

 

Barcodes can be set with any of the data available, to be used on the back of items 

for pricing, on additional order sheets for easy scanning, or for aesthetic value, such as 

on the back of a baseball card or poster. 
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Line 

You can add a line and set or modify its attributes with this tool. The line style will 

depend upon the effects that are applied by the tool. 

                                                                                                                

Save, Edit, and Add Custom Object 

The Border Workshop allows you to quickly use the previously mentioned tools to create 

and edit an object, photo, effect, shape, or text object, and then save it as a ―custom 

object.‖ A Custom Object is something you create and name, then save in a 

predetermined Custom Objects directory.  

Once you have created an object you wish to save, select ―Save Custom Object‖ from 

the drop-down menu, which will bring up the Custom Objects prompt. 
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The Custom Objects window has two primary parts: a text field and the Custom Objects 

list. Click on the text field and enter the name you wish to associate with your custom 

object. It is recommended that you name it descriptively, so that you can recognize 

what each custom object is. Once you have entered a name, you are ready to add it 

to the list. Click the ―Add‖ button to add the custom object to the list. 

The Custom Objects list is a list found throughout different parts of the program, under 

the Borders options. Modifying the list here will also modify the Custom Objects list in the 

Photo Workshop, as well as the Edit & Proofing page. The other options available are 

―Move Up,‖ ―Move Down,‖ and ―Remove.‖ To move an object up or down in the 

Custom Objects list, select it and choose the appropriate option. To remove the object 

from the list entirely, select the object and click ―Remove.‖ 

 

Note: Removing a custom object from the Custom Objects list will delete it entirely. 

―Edit Custom Objects‖ will bring up the current list of Custom Objects, allowing you to 

move them up or down in the list, or to remove them. 

―Add Custom Object‖ will allow you to add a custom object from the Custom Objects 

list into the border you are currently working on.  
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Edit 

The Edit menu allows the user to quickly modify objects in the current border.  

 

 

―Duplicate‖ copies the selected object and pastes at the exact same location. The 

shortcut key for this is Ctrl + D. 

―Cut‖ copies the selected object and deletes it. The shortcut key for this is Ctrl + X. 

―Copy’ copies the selected object. The shortcut key for this is Ctrl + C. 

―Paste‖ pastes the selected object. To paste an object, you need to have already 

―cut‖ or ―copied‖ an object. The shortcut key for this is ―Ctrl + V.‖ 

―Delete‖ deletes the selected object. The shortcut key for this is ―Delete.‖ 

Options 

The Studio Solution Border Workshop menu provides a way for photographers to access 

the Options menu. This feature is important to photographers who are creating or 

editing a unique border or template. The Border Workshop menu includes grid and 

alignment features as well as undo and redo options.  

The Options menu, specifically, allows the user to access both grid and alignment 

options for the active border. These menu listings include ―Show Grid,‖ ―Grid Options,‖ 

and ―Auto Alignment.‖ 

 



Tutorial: Border Workshop 

 

267 

 

The ―Show Grid‖ feature allows the user to activate a grid system that can be used in 

the border creation process. Grids are helpful for users who want to make items 

symmetrical and positioned exactly on the border palate. 

 

To activate the grid option, select ―Options‖ from the Border Workshop menu. Then, 

select ―Show Grid‖ from the menu. A series of dots will appear on screen set in a perfect 

grid.  This grid will help the user match up photos and objects on right angles. This will 

also help the user count off spacing and will help ensure that the photos are the same 

size. 

The Border Workshop menu also provides a way for users to change the grid settings. 

The second feature available in the ―Options‖ menu is ―Grid Options.‖ When a user 

selects this function, the ―Snap Grid‖ window will appear. 
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Studio Solution users have several options in this window. First, the photographer can 

opt to display the grid when it is activated. This option is set to default as activated. To 

deactivate the option, click on the checkmark to make it disappear. 

The second option allows the user to make items ―Snap to Grid.‖ This means that when 

photographer moves an object or photo around the border palate, the object will line 

up directly on the grid lines. This means that the object or photos will snap to the visible 

grid line as the photos are moves around. The application will pick the nearest grid line. 

The third option allows the user to change the grid units. There are four units available in 

the drop down menu. These include ―inch,‖ ―pixel,‖ ―centimeter (cm),‖ and ―millimeter 

(mm).‖ 

Finally, users can change the number of grid units per inch. This allows the user to move 

the grid dots to represent a larger size. 

It is possible to activate this option by selecting a shortcut key. The keys assigned to this 

operation are ―CTRL G.‖ 

The next Border Workshop menu option is the feature called ―Auto Alignment.‖ This 

feature allows the user to more closely line up a photo on the exact line on the border 

palate. When the ―Auto Alignment‖ option is activated, guiding lines appear on the 

screen to guide the user in correct alignment. 
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These lines show exactly where the photo is supposed to be placed in reference to the 

other photos and object onscreen. 

The last two Border Workshop menu options include the Undo and Redo options. The 

Undo tool allows the user to remove retouch changes one step at a time. If a change is 

made to the image in the workshop, then the undo tool can remove that change. The 

tool removes the most recent change first. It is possible to remove all of the changes by 

repeatedly selecting Undo. 

The Redo tool allows the user to reverse the Undo effect. The tool will redo whatever 

effect the user made to the image and then subsequently removed. This is a great way 

to produce an effect in the Retouch Workshop and then compare a before and after 

version of that effect. You can apply the effect, Undo the effect to see what it looked 

like before, and then finally redo the effect. 
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Setting Border Properties 

When you create a new border, you begin by entering the border properties. The 

Border Properties window appears automatically when you click ―new‖ on the toolbar. 

When editing a border, click ―border properties‖ on the Border Workshop toolbar. 

 

Enter a descriptive name for the border. This description will appear in the Borders menu 

when you select a border to apply to a photo. If this is not a new border, the border’s 

filename appears in the Filename field. Next, select the page settings. You can set a 

page color, but in most instances, the page will not be visible when the border is 

applied to a photo because the photo fills the border opening. However, if you make 

the photo a smaller size than the border opening, the page color will show, creating a 

photo mat look. 

Back Layout 

There is an option to change the back layout: ―Rotate 180 degrees when printing.‖ 

Checking this box will rotate the back of your border, changing the bottom to the top 
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and vice-versa. This option is useful for printing double-sided objects that will be flipped 

on a horizontal hinge, rather than the normal vertical hinge used in most books. This 

option can only be enabled if your border has a back, and then only from the Border 

Properties on the ―back‖ tab. If you are in the Border Properties of the front tab, this 

option will be grayed out.  

In most cases, you will use the default photo orientation setting of ―Use photo 

orientation.‖ When you apply a border to a photo, the photo retains its original 

orientation in the border opening. Choose one of the rotate options to rotate the photo 

either clockwise or counterclockwise within the image cell. 

If a border has variable fields that require you to input text, you can set the Text Dialog 

option to either show the Text Fields window each time the border is applied or open 

the window only when you click the border Text button. 
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Using the Border Items List 

As you add objects to a border, the objects are listed in the Border Items column on the 

right side of the screen. Use this list to select items on the page. You can also select an 

item on the page by clicking it, but as you overlap items, it can be difficult to select 

items underneath. When you select items in the Border Items list, they are also selected 

on the page.  

You can double-click an item in the list to edit its properties, or select the item and click 

―item properties‖ on the toolbar. Delete a selected item by clicking ―delete‖ on the 

toolbar. If you want to duplicate an item, select it and click ―duplicate‖ on the toolbar. 

You can only duplicate a single item at a time. You can also cut or copy a selected 

item and paste from the Windows Clipboard by clicking the corresponding tools on the 

toolbar.  

The order of the items in the Border Items list is important. The first item in the list is on the 

bottom of the layer stack. The last item in the list is the top layer. You can change an 

item’s position in the layer stack by selecting the layer and using the Order tool. See the 

Order Tool section for information on layer order. 

To help you set the position and size of objects, the bottom of the Border Items column 

displays the coordinates of your mouse pointer. You can also view the size and position 

of a selected object. 

Adding Photo Placeholders 
When creating border templates, you need a placeholder for one or more photos. You 

add photo placeholders to the border template in the position where you want a 

photo to appear. These photo placeholders are called image cells. In most cases, you 

will probably have only one image cell because the border is designed for only one 

photo. The example below is a single photo with a simple border overlay. 



Tutorial: Border Workshop 

 

273 

 

 

You might want to create a design using more than one photo. In this case, you would 

add multiple image cells and position them on the page where you want the photos to 

appear. The following example uses four different photos. 

 

To add a photo to the border template, click ―add photo‖ on the toolbar. The Photo 

Object window appears. When you add the first photo, ―*Photo1‖ appears in the Photo 

field automatically. Photo 1 is the photo you have open in the photo workshop when 

you apply the border.  

When you add a second photo to the template, ―*Photo2‖ appears in the Photo field, 

but if you want to add Photo 1 again, click the Lookup button, and select *Photo1 from 

the Photos menu, or type *Photo1 in the Photo field. See the Using the Photo and 

Graphic Object Query section later in this chapter for more information on using the 

lookup. 
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Transparency Options 

The Transparency setting you select depends on the type of photos you will use with the 

border. If you want the photo to be transparent, select the Simple option and enter a 

transparency percentage. If the border is for green screen photos, select the Chroma 

key option. If the border is for multi-exposure photos you want to overlap, select either 

the High-key or Low-key option, depending on whether the photo you are adding has 

a white or black background. 

If you want to create effects where a section is masked off so the effect is not applied, 

select Pre-defined Mask, and select a mask you want to apply.  
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You can create your own masks if you want a transparent shape that is not available in 

the pre-defined masks. For example, you might want to create a cut-out as in the 

example below.  

 

To create a custom mask effect, you must first create a graphic file that contains the 

shape you want to be masked from the effect. On the Choose Mask window, check 

the ―Custom Mask‖ checkbox, and browse for your mask file. The effect above uses the 

following mask JPG file. 
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The inner shape is the masked area and is transparent. The default color around the 

masked area is white. If you want the non-transparent area to be a color other than 

white, you can use the Color effect. See the custom mask example in the Adding an 

Effect section. 

Movement Options 

The Movement setting determines if you can move the photo inside the border when 

you apply the border in the Photo Workshop. The default setting, Adjustable, gives you 

freedom to move the photo within the image cell. The Fixed setting does not let you 

move the photo at all. The Floating setting gives you freedom to move the photo 

anywhere on the page. The Relative setting allows you to move the photo, but its 

position remains relative to the object on the previous layer. This is useful if you want to 

keep the relationship between two photos or a photo and text. Using this option is like 

grouping objects. In the example below, you want to be able to move the photos as a 

whole, but you do not want to be able to move them independently. The large photo is 

set to Adjustable, and the small photo is set to Relative. 



Tutorial: Border Workshop 

 

277 

 

 

Advanced Options 

You can add a frame to the photo, and specify the frame color, size, and offset (from 

the photo edges). If you want a photo to have a shadow, select the Draw a Drop 

Shadow option. With this selection, you can have the shadow appear either below the 

photo or on top of the photo so the photo appears inset. Specify the offsets and radius 

of the shadow.  

You can choose whether or not a photo must be manually selected. When you disable 

this option, selecting photos in the photo bar of the Photo Workshop automatically fills in 

the image cells. When you enable this option, you must drag a photo from the photo 

bar to the image cell in which you want the photo to appear. Finally, you can set a 

rotation angle for the photo. 

To set the exact position and size of an image cell, click the Options tab. 

After you add the image cell, you can size it with the mouse. Select the cell and 

position your pointer in one of the corners until you see the arrow pointer. Drag the 

corner to change the size of the image cell. 
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Size and Position 

It is possible to select the size and position for the photo from the ―Photo Object‖ 

window. This is available in the ―Size and Position‖ tab. Photographers can change the 

position starting at the top left corner. This positioning system can be measured in 

inches, pixels, centimeters (cm), or millimeters (mm). 

 

 

Before you choose a position or size for your object, first check the drop-down box in 

the upper right hand corner, there are four possible units of measure: pixels (default), 

inches, centimeters, and millimeters. You can change the unit of measure at any time, 

and the numbers in each field will automatically change to accommodate the new 

units, without changing the position or size. 

The ―Position‖ fields determine exactly where each side of the shape is located. The 

farthest point up, down, left, and right of the shape will be placed at these coordinates. 

A ―Top‖ entry of 0 means the topmost part of the object will extend to the very edge of 

the top border. A ―Left‖ entry of 50 means the object will start 50 pixels from the leftmost 
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edge of the border. To change the position of the edges of your object, use the arrow 

buttons or click in the text fields and type in the desired amounts.  

Note: Changing the coordinates within the Position fields can change the size of your 

object. 

To quickly change the position of object, you can click the ―Alignment Options‖ button. 

This option will bring up a drop-down list of available alignments: Left, Center, Right, 

Center of Page, Top, Middle, and Bottom. 

The ―Size‖ fields determine the width and height of your shape. Click the arrow buttons 

or click in the text field to enter the desired size of your object. To quickly change the 

size of a object, you can click the ―Fill Options‖ button. This option will bring up a drop-

down list of available fill options: Fill Entire Page, Fill Width, Fill Height. Choosing one of 

these will extend those parameters to the edge of the border. 

Add Multiple Photos 
Adding multiple photos using the Add Photo tool lets you create layouts where photos 

are positioned anywhere on the page. However, there may be times when you want to 

have multiple photos on the page in a row/column format as in a composite. To create 

a template for this type of layout, click ―add multiple photos‖ on the toolbar to open 

the Composite Object window. 
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If you want a fixed number of rows and columns, set the array size by specifying the 

number of rows and columns. If you want a specific number of photos, enter the 

number of photos you want on the page. You can choose to lookup photos from a 

query since the number of photos could vary by job. You can also select the value to 

start the count for the photos. 

Photo Queries 

On the Photos tab, select ―Lookup the photos by query‖ to set queries specifying which 

photos you want to print. Click the Edit button to open the Photo Query window. Click 

the Add Query button to select a predefined query. Many times, you simply want to 

print all photos in a catalog, including sub-catalogs, or you want to print all the photos 

in the open sub-catalog. You can choose either of these queries by selecting the 

Generic Queries menu item. 

You can use other predefined school-related queries on the Add Query menu. You can 

have your composite display photos by class, grade, or entire school.  
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Note: For these predefined queries to return results, you must enter photo data for your 

photos. You must enter “type” in the property field and use a value that matches those 

in the queries.  

By class, you can select a query that displays all photos in the class catalog, including 

the teachers. You can select a query that displays only the teachers in the class or a 

query that displays only the students in the class. 

By grade, you can select a query that displays all the photos in the grade, including the 

teachers. You can select a query that displays only the teachers in the grade or a query 

that displays only the students in the grade. You can also select a query that displays 

only the male or female students. With this query, the gender that appears in the 

composite depends on the photo you select in the Photo Workshop. If the photo data 

of the selected photo contains a value of ―female‖ in the Gender field, the composite 

displays the females in the grade. Select a male photo to view all males. 

By entire school, you can select a query that displays all the photos in the school (i.e., all 

photos in the job). You can select queries that display only the administrative staff, only 

the teachers, or only the students in the school. 

If you want to specify a Type query of a name other than those predefined, select ―Find 

type‖ from the Add Query menu and replace the question marks with a type value you 

use in your photo data. When you apply the composite border to a photo, the 

application looks in the catalog for the photos having the type value you specified and 

adds it to the composite. 

You can add multiple queries to the composite. For example, if you want to create a 

composite that displays the teacher first and then all the students in a class, you can 

add the Teacher by Class query, and then add the Students by Class query. The order 

of the queries determines the order in which the photo types display in the composite. 

In the example below, the Teacher by Class query is first; therefore, the teachers will 

appear on the composite first. 
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To change a query, select it in the list, and click the Change Query button. A cursor 

appears allowing you to type changes to the query. To remove a query, select it in the 

list, and click the Remove button. 

Change the sorting of individual photos in the composite by clicking the Change 

button. You can set up to three levels of sorting. Select the item you want to sort by, 

and then choose either ascending or descending. 

You can choose to draw all images that match the queries, including photo 

placeholders of missing photos. If you do not want to have photo placeholders in the 

composite, select ―Do not draw missing photos.‖ You can also choose not to include 

photo placeholders and, in addition, include a list of the names of those not pictured. If 

you choose this option, you can set font attributes for the list by clicking the Font button. 

Image Cell Settings 

Set the fixed aspect ratio for the images to be on the composite. Click the Edit button 

to set the size. You can select a common size, or to enter a custom size, select Custom 

from the Common Sizes drop-down and enter the height and width.  
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Enter the size of the area you want to fill, enter the number of rows and columns, and 

select the orientation of the photos. If there are more photos than what you allow for, 

the application overrides the size and row/column setting to fit all images on the page. 

If you want space between the photos, select ―Spaced.‖ Choose how to handle 

overlapping photos, and how you want to align the last row if it is not full.  

Photo Labels 

On the Labels tab, check the Show Labels checkbox if you want the composite to have 

labels below each photo. Enter the label you want to appear, and click the Font button 

to set the font attributes of the text. The label can be any text or any variable name 

enclosed in percent signs (%). If you use a variable label, the application prompts you 

to enter the variable value for each photo when the composite is generated. Choose 

the position of the label in relation to the photo. If you want the label text to be white 

on a black background, click the Invert checkbox. 

You can label with predefined variables such as the date or copyright by clicking the 

Insert Auto Text button and selecting a variable. 

Composite Options 

The Transparency setting you select depends on the type of photos you will use with the 

border. If you want the photo to be transparent, select the Simple option and enter a 

transparency percentage. If you want to create effects where a section is masked off 

so the effect is not applied, select Pre-defined Mask, and select a mask you want to 

apply. If the border is for green screen photos, select the Chroma key option.  

You can add a frame to the photo, and specify the frame color, size, and offset (from 

the photo edges). If you want a photo to have a shadow, select the Draw a Drop 

Shadow option. With this selection, you can have the shadow appear either below the 

photo or on top of the photo so the photo appears inset. Specify the offsets and radius 

of the shadow.  

Composite Size and Position 

Before you choose a position for your object, first check the drop-down box in the 

upper right hand corner, there are four possible units of measure: pixels (default), 

inches, centimeters, and millimeters. You can change the unit of measure at any time, 

and the numbers in each field will automatically change to accommodate the new 

units, without changing the position or size. 
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The ―Position‖ fields determine exactly where each side of the shape is located. The 

farthest point up, down, left, and right of the shape will be placed at these coordinates. 

A ―Top‖ entry of 0 means the topmost part of the object will extend to the very edge of 

the top border. A ―Left‖ entry of 50 means the object will start 50 pixels from the leftmost 

edge of the border. To change the position of the edges of your object, use the arrow 

buttons or click in the text fields and type in the desired amounts.  

Note: Changing the coordinates within the Position fields can change the size of your 

object. 

To quickly change the position of object, you can click the ―Alignment Options‖ button. 

This option will bring up a drop-down list of available alignments: Left, Center, Right, 

Center of Page, Top, Middle, or Bottom. 

Adding a Border Graphic 
Most borders contain a graphic, whether it is a decorative border that surrounds the 

photo or a simple logo in the corner of the page. You can add one or more graphics to 

your border template by clicking ―add graphic‖ on the toolbar. The Graphic Object 

window appears. Click the Browse button to select the graphic file you want to appear 

on the page.  

The Border Workshop can use several different types of files while making graphics. The 

Workshop will convert these files to .PNG files automatically as the border is created. 

Transparency Options 

If you want the graphic to appear as-is, leave the Transparency option on None. If you 

want the graphic to be transparent, select the Simple option and enter a transparency 

percentage. If you want to make a single color in the image transparent, select the 

Drop Out a Specific Color option and choose the color you want to drop out. If your 

graphic has an alpha channel you want to make transparent, select the Use Image 

Alpha Channel option. 

Movement Options 

The Movement setting determines if you can move the graphic when you apply the 

border in the Photo Workshop. The Fixed setting does not let you move the graphic at 

all. The Floating setting gives you freedom to move the graphic anywhere on the page. 

The Relative setting allows you to move the graphic, but its position remains relative to 
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the object on the previous layer. This is useful if you want to keep the relationship 

between two graphics or a graphic and text. Using this option is like grouping objects. 

Advanced Options 

You can add a frame to the graphic, and specify the frame color, size, and offset (from 

the graphic edges). If you want a graphic to have a shadow, select the Draw a Drop 

Shadow option. With this selection, you can have the shadow appear either below the 

photo or on top of the photo so the photo appears inset. Specify the offsets and radius 

of the shadow. Finally, you can set a rotation angle for the graphic. 

Size and Position 

It is possible to select the size and position for the graphic elements from the ―Graphic 

Object‖ window. This is available in the ―Size and Position‖ tab.  

Before you choose a position or size for your object, first check the drop-down box in 

the upper right hand corner, there are four possible units of measure: pixels (default), 

inches, centimeters, and millimeters. You can change the unit of measure at any time, 

and the numbers in each field will automatically change to accommodate the new 

units, without changing the position or size. 

The ―Position‖ fields determine exactly where each side of the shape is located. The 

farthest point up, down, left, and right of the shape will be placed at these coordinates. 

A ―Top‖ entry of 0 means the topmost part of the object will extend to the very edge of 

the top border. A ―Left‖ entry of 50 means the object will start 50 pixels from the leftmost 

edge of the border. To change the position of the edges of your object, use the arrow 

buttons or click in the text fields and type in the desired amounts.  

Note: Changing the coordinates within the Position fields can change the size of your 

object. 

To quickly change the position of object, you can click the ―Alignment Options‖ button. 

This option will bring up a drop-down list of available alignments: Left, Center, Right, 

Center of Page, Top, Middle, or Bottom. 

The ―Size‖ fields determine the width and height of your shape. Click the arrow buttons 

or click in the text field to enter the desired size of your object. To quickly change the 

size of a object, you can click the ―Fill Options‖ button. This option will bring up a drop-

down list of available fill options: Fill Entire Page, Fill Width, Fill Height. Choosing one of 

these will extend those parameters to the edge of the border. 
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Adding Text 
You can add either static text or variable text to a border. Static text appears as-is 

when the border is applied to a photo. When you apply a border to a photo that 

contains variable text, you are prompted to enter text to replace the variable. For 

example, you might have a static text label ―Name:‖ and a text variable for the name. 

When you apply the border to a photo, the application prompts you to enter the name 

of the person in the photo so his or her name appears. 

To add text, click ―add text‖ on the toolbar. The Text Object window appears. Enter the 

text you want to appear on the page. If you want to enter a text variable, type a 

percent sign before and after the variable name. For example, you enter the text ―My 

name is %name%.‖ This example prints the static text ―My name is‖ and then prompts 

you for a name. You might also use variable text without static text. For example, 

%title% prompts you for the person’s title and prints only the title. You can insert 

predefined variables such as the date or copyright by clicking the Insert Auto Text 

button and selecting a variable. 

Attribute Options 

Select the font settings and text alignment. You can set color attributes by checking the 

attributes you want to use and choosing a color. This section allows the photographer 

to set text opacity, the background color for the text box and the background color 

opacity. 

Movement Options 

The Movement setting determines if you can move the text when you apply the border 

in the Photo Workshop. The Fixed setting does not let you move the text at all. The 

Floating setting gives you freedom to move the text anywhere on the page. The 

Relative setting allows you to move the text, but its position remains relative to the 

object on the previous layer. This is useful if you want to keep the relationship between 

two text objects or a graphic and text. Using this option is like grouping objects.  

Vertical Alignment Options 

Choose the vertical alignment within the text box. When you add text, it is inside a text 

box that can be sized. This setting aligns the text at either the top, middle, or bottom of 

the text box. 
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Character and line Spacing 

The Border Workshop allows user to set custom character spacing for the text on a 

border. The workshop offers default, exact, and even options. The ―Exact‖ option allows 

the photographer an opportunity to set the exact spacing measured in pixels. The 

―Evenly Spaced Text Box‖ option means that each character will be evenly spaced 

with every other character in the text box. 

The Border Workshop also allows the user to set custom line spacing for the text on the 

border. These options include single, multiplier and exact. The multiplier option takes the 

amount fixed for single and multiplies that by the entered number. A photographer 

could choose 6 and the result would be 6 single lines between each line of text. The 

exact option allows the user to select an exact pixel width. If the user entered 20 in the 

―Exact‖ field, then the space between each line of text would be 20 pixels wide. 

Advanced Options 

The advanced section of the Text Object window includes seven features. These allow 

the user to display text onscreen as a guide but the text is not printed. It allows the user 

to draw an outline around the text in addition to a drop shadow or an inside shadow 

around the text. The advanced options allow the user to enter a text rotation angle if 

you want rotated text. Users can also select whether or not you want word-wrap 

enabled. When enabled, the text wraps within the text box. Finally, this feature allows 

the user to make the border editable for future changes. 

Size and Position 

It is possible to select the size and position for the text from the ―Text Object‖ window. 

This is available in the ―Size and Position‖ tab. Before you choose a position or size for 

your object, first check the drop-down box in the upper right hand corner, there are 

four possible units of measure: pixels (default), inches, centimeters, and millimeters. You 

can change the unit of measure at any time, and the numbers in each field will 

automatically change to accommodate the new units, without changing the position 

or size. 

The ―Position‖ fields determine exactly where each side of the shape is located. The 

farthest point up, down, left, and right of the shape will be placed at these coordinates. 

A ―Top‖ entry of 0 means the topmost part of the object will extend to the very edge of 

the top border. A ―Left‖ entry of 50 means the object will start 50 pixels from the leftmost 
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edge of the border. To change the position of the edges of your object, use the arrow 

buttons or click in the text fields and type in the desired amounts.  

Note: Changing the coordinates within the Position fields can change the size of your 

object. 

To quickly change the position of object, you can click the ―Alignment Options‖ button. 

This option will bring up a drop-down list of available alignments: Left, Center, Right, 

Center of Page, Top, Middle, or Bottom. 

The ―Size‖ fields determine the width and height of your shape. Click the arrow buttons 

or click in the text field to enter the desired size of your object. To quickly change the 

size of a object, you can click the ―Fill Options‖ button. This option will bring up a drop-

down list of available fill options: Fill Entire Page, Fill Width, Fill Height. Choosing one of 

these will extend those parameters to the edge of the border. 

Adding an Effect 
You can add an effect object to overlay other objects in your template. The effect 

object takes on the effect you specify, such as grayscale or color saturation. When you 

layer the effect object on top of another object on the page, the effect is ―applied‖ to 

the object. 
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Using the grayscale effect object, you can create an image such as the one shown 

above. The large photo is Photo1 and the small photos are Photo2 and Photo3. The 

effect object is layered under the small photos in the layer stack, but on top of the large 

photo so only the large photo has the effect. The layer the effect is on is very important. 

In this example, if the effect were on top of all other layers, all photos would be 

grayscale. To add an effect, click ―add effect‖ on the toolbar. The Effect Object 

window appears. Select the effect you want to use.  

Transparency Options 

Select the transparency option. If you do not want any special transparency effect, 

select None. If you want to create effects where a section is masked off so the effect is 

not applied, select Pre-defined Mask, and select a mask you want to apply.  

You can create your own masks if you want a transparent shape that is not available in 

the pre-defined masks. For example, you might want to create a color mat effect with 

a cut-out as in the example below.  



Tutorial: Border Workshop 

 

290 

 

 

To create a custom mask effect, you must first create a graphic file that contains the 

shape you want to be masked from the effect. On the Choose Mask window, check 

the ―Custom Mask‖ checkbox, and browse for your mask file. The mat effect above 

uses the Color effect and the following mask JPG file. 
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The inner shape is the area masked from the effect. When you add the mask file to the 

effect, the effect is applied only to the area outside the mask area. The default color for 

the outer edge of a mask file is white. Had the color effect not been applied, the non-

transparent portion of the mask would be white. See the mask example in the Adding 

Photo Placeholders section. 

Movement Options 

If you want to be able to move the effect in relation to the object just below it in the 

layer order, select the Relative option. This groups the effect with the object on the 

previous layer. Otherwise, the effect object is fixed; it cannot be moved when the 

border is applied to a photo. 

Advanced Options 

In the Advanced options, you can enter a rotation angle for the effect object. If you 

selected a mask, you can invert the mask. Inverting the mask blocks off the area 

outside the mask shape so the effect is applied to the shape instead of around the 

shape. 

Other Options 

Some of the effects have additional options. The Brightness, Darken and Saturation 

effects allow you to enter an amount. The Color effect allows you to select a color and 

enter a transparency value. The DuoTone effect allows you to select a color and enter 

saturation and hue values. The remaining effects have no extra settings. 

Size and Position 

It is possible to select the size and position for the effect from the ―Effect Object‖ 

window. This is available in the ―Size and Position‖ tab. Before you choose a position or 

size for your object, first check the drop-down box in the upper right hand corner, there 

are four possible units of measure: pixels (default), inches, centimeters, and millimeters. 

You can change the unit of measure at any time, and the numbers in each field will 

automatically change to accommodate the new units, without changing the position 

or size. 

The ―Position‖ fields determine exactly where each side of the shape is located. The 

farthest point up, down, left, and right of the shape will be placed at these coordinates. 

A ―Top‖ entry of 0 means the topmost part of the object will extend to the very edge of 

the top border. A ―Left‖ entry of 50 means the object will start 50 pixels from the leftmost 
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edge of the border. To change the position of the edges of your object, use the arrow 

buttons or click in the text fields and type in the desired amounts.  

Note: Changing the coordinates within the Position fields can change the size of your 

object. 

To quickly change the position of object, you can click the “Alignment Options” button. 

This option will bring up a drop-down list of available alignments: Left, Center, Right, 

Center of Page, Top, Middle, or Bottom. 

The ―Size‖ fields determine the width and height of your shape. Click the arrow buttons 

or click in the text field to enter the desired size of your object. To quickly change the 

size of a object, you can click the ―Fill Options‖ button. This option will bring up a drop-

down list of available fill options: Fill Entire Page, Fill Width, Fill Height. Choosing one of 

these will extend those parameters to the edge of the border. 

Editing a Text Object’s Font 
After adding a text object, you can change its font without opening the item 

properties. Select one or more text objects, and click ―font‖ on the toolbar. You can set 

font attributes for the text and view a sample of your font selections before applying 

them. 

Adjusting the Page Layout 
After you add border objects, you might need to adjust how they are presented on the 

page. For example, you might have three small photos you want to align and space 

evenly. Or, you might need to change the layer order of overlapping objects to 

achieve the look you want. Use the following tools to make these kinds of layout 

adjustments. 

Fill & Fit Tool 

Use this tool to size a selected object in relation to the page.  

 Fill Entire Page: Sizes the object to the exact size of the page 

 Fill Width: Sizes the object to the exact width of the page 
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 Fill Height: Sizes the object to the exact height of the page 

 Fit Within Page: Sizes the object proportionally until its boundaries reach the edge 

of the page 

Make Same Tool 

The Make Same tool gives one object the same attributes as another. The order in 

which you select objects before using this tool is important. First, select the object from 

which you want to copy attributes, and then select the objects you want to copy to. 

Click ―make same‖ on the toolbar and select the attributes you want to copy. 

 Make Same Size: Sizes the object to the exact size of the object you selected first 

 Make Same Size & Position: Sizes the object to the exact size and positions the 

object to the exact position of the object you selected first 

 Make Same Width: Sizes the object to the exact width of the object you selected 

first 

 Make Same Height: Sizes the object to the exact height of the object you 

selected first 

 Make Same Font: Applies the same font attributes as the text object you 

selected first 

Center Tool 

Use this tool to center selected items on the page. When you have multiple items 

selected, they are centered as a single unit. 

 Horizontally: Centers the object between the left and right of the page 

 Vertically: Centers the object between the top and bottom of the page 

 Center: Centers both horizontally and vertically 

Align Tool 

This tool aligns two or more selected objects with each other. The first three align 

options are for the horizontal alignment of objects stacked vertically. The last three are 

for the vertical alignment of horizontal objects. 

 Left: Aligns objects by their left edges 

 Center: Aligns objects by their centers 
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 Right: Aligns objects by their right edges 

 Top: Aligns objects by their top edge 

 Middle:  Aligns objects by their middles 

 Bottom: Aligns objects by their bottom edges 

Space Tool 

Use the Space tool to evenly space three or more selected objects. You can set 

spacing from the object edges or from the object centers. 

 Gaps Horizontally: Equally Spaces the gaps between objects lined horizontally on 

the page. 

 Gaps Vertically: Equally spaces the gaps between objects lined vertically on the 

page 

 Centers Horizontally: Equally spaces objects from their centers. Use with objects 

lined horizontally on the page. 

 Centers Vertically: Equally spaces objects from their centers. Use with objects 

lined vertically on the page. 

Order Tool 

You can change the layer order of a selected object. As you add objects to the page, 

they are layered one on top of another. The back, or bottom, layer is covered by new 

layers. The front, or top, layer covers all previous layers. To achieve the look you want, 

you might need to rearrange the order in which objects appear on the page. You can 

use the Order tool on only one selected object at a time. 

 Send to Back: Sends the selected object to the bottom of the layer stack. The 

object becomes the first item in the Border Items list. 

 Bring to Front: Sends the selected object to the top of the layer stack. The object 

becomes the last item in the Border Items list. 

 Send Backward: Sends the selected object one layer toward the bottom of the 

layer stack. The object moves closer to the first item in the Border Items list. 

 Bring Forward: Sends the selected object one layer toward the top of the layer 

stack. The object moves closer to the last item in the Border Items list. 
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Rotate Tool 

Use this tool to rotate photo, text, and graphic objects. You can rotate 90 degrees, 180 

degrees or an angle you specify. When you rotate photo objects, the photo rotates 

within the image cell. For example, if you have a portrait image cell and you rotate 90 

degrees, the image cell remains portrait, but the photo within the cell rotates 90 

degrees.  

 Reset: Resets the rotation to the original setting 

 90º Clockwise: Rotates the selected object 90 degrees to the right 

 90º Counterclockwise: Rotates the selected object 90 degrees to the left 

 180º: Rotates the selected object 180 degrees 

 Angle: Allows you to set a specific degree angle of rotation 

Select 

The Studio Solution Border Workshop provides more control for the border creator. The 

―Select‖ tool provides the photographer with a simple way to click-select border 

objects. This tool provides a way to click and drag objects around the template or to 

perform subtle changes in a zoomed in view. 

To use the ―Select‖ tool, highlight the icon. This will activate the feature. Click on items in 

the Border Preview. All selected items will highlight by displaying an outline. 

 

 

This is what a 

selected item in 

the Border 

Workshop looks 

like. An outline will 

appear on the 

exact outline of 

the original object. 
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Pan 

The Pan tool allows the photographer to move around a photo quickly while zoomed 

in. To use this tool, click on ―Pan.‖ Move the cursor over to the border viewer and notice 

that the cursor now appears as a small hand. Hold the left button down on the mouse 

and move around the photo. The user should notice that the object moves the same 

the way the mouse moves. 

Zoom 

The Zoom tool allows the photographer to pull the border closer for better viewing. This 

is helpful when building a border because you can see the flaws up close and thus you 

are able to better cover and correct those flaws. To zoom the image, click on the 

magnifying glass icon. When you move over the border viewer, your cursor now 

appears as a magnifying glass. Click on the part of the border that you wish to magnify. 

You can either click repeatedly on the picture to zoom in or you can click on the object 

and use the mouse scroll wheel to zoom. Whatever you click on in the border viewer will 

automatically center. 

Fit to Page 

The Fit to Page tool allows you to zoom the entire template out to the original border 

size. This tool will fit the entire image into the confines of the border viewer. 

Actual Size 100% 

The Actual Size tool allows the user to view the border at the actual pixel size of your 

monitor. The Border Viewer portion of the editing screen shows a condensed version of 

the image. By viewing the image at its Actual Size, you are able to see every 

imperfection available for display. For extremely large borders this is a great way to 

identify parts of the border that would not be noticeable in a small 4x6 print. 
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Testing Variable Text fields 

If you add variable text to your template, the application prompts you for values for 

those text fields when you apply the border to a photo. You can test the variable input 

form from the Border Workshop to make sure fields are correct and text appears 

correctly on the page. To test the form, click ―test form‖ on the toolbar. The Text Fields 

window displays your variable text fields. You can enter values into the fields to check 

your layout.  

Using the Photo and graphic Object Query 
When you add photos and graphics to a border template, you can select a variable 

that instructs the application to generate the border at the time it is applied based on 

images found in the catalog. The simplest photo variable is *Photo# (e.g., *Photo1). This 

variable is entered automatically as you add single photos to the template. This 

variable simply adds to the border the first, second, third, etc. photo you select while 

editing a photo in the Photo Workshop. There are two other types of predefined 

variables you can select—graphic and query variables. 

Graphic Variables 

If have a graphic element you consistently want to add to your photos, you might add 

the graphic to your catalog. Common graphic elements in a border are a background 

and a logo. Once added to the catalog, the graphics are available to be used by 

graphic variables you specify in your border template.  

For your border template to access these graphics, you must add photo data to the 

graphic file so the border can find them. To add photo data, right-click the graphic in 

the Photo Library and select Properties. Click the Photo Data tab, and click the Add 

Data button. Using the background example, enter a property of graphic and a value 

of background. 
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When you add a graphic to a border template, click the Lookup button to add a 

graphic variable. There are predefined variables for background and logo graphics. 

Use these if you have graphics in your catalogs with a property of graphic and a value 

of background or logo. If you want to specify a variable for a graphic property of a 

different value, choose ―Graphic‖ from the graphic lookup menu and replace the 

question marks in the Graphic field with a value you use in your photo data. When you 

apply the border to a photo, the application looks in the catalog for the graphic 

having the value you specified in the variable and applies it to the border. 

For example, you want to create a border for membership ID cards. Your catalogs 

contain a graphic with photo data of graphic=idcard. You want this border to use the 

graphic photo property of the value idcard, so you choose ―Graphic‖ from the graphic 

lookup menu and replace the question marks with idcard. Your catalog contains an ID 

card graphic, and its photo data indicates the graphic value is idcard. When you apply 

your ID card border to a photo, the application finds the graphic named idcard and 

applies it to the border. 

Query Variables 

You might want to create a border that searches for a photo or graphic of a certain 

Type value. When the search finds that photo or graphic in the current catalog, the 

application inserts the photo into the border. For example, you might have a group 

photo, like a team photo, in your catalog and you want it to always be applied to a 
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special border, like a memory mate. If the photo’s data has a property of type and a 

value of group, you can use a query in the border template that tells the application to 

find the photo of type ―group‖ when you open the border in the Photo Workshop. 

When the photo is found, the application applies the photo to the border.  

Note: If there is more than one photo in the catalog with the same type value, the 

application uses the first one it finds. Therefore, this feature is best used when you only 

have one photo of the type specified in the query. 

The Queries lookup contains common queries. To use these, you must use the same 

type value in your photo data as in the query you want to use. For example, if you use 

the query *Find Type=league and you do not use the type value ―league‖ in the photo 

data for any photos, the query will return no photos. 

Note: The query is not case sensitive. 

If you want to specify a query for a photo type other than those predefined, choose 

―Find‖ from the query lookup menu and replace the question marks with a type you use 

in your photo data. When you apply the border to a photo, the application looks in the 

catalog for a photo of the type you specified and adds it to the border. 

  



Troubleshooting 

 

300 

 

Troubleshooting 

If you are having problems with the network or software, read on for help. Click a link to 

jump directly to the help for a problem. 

Common status bar errors 

Can’t connect to a server or client station 

Can’t detect a printer or camera 

Can’t connect to the database 

Can’t access the photos folder 

Can’t find a portrait session 

Can’t send orders to print 

Common Status Bar Errors 
The status bar is located at the very bottom left of the software and will display to 

update you of any errors in the software. 

Print Queue Problem 

The print queue could not be started. It is possible that your print server is not set up, or 

that this client cannot connect to it. Click here to troubleshoot server connections. 

File Server Problem 

An error occurred while connecting to the file server. You may not be able to access 

pictures and customers until the conditions are corrected. It is possible that your data 

server is not set up, or that the client cannot connect to it to send and retrieve 

information. Click here to troubleshoot database connections. 
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Camera Not Detected 

Your camera has not been detected. Click here to troubleshoot camera problems. 

Can’t Connect to a Server or Client Station 
There are a few common reasons for not being able to connect to a station. Before 

reading this guide, click here for a walkthrough to setting up your network. 

Hardware Problems 

It is possible that there is a problem with your computer equipment: 

1. Ensure that every station is physically connected to the network, or that your 

wireless network is working properly. 

2. Try restarting all of the computer stations and your router/modem. 

3. Confirm that all stations are functioning and connected to your local area 

network. 

Permissions 

Your operating system permissions could be blocking the stations from accessing each 

other.  

1. Ensure that you have administrative access to the server computer. 

2. You will need to enable file sharing, share photo folders, and disable your firewall 

on the server computer. You can perform these functions in the software by 

navigating to Manage Studio > Options > Network Options and selecting Server 

Computer from the left side of the software. 

3. Select Enable File Sharing. 

a. For Windows XP: Follow the Network Setup Wizard to enable file sharing on 

your network. You will need to restart your computer before this takes 

effect. 

b. For Windows Vista: The Network and Sharing Center window appears. Turn 

On the following options: Network discovery, File sharing, Public folder 

sharing, and Printer sharing. Select X to exit this window when finished.  
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c. You may also want to disable User Account Control (UAC) in Vista to 

eliminate recurring password and permission prompts. To do this: 

i.  Open the Control Panel and under User Account and Family 

Safety, select Add or remove user accounts. 

ii. Select Go to the main User Accounts page and select Change 

security settings. 

iii. Click to unselect the box next to Use UAC to help protect your 

computer. 

iv. Select OK. UAC is now disabled. 

2. Select Share Photo Folder. 

a. For Windows XP: Select the Sharing tab, and select Share this folder on the 

network. The Share Name should be Photos. Select Allow network users to 

change my files. Select Apply. Select OK. 

b. For Windows Vista: Once you have enabled File Sharing, the Photos folder 

is automatically shared as a subfolder. If you wish to share the folder 

manually, you can disable sharing of public folders and enable sharing 

specifically on your photos folder only by right-clicking on it and selecting 

Share and allowing all users on your network.  

3. Select Disable Firewall. 

a. For Windows XP: The Windows Firewall window appears. Select to turn the 

firewall off, or to enable Studio Solution as an exception. To do this, select 

the Exceptions tab and select Add Program. Select Studio Solution and 

select OK. 

b. For Windows Vista: The Windows Firewall window appears. Select to turn 

the firewall off, or to enable Studio Solution as an exception. To do this, 

select the Exceptions tab and select Add Program. Select Studio Solution 

and select OK. 

4. Select Apply. 

Testing the Server 

Once the hardware, network connection, and your server settings have been verified, 

go to one of your client stations to test the server connection: 
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1. Go to a client computer and navigate to Manage Studio > Options > Network 

Options and select Client Computer from the left side of the software. 

2. Ensure that the Server Name, IP address, and Workgroup are all accurate. 

a. You must be in the same Workgroup to connect to the server computer. 

3. Select Test Server to locate the server computer. 

4. If the test fails, select Manually specify the computer name of the server 

computer and enter the server name or IP address of the server computer. 

5. Select Test Server to manually locate the server computer. 

6. If the test fails, ensure that you have followed all of the steps in both Setting Up 

Your Network and Troubleshooting. 

7. Restart your computers to reset the connection, repeat the steps. 

8. Contact customer care if the problem persists. 

Testing the Clients 

Once the hardware, network connection, and your server and client settings have 

been verified, return to the server computer to view the connected clients. 

1. Go to the server computer and navigate to Manage Studio > Options > Network 

Options and select Server Computer from the left side of the software. 

2. Ensure that the Server Name, IP address, and Workgroup are all accurate. 

a. You must be in the same Workgroup to view client computers. 

3. Select View Clients to locate client computers. 

4. If no clients are active, ensure that you have followed all of the steps in both 

Setting Up Your Network and Troubleshooting. 

5. Restart your computers to reset the connection, repeat the steps. 

6. Contact customer care if the problem persists. 

Can’t Detect a Printer or Camera 
There are a few common reasons for not being able to detect a printer or camera. 

Before reading this guide, click here for a walkthrough to setting up your printers and 

cameras. 
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Hardware Problems 

It is possible that there is a problem with your equipment: 

1. Ensure that the printer or camera is turned on. 

2. Ensure that you have properly connected the printer or camera to the 

computer. 

3. If Windows cannot recognize the device, Studio Solution will not be able to 

detect it. 

Canon Printer Help 

Canon printers should be automatically detected in the software. To view detected 

printers, navigate to Manage Studio > Printers and view the printer list. 

 

 

 

If your printer is not detected: 

1. Ensure that your printer is turned on and connected to the computer. 

2. Select [Add Canon iPF Printer]. 

3. If the printer is still not detected, look for it as a Windows Printer. 

4. Select [Add Printer using standard Windows Driver]. 

5. If the printer is still not detected, use Canon’s printer troubleshooting. 

6. Select Troubleshoot Printer issues. 

7. If the problem persists, select Contact Canon Service Center. 
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Canon Camera Help 

Canon cameras should be automatically detected in the software. To view detected 

cameras, navigate to Manage Studio > Cameras. 

If your camera does not appear below. Select Camera Type: 

1. Ensure that your camera is turned on and connected to the computer. 

2. Select Detect Camera. 

3. If the printer is still not detected, use Canon’s camera troubleshooting. 

4. Select Troubleshoot Camera Issues. 

5. If the problem persists, select Contact Canon Service Center. 

Can’t Connect to the Database 
Your network will share information between stations through a database. If your client 

and server station are not connected, view this help guide.  

If your client station is connected to the server but cannot access the database: 

1. Go to your server computer. 

2. Navigate to Manage Studio > Options > Network Options. 

3. Select Server Computer from the left side of the software. 

4. View Database Connection and ensure it is the correct database. 

a. Use Select Database to edit SQL database options. 

5. Select Apply. 

6. Return to the client computer. 

7. Navigate to Manage Studio > Options > Network Options. 

8. Select Client Computer from the left side of the software. 

9. Select Test Server to reconnect to the database. 

10. The Database Connection should change from Not Connected to Connected. 
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Can’t Access the Photos Folder 
Your network will share photos between stations. If your client and server station are not 

connected, view this help guide.  

If your client station is connected to the server but cannot access the Photos folder: 

1. Go to your server computer. 

2. Navigate to Manage Studio > Options > Network Options. 

3. Select Server Computer from the left side of the software. 

4. View the Photos Folder address and ensure it is the correct location. 

a. Select Browse Folders to change the Photos folder. 

5. Select Share Photo Folder. 

a. For Windows XP: Select the Sharing tab, and select Share this folder on the 

network. The Share Name should be Photos. Select Allow network users to 

change my files. Select Apply. Select OK. 

b. For Windows Vista: Once you have enabled File Sharing, the Photos folder 

is automatically shared as a subfolder. If you wish to share the folder 

manually, you can disable sharing of public folders and enable sharing 

specifically on your photos folder only by right-clicking on it and selecting 

Share and allowing all users on your network.  

6. Select Apply. 

7. Return to the client computer. 

8. Navigate to Manage Studio > Options > Network Options. 

9. Select Client Computer from the left side of the software. 

10. Select Test Server to reconnect to the Photos folder. 

11. The Server Photos Folder status should change from Not Connected to 

Connected. 

Can’t Find a Portrait Session 
If you cannot find a particular catalog or photo group, follow these steps to locating it: 
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1. Select the Photo Library tab from the bottom of the software. 

2. If you created the session through the Manage Studio tab, it will automatically 

be saved in the Portraits tree. 

a. Select Portrait from the Catalog Menu. 

b. Search for your event by customer name, listed last name first. 

3. To search for a catalog, select Find above the catalog list. Enter the text and 

type to search for, and select whether to search archived photos.  

4. If the photo event is not in the Catalog Menu or archived, it is possible that it has 

been deleted. 

Can’t Send Orders to Print 
If an order in the Orders workspace will not print: 

1. Ensure that the target printer is turned on and connected to the network. 

a. Click here to troubleshoot printer and network options. 

2. It is possible that you have created an order containing print items or sizes that 

your printer cannot produce. 

3. It is possible that your print job has been suspended. 

a. Select Print Queue from the top of the Orders workspace. 

b. Select the Pending Jobs tab. 

c. Select the job you want to print. 

d. Select Resume Print Job from the left side of the window. 

e. Select return to the order page. 

4. If the order has not resumed printing, select Refresh from the top of the Orders 

Workspace. 

5. Select your job and select print order. 
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Reference 

So far, this manual has listed all the tools and guides, sorted by types. This section will 

provide a quick-reference for the more complicated workspaces in the software, with 

screenshots and buttons listed by where they appear in your window with a brief 

description.  

For detailed information on any button in the software, you should use the Table of 

Contents or Index to locate the correct chapter for using that tool, but if you’re having 

trouble finding a button or an effect, or just want to know what a button does, continue 

reading. 

Select a specific workspace to jump ahead to that section: 

Photo Library Reference 

Shopping Cart Reference 

Orders Workspace Reference 

Presentation Mode Reference 

Photo Workshop Reference 

Border Workshop Reference 

For help with general reading, every reference guide will start at the top of the 

software, detailing the top-most menu bar, and will work down the page left to right. 

Each menu on the screen will list brief descriptions of the functions contained. 
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Photo Library Reference 
Find the Photo Library by clicking the Photo Library tab at the bottom of the software. 

 

 

 

Below are the menus for the Photo Library. Click a specific menu to jump ahead to that 

section: 

 

Top Photo Viewer Menu Top Catalog 

Menu 

Bottom Catalog 

Menu 

Bottom Photo Viewer 

Menu 

Shopping 

Cart 



Reference: Photo Library 

 

310 

 

Top Catalog Menu 

Top Photo Viewer Menu 

Bottom Catalog Menu 

Bottom Photo Viewer Menu 

Right-Clicking a Catalog 

Right-Clicking a Photo 

 

Top Catalog Menu 

 

 

 

Catalogs: 

 Catalog Info: information specific to the catalog can be entered here. 

 Remove Catalogs: delete selected catalogs. 

 Publish Catalogs: publish selected catalogs to your online. 

 UnPublish Catalogs: remove selected catalogs from your online storefront. 

 Quick Archive: quickly store backups of photos for the selected catalog. 

 Archive To: back up and archive the selected catalog to a root folder. 

 Quick Unarchive: quickly unarchive photos for the selected catalog. 

 Unarchive From: select a location and event to unarchive photos from. 

 Reset Photo Numbers: reset all photo numbers from a specified starting number. 

 Set Starting Photo Number: set a starting number for all new imported photos. 

 Refresh: refresh all catalogs. 
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Sort: 

 Sort Catalogs by Time: sort catalogs by time and date of the event. 

 Sort Catalogs by Name: sort catalogs by the event name. 

 Sort Catalog in Ascending Order: sort catalogs by time in chronological order or 

by name in alphabetical order. 

 Sort Catalog in Descending Order: sort catalogs by time in reverse-chronological 

order or by name in reverse-alphabetical order. 

View: 

 View Catalogs Default: view catalogs by software default view. 

 View Catalogs By Date: view catalogs by time and date of the event. 

 View Catalogs Alphabetically: view catalogs in alphabetical order. 

 View Catalogs By Type: view catalogs by the event type. 

 Arrange Catalogs: 

 

o Arrange Catalogs By Day: organize all catalogs by days. 

o Arrange Catalogs By Week: organize all catalogs by week. 

o Arrange Catalogs By Month: organize all catalogs by month. 

o Arrange Catalogs into 4 groups: organize catalogs alphabetically into 4 

groups. 

o Arrange Catalogs into 6 groups: organize catalogs alphabetically into 6 

groups. 

o Arrange Catalogs into 26 groups: organize catalogs alphabetically into 26 

groups. 

 

 Show Number of Catalogs: show the number of catalogs per catalog type. 

 Show Catalog ID: show the event ID information in the catalog name. 

 Show Archived Catalogs: view only archived catalogs. 



Reference: Photo Library 

 

312 

 

Top Photo Viewer Menu 

 

 

 

Photos: 

 

 Rename Photo: rename selected photo. 

 Describe Photo: add photographer note to selected photo. 

 Remove Photo: delete selected photo. 

 Hide Photo(s): do not publish the selected photo when publishing the catalog. 

 Hide Hidden Photos: do not display the hidden photos selected when viewing 

the catalog. 

 Hide 1 Star Photo: do not display photos rated with one star. 

 Rate Photo: assign a 1 to 5 star rating to selected photo. 

 Orient Photo: set the orientation of the selected photo. 

 Service Notes: view and edit services to be applied to selected photo. 

 Edit Shipping Info: view and edit billing and shipping information for customer. 

 Select All: select all photos in the catalog. 

 Deselect All: deselect all photos in the catalog. 

 Refresh: refresh photos in the catalog. 

 Open Containing Folder: open and view the location containing the selected 

photo. 

 Copy Path to Clipboard: copy the folder location of the selected photo to the 

clipboard. 

 Properties: view and edit photo properties, notes, and data. 
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Attributes: 

 Save Attributes To: 

o Clipboard: save current photo settings to the clipboard. 

o System Defaults: save current photo settings as system defaults. 

o Catalog Defaults: save current photo settings as catalog defaults. 

o Custom 1 – 4: save current photo settings as custom settings 1 – 4. 

o New: create a new custom setting for saving attributes to. 

o Edit: edit any custom settings you’ve created for saving attributes to. 

 

 Apply Attributes From: 

o Clipboard: apply photo settings from the clipboard to the selected photo. 

o System Defaults: apply the system default photo settings to the selected 

photo. 

o Catalog Defaults: apply the catalog default photo settings to the selected 

photo. 

o Custom 1 – 4: apply custom photo settings 1 – 4 to the selected photo. 

 Apply to All From: 

o Current: apply the selected photo settings to all photos in the catalog. 

o System Defaults: apply the system default photo settings to all photos in 

the catalog. 

o Catalog Defaults: apply the catalog default photo settings to all photos in 

the catalog. 

o Custom 1 – 4: apply custom photo settings 1 – 4 to all photos in the 

catalog. 

Sort: 

 Sort Photos by Rating: sort by your assigned 1 to 5 star rating.  

 Sot Photos by Time: sort by the time assigned to the photo. 

 Sort Photos by Photo Number: sort by the assigned photo numbers.  

 Sort Photos by Filename: sort by the photo filename. 
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 Sort Photos by Full Pathname: sort by the entire computer pathname. 

 Sort Photos by File Size: sort by file size. 

 Sort Photos by Published: sort by published and unpublished. 

 Sort Photos by Archived: sort by archived and unarchived. 

 Sort Photos by Exif Comment: sort by Exchangeable Image File information. 

 Sort Photos by Sort by Custom: manually click and drag photos to their positions. 

 Sort Photos in Ascending Order: sort by the previous criteria in ascending order. 

 Sort Photos in Descending Order: sort by the previous criteria in descending 

order. 

View: 

 Show Photo Filenames: show filenames under each photo. 

 Show Photo Icons: show information icons above each photo. 

 Show Photo Number: show the photo number under each photo. 

 Show Photo Rating: show the 1 – 5 star rating above each photo. 

 Show Hidden Photos: show photos hidden from publishing. 

 View Photo Thumbnails: view photos as thumbnails. 

 View Photo Filename List: view photos as filenames in a list. 

 View Photo Info List: view photos as a detailed list of information. 

 Display Thumbnails: display photo thumbnails in five sizes. 

 High Quality Preview: view a higher resolution preview of photos. 

Bottom Catalog Menu 
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New Catalog: 

 Create New & Import: check to create and import photos when adding a 

catalog or event. 

 Add Photo Group to event: add a photo group to the selected event. 

 Add Photo Catalog: add a photo catalog to the selected catalog type. 

 Add Portfolio: create a portfolio for using on your online storefront. 

 Find: search for selected catalogs using a search string and method.  

 Info: view and edit information for the selected catalog. 

Bottom Photo Viewer Menu 

 

 

 

Add Photo: import photos into the selected event. 

Find: search for selected photos within the catalog using a search string and method. 

Orient:  

 Arrows: click to rotate selected photo 90° clockwise and counter-clockwise, 

respectively. 

 Vertical: orient selected photo vertically. 

 Horizontal: orient selected photo horizontally. 

 Vertical Flipped: orient selected photo vertically and flipped 180°. 

 Horizontal Flipped: orient selected photo horizontally and flipped 180°. 

 Rotate Clockwise: rotate selected photo 90° clockwise. 

 Rotate Counter Clockwise: rotate selected photo 90° counter clockwise. 

 Flip: flip selected photo 180°. 
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 Set Crop Orientation: 

o Auto: let the software decide to crop selected photo vertically or 

horizontally. 

o Vertical: crop selected photo vertically. 

o Horizontal: crop selected photo horizontally. 

 Set Default Orientation: 

o Vertical: set selected photo with vertical orientation as default. 

o Horizontal: set selected photo with horizontal orientation as default. 

o Vertical Flipped: set selected photo with vertical orientation flipped 180°. 

o Horizontal Flipped: set selected photo with horizontal orientation flipped 

180°. 

 Set Tilt Angle: set a custom tilt angle for selected photo. 

Enhance: open selected photo in the Photo Workshop for editing. 

Preview: view selected photo as a fullscreen preview with slideshow options. 

Publish:  

 Publish Selected: publish selected photo to your online storefront. 

 UnPublish Selected: remove selected photo from your online storefront. 

 Batch Publish: publish a number of selected photos to your online storefront. 

 Batch UnPublish: remove a number of selected photos from your online 

storefront. 

Copy: copy and paste selected photo to a new file location. 

Batch: create a batch order from all or select photos in the catalog. 

Proof: create a proof template for all or select photos in the catalog. 

Order: show or hide the shopping cart. 

Right-clicking a Catalog 

View: 
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 Sort Catalogs by Time: sort catalogs by time and date of the event. 

 Sort Catalogs by Name: sort catalogs by the event name. 

 Sort Catalog in Ascending Order: sort catalogs by time in chronological order or 

by name in alphabetical order. 

 Sort Catalog in Descending Order: sort catalogs by time in reverse-chronological 

order or by name in reverse-alphabetical order. 

 View Catalogs by Default: view catalogs by software default view. 

 View Catalogs By Date: view catalogs by time and date of the event. 

 View Catalogs Alphabetically: view catalogs in alphabetical order. 

 View Catalogs By Type: view catalogs by the event type. 

 Arrange Catalogs:  

o Arrange Catalogs By Day: organize all catalogs by days. 

o Arrange Catalogs By Week: organize all catalogs by week. 

o Arrange Catalogs By Month: organize all catalogs by month. 

o Arrange Catalogs into 4 groups: organize catalogs alphabetically into 4 

groups. 

o Arrange Catalogs into 6 groups: organize catalogs alphabetically into 6 

groups. 

o Arrange Catalogs into 26 groups: organize catalogs alphabetically into 26 

groups. 

 Publish Catalogs: Publish Catalogs: publish selected catalogs to your online 

storefront. 

 UnPublish Catalogs: remove selected catalogs from your online storefront. 

 New Portfolio: create a portfolio for your online storefront. 

 Add Photo(s): adding photos to a catalog 

 Quick Archive: Quick Archive: quickly store backups of photos for the selected 

catalog. 

 Archive To: back up and archive the selected catalog to a root folder. 

 Quick Unarchive: quickly unarchive photos for the selected catalog. 

 Unarchive From: select a location and event to unarchive photos from. 
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 Open Containing Folder: open and view the location containing the selected 

photo. 

 Copy Path to Clipboard: copy the folder location of the selected photo to the 

clipboard. 

Right-clicking a Photo 

View: 

 Sort Catalogs by Time: sort catalogs by time and date of the event. 

 Sort Catalogs by Name: sort catalogs by the event name. 

 Sort Catalog in Ascending Order: sort catalogs by time in chronological order or 

by name in alphabetical order. 

 Sort Catalog in Descending Order: sort catalogs by time in reverse-chronological 

order or by name in reverse-alphabetical order. 

 View Catalogs by Default: view catalogs by software default view. 

 View Catalogs By Date: view catalogs by time and date of the event. 

 View Catalogs Alphabetically: view catalogs in alphabetical order. 

 View Catalogs By Type: view catalogs by the event type. 

 Arrange Catalogs:  

o Arrange Catalogs By Day: organize all catalogs by days. 

o Arrange Catalogs By Week: organize all catalogs by week. 

o Arrange Catalogs By Month: organize all catalogs by month. 

o Arrange Catalogs into 4 groups: organize catalogs alphabetically into 4 

groups. 

o Arrange Catalogs into 6 groups: organize catalogs alphabetically into 6 

groups. 

o Arrange Catalogs into 26 groups: organize catalogs alphabetically into 26 

groups. 

 Remove Photo: delete the selected photo. 

 Hide from Publishing: do not publish the selected photo when publishing the 

catalog. 
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 Rename Photo: rename selected photo. 

 Orient Photo: options listed here. 

 Rate Photo: assign a 1 to 5 star rating to selected photo. 

 Describe Photo: add photographer note to selected photo. 

 Service Notes: Service Notes: view and edit services to be applied to selected 

photo. 

 Edit Shipping Info: view and edit billing and shipping information for customer. 

 Select All: select all photos in the catalog. 

 Deselect All: deselect all photos in the catalog. 

 Refresh: refresh photos in the catalog. 

 Open Containing Folder: open and view the location containing the selected 

photo. 

 Copy Path to Clipboard: copy the folder location of the selected photo to the 

clipboard. 

 Properties: view and edit photo properties, notes, and data. 
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Shopping Cart Reference 
Find the Shopping Cart in the Photo Library, Photo Workshop, and Presentation Mode, 

located on the right side of the software. 

Hiding and Showing Data and the Cart 

 Show Data: show photo data for the selected photo, including notes and EXIF 

information. 

 Hide Data: hide photo data. 

 Show Cart: display the shopping cart. 

 Hide Cart: hide the shopping cart. 

 Hide Packages: hide the package window of the shopping cart. 

Shopping Cart Options 

 Package List 1 – 9: list of the packages contained in the current package group. 

 Previous: view the previous packages or package group. 

 More: view more packages or the next package group. 

 Place Order: send the selected order to print. 

 Save Order: save the order in the orders workspace. 

 Copies: select the number of packages for the selected item. 

 Add: add or edit services for the selected item. 

 Add Package: list of packages in the current package group. 

o Change Default Group: select a new package group to display in the 

shopping cart. 

 Change Cropping: switch cropping of the selected photo between vertical and 

horizontal. 

 Clear Order: clear the shopping cart of all items. 

 Remove Item: remove the selected item from the shopping cart. 
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Right-clicking an Item in the Shopping Cart 

 Remove Item: remove the selected item from the shopping cart. 

 Remove Package: remove the selected package from the shopping cart. 

 Clear Order: clear the shopping cart of all items. 

 Show Prices: check to display package prices in the shopping cart. 

 Service Notes: view and edit services to be applied to selected photo. 

 Edit Shipping Info: view and edit billing and shipping information for customer. 

 Change Media: change the printing media for the selected item. 

 Change Print Commands: change the printing instructions for the selected item. 

 Open Containing Folder: open and view the location containing the selected 

photo. 

 Copy Path to Clipboard: copy the folder location of the selected photo to the 

clipboard. 
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Orders Workspace Reference 
Find the Orders Workspace by clicking the Orders tab at the bottom of the software. 

 

 

 

Below are the menus for the Orders Workspace. The menus in the New Orders, Pending 

Orders, and Completed Orders tab are identical. Click a specific menu to jump ahead 

to that section: 

Bottom 

Menu 

Top Menu 
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Top Menu 

Bottom Menu 

Right-clicking an Order 

Top Menu 

 

 

 

 Auto Print: check to enable and automatically print new orders. 

 Print Queue: view and organize the order of printing and suspend or resume print 

jobs. 

 View (only available for Completed Orders): select a time period to view orders 

of that age. 

 Refresh: refresh all orders. 

Bottom Menu 

 

 

 

 Find Orders: find an order by Order ID. 

 Delete Order: delete the selected order. 

 Mark Order Shipped: mark the order as printed and shipped and send it to the 

Completed Orders tab. 

 Edit & Proof Order: open the order in the Edit & Proof workspace. 
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 Print Order Proof: print a proof page of selected order. 

 Print Order Form: print a copy of the order form and information. 

 Print Order: send selected order to print. 

 Print All Orders: send all new orders to print. 

 Print to CD: print the order information on a CD to be delivered to a lab. 

 Cancel Print: cancel printing the selected order. 

Right-clicking an Order 

 Print Order: send selected order to print. 

 Print All Orders: send all new orders to print. 

 Print to CD: print the order information on a CD to be delivered to a lab. 

 Mark Order Shipped: mark the order as printed and shipped and send it to the 

Completed Orders tab. 

 Edit & Proof Order: open the order in the Edit & Proof workspace. 

 Batch Orders: group all selected orders together as one print order. 

 Unbatch Order: unbatch all selected orders to be individual print orders. 

 Print Simple Receipt: print a quick and simple text receipt for records. 

 Find Order: find an order by Order ID. 

 Delete Order: delete the selected order. 

 Print Order Proof: print a proof page of selected order. 

 Print Order Form: print a copy of the order form and information. 
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Presentation Mode Reference 
Find Presentation Mode by selecting the Client Presentation tab at the bottom of the 

software while viewing a photo catalog in either the Photo Library or Photo Workshop. 

 

 

Top Menu 

 

 

Top Menu 
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Compare: lock selected photo while navigating the catalog to compare other photos 

with it. 

Stars: select a 1 to 5 star rating for selected photo. 

Rating: select a 1 to 5 star rating for selected photo. 

Sort: 

 Sort Photos by Rating: sort by your assigned 1 to 5 star rating.  

 Sort Photos by Time: sort by the time assigned to the photo. 

 Sort Photos by Photo Number: sort by the assigned photo numbers.  

 Sort Photos by Filename: sort by the photo filename. 

 Sort Photos by Full Pathname: sort by the entire computer pathname. 

 Sort Photos by File Size: sort by file size. 

 Sort Photos by Published: sort by published and unpublished. 

 Sort Photos by Archived: sort by archived and unarchived. 

 Sort Photos by Exif Comment: sort by Exchangeable Image File information. 

 Sort Photos by Custom: manually click and drag photos to their positions. 

 Sort Photos in Ascending Order: sort by the previous criteria in ascending order. 

 Sort Photos in Descending Order: sort by the previous criteria in descending 

order. 

Fullscreen: view selected photo as a fullscreen preview with slideshow options. 

Music:  

 Off: check to turn off music. 

 Play Music Folder: select a music folder from the list with files to play and loop 

automatically. 

 Choose Music Folder: select a music folder to play and loop all files. 

 Choose Music File: select a single music file to play and loop. 
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Orientation: 

 Vertical: orient selected photo vertically. 

 Horizontal: orient selected photo horizontally. 

 Vertical Flipped: orient selected photo vertically and flipped 180°. 

 Horizontal Flipped: orient selected photo horizontally and flipped 180°. 

 Rotate Clockwise: rotate selected photo 90° clockwise. 

 Rotate Counter Clockwise: rotate selected photo 90° counter clockwise. 

 Flip: flip selected photo 180°. 

 Set Crop Orientation: 

o Auto: let the software decide to crop selected photo vertically or 

horizontally. 

o Vertical: crop selected photo vertically. 

o Horizontal: crop selected photo horizontally. 

 Set Default Orientation: 

o Vertical: set selected photo with vertical orientation as default. 

o Horizontal: set selected photo with horizontal orientation as default. 

o Vertical Flipped: set selected photo with vertical orientation flipped 180°. 

o Horizontal Flipped: set selected photo with horizontal orientation flipped 

180°. 

 Set Tilt Angle: set a custom tilt angle for selected photo. 

View: 

 1 – 12 Photos: view 1 – 12 photos in the workspace at one time. 

 View Less Photos: view less photos in the workspace at one time. 

 View More Photos: view more photos in the workspace at one time. 

 Show Filenames: show filenames below each photo. 

 Show Photo Numbers: show photo numbers below each photo. 

 Viewing Aspect: select the photo viewing aspect from your preset list of aspects. 

 High Quality Preview: view higher resolution images for photo previews. 
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Photo Workshop Reference 
Find the Photo Workshop by clicking the Photo Workshop tab at the bottom of the 

software. 

 

 

 

 

Top Menu 

Catalog 

Menu 
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Below are the menus for the Photo Workshop. Toolsets are not listed here, but are 

detailed here in order of appearance in the software.  Click a specific menu to jump 

ahead to that section: 

Top Menu 

Catalog Menu 

Right-clicking a Photo 

Top Menu 

 

 

 

Single: view one photo at a time in the workspace. 

Multiple: view all of the photos in the selected catalog in the workspace. 

Photos: 

 Import: add photos to the selected catalog. 

 Quick Import: automatically add photos from a preselected folder. 

 Quick Import Setup: select a folder for quick importing. 

Attributes: 

 Save To: 

o Clipboard: save current photo settings to the clipboard. 

o System Defaults: save current photo settings as system defaults. 

o Catalog Defaults: save current photo settings as catalog defaults. 

o Custom 1 – 4: save current photo settings as custom settings 1 – 4. 

o New: create a new custom setting for saving attributes to. 

o Edit: edit any custom settings you’ve created for saving attributes to. 
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 Apply From: 

o Clipboard: apply photo settings from the clipboard to the selected photo. 

o System Defaults: apply the system default photo settings to the selected 

photo. 

o Catalog Defaults: apply the catalog default photo settings to the selected 

photo. 

o Custom 1 – 4: apply custom photo settings 1 – 4 to the selected photo. 

 Apply to All in Catalog: 

o Current: apply the selected photo settings to all photos in the catalog. 

o System Defaults: apply the system default photo settings to all photos in 

the catalog. 

o Catalog Defaults: apply the catalog default photo settings to all photos in 

the catalog. 

o Custom 1 – 4: apply custom photo settings 1 – 4 to all photos in the 

catalog. 

 Service Notes: view and edit services for selected photo. 

 Reset Current: reset selected photo to previous attributes. 

 Reset System Defaults: reset selected photo to system default photo attributes. 

Sort: 

 Sort Photos by Rating: sort by your assigned 1 to 5 star rating.  

 Sort Photos by Time: sort by the time assigned to the photo. 

 Sort Photos by Photo Number: sort by the assigned photo numbers.  

 Sort Photos by Filename: sort by the photo filename. 

 Sort Photos by Full Pathname: sort by the entire computer pathname. 

 Sort Photos by File Size: sort by file size. 

 Sort Photos by Published: sort by published and unpublished. 

 Sort Photos by Archived: sort by archived and unarchived. 

 Sort Photos by Exif Comment: sort by Exchangeable Image File information. 

 Sort Photos by Sort by Custom: manually click and drag photos to their positions. 
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 Sort Photos in Ascending Order: sort by the previous criteria in ascending order. 

 Sort Photos in Descending Order: sort by the previous criteria in descending 

order. 

View: 

 Clear: clear the workspace of all photos. 

 Front: if your photo has a front and back, display the front. 

 Back: if your photo has a front and back, display the back. 

 Viewing Aspect: select the photo viewing aspect from your preset list of aspects. 

 Setup Aspect Ratio List: setup a list of aspect ratios. 

 Frame: view a white, black, or gray frame around photos in the workspace. 

 Soft Proof with Printer Profile: select to copy a printer profile for viewing more 

accurate colors. 

 High Quality Previews: view higher resolution images for photo previews. 

 Show Photo Numbers: show photo numbers below each photo. 

 Show Make Editable Dialog: check to prompt you to make saved photos 

editable in the future. 

 Guides: 

o Show Guides: show guidelines to help center photos. 

o School: standard school portrait guide with face bubble and aspect 

ratios. 

o Standard: show centering line and aspect ratios. 

 Paper Textures: select a texture to be applied to all photos in the workspace: 

o Polished, Satin, Canvas, Velvet, Watercolor, Glossy, Heavy Canvas. 

Fullscreen: view selected photo as a fullscreen preview. 

View Hidden: view hidden photos. 

Catalog Menu 
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 Slideshow: view all photos as a fullscreen slideshow. 

 Sort Photos: 

o Sort Photos by Rating: sort by your assigned 1 to 5 star rating.  

o Sort Photos by Time: sort by the time assigned to the photo. 

o Sort Photos by Photo Number: sort by the assigned photo numbers.  

o Sort Photos by Filename: sort by the photo filename. 

o Sort Photos by Full Pathname: sort by the entire computer pathname. 

o Sort Photos by File Size: sort by file size. 

o Sort Photos by Published: sort by published and unpublished. 

o Sort Photos by Archived: sort by archived and unarchived. 

o Sort Photos by Exif Comment: sort by Exchangeable Image File 

information. 

o Sort Photos by Custom: manually click and drag photos to their positions. 

o Sort Photos in Ascending Order: sort by the previous criteria in ascending 

order. 

o Sort Photos in Descending Order: sort by the previous criteria in 

descending order. 

 Show Photo Icons: show information icons above each photo. 

 Show Photo Rating: show 1 to 5 star rating below each photo. 

 Refresh Photos: refresh all photos in the current catalog. 

 Reset Photo Numbers: reset all photo numbers from a specified number. 

 Set Starting Photo Number: set a starting number for all new imported photos. 

 Set Capture Filenames: set filename options for all new imported photos. 

 Find Photo: find a photo with search string and method. 

 Find Next Photo: find next photo in the catalog with previous search criteria. 

 Find Previous Photo: find previous photo in the catalog with previous search 

criteria. 
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 Create New & Import: check to create and import photos when adding a 

catalog or event. 

 Create New:  

o Add Photo Group to event: add a photo group to the selected event. 

o Add Photo Catalog: add a photo catalog to the selected catalog type. 

o Add Portfolio: create a portfolio for using on your online storefront. 

Right-clicking a Photo 

 Remove Photo: delete the selected photo. 

 Rename Photo: change the name of the selected photo. 

 Describe Photo: assign a description to identify the photo. 

 Hide from Publishing: do not publish the selected photo when publishing the 

catalog. 

 Rename Photo: rename selected photo. 

 Orient Photo: options listed here. 

 Rate Photo: assign a 1 to 5 star rating to selected photo. 

 Orient Photo: select the photos orientation. 

 Describe Photo: add photographer note to selected photo. 

 Service Notes: Service Notes: view and edit services to be applied to selected 

photo. 

 Edit Shipping Info: view and edit billing and shipping information for customer. 

 Select All: select all photos in the catalog. 

 Deselect All: deselect all photos in the catalog. 

 Refresh: refresh photos in the catalog. 

 Open Containing Folder: open and view the location containing the selected 

photo. 

 Copy Path to Clipboard: copy the folder location of the selected photo to the 

clipboard. 

 Properties: view and edit photo properties, notes, and data. 
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Border Workshop Reference 
Find the Border Workshop by navigating to Manage Studio > Products > Templates and 

Composites and selecting New Template or Edit Template from the bottom of the 

software.  

 

 

 

  

Top Menu 

Left Toolbar 
Right 

Toolbar 
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Below are the menus for the Border Workshop. Click a specific menu to jump ahead to 

that section: 

Top Menu 

Left Toolbar 

Right Toolbar 

Right-clicking an Item 

Top Menu 

 

 

 

Front: if your border has a front and back, display the front. 

Back: if your border has a front and back, display the back or create a back. 

Add: 

 Photo: add a photo placeholder to the border. 

 Multiple Photos: add a photo composite placeholder to the border. 

 Graphic: add a graphic to the border. 

 Text: add text to the border. 

 Effect: add a selected effect to the border: 

o Brightness, Color, Darken, Duotone, Duotone Color, Grayscale, Invert RGB, 

Negate RGB, Overlay, Sepia, Saturation, Watermark, Antique, Blur. 

 Shape: add a selected shape to the border: 

o Arch, Circle, Diamond, Ellipse, Hear, Octagon, Rectangle, Star, Triangle. 

 Barcode: add a barcode to the border for storing information and scanning. 

 Line: add a line to the border. 
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 Save Custom Object: save a custom shape or graphic you created. 

 Edit Custom Objects: view and edit a list of custom shapes or graphics you 

created. 

 Add Custom Objects: view a list of and add one of the custom shapes or 

graphics you created. 

Edit: 

 Duplicate: copy and paste an exact duplicate of the item, including item 

description. 

 Cut: copy an item to the clipboard and delete it. 

 Copy: copy an item to the clipboard. 

 Paste: paste the current item from the clipboard. 

 Delete: delete the current item.  

 Select All: select all available border items. 

Options: 

 Show Grid: check to display a grid for aligning and snapping objects. 

 Grid Options: view a list of grid options for displaying and snapping objects. 

 Auto Alignment: automatically align objects to the grid. 

Undo and Redo: undo and redo the last step. 

Left Toolbar 

 Border Properties: view and edit border properties. 

 Add Photo: add a photo placeholder to the border. 

 Add Multiple Photos: add a photo composite placeholder to the 

border. 

 Add Graphic: add a graphic to the border. 

 Add Text: add text to the border. 

 Add Effect: add a selected effect to the border: 

o Brightness, Color, Darken, Duotone, Duotone Color, 

Grayscale, Invert RGB, Negate RGB, Overlay, Sepia, 



Reference: Border Workshop 

 

337 

 

Saturation, Watermark, Antique, Blur. 

 

 Duplicate: copy and paste an exact duplicate of the item, including item 

description. 

 Cut: copy an item to the clipboard and delete it. 

 Copy: copy an item to the clipboard. 

 Paste: paste the current item from the clipboard. 

 Delete: delete the current item.  

Right Toolbar 

 Item Properties: view and edit properties for selected item. 

 Font: view and edit font for selected item. 

 Fill & Fit Page: fit selected item to page edges. 

 Make Same: copy properties of another item. 

 Center: center item to page. 

 Align: align item edges to another item. 

 Space: space three or more items evenly. 

 Order: send an item back or bring an item forward in layers. 

 Rotate: rotate an item. 

 Select: selection mode for clicking items. 

 Pan: pan mode for examining items. 

 Zoom: zoom mode for zooming in and out. 

 Fit Page: zoom the current border to the page size. 

 Actual Size: view the current border in actual pixels. 

 Test Form: enter test text fields and queries that will appear when the border is 

applied. 

Right-clicking an Item 

 Properties: view and edit properties for selected item. 

 Lock Object: lock object so it cannot be selected or moved. 
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 Hide Object: hide object to view beneath it. 

 Link Object: link an object to move with other objects. 

 Cut: copy an item to the clipboard and delete it. 

 Copy: copy an item to the clipboard. 

 Paste: paste the current item from the clipboard. 

 Duplicate: copy and paste an exact duplicate of the item, including item 

description. 

 Delete: delete the current item.  

 Fill & Fit Page: fit selected item to page edges. 

 Make Same: copy properties of another item. 

 Center: center item to page. 

 Align: align item edges to another item. 

 Space: space three or more items evenly. 

 Order: send an item back or bring an item forward in layers. 

 Rotate: rotate an item. 

 Zoom: zoom mode for zooming in and out. 

 Set Test Photo: select a photo to view within a photo placeholder. 
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Shortcut Keys and Special Text 

There are a lot of options in Studio Solution, but fortunately there are a lot of shortcut 

keys for quickly accessing those options. Shortcut keys change depending on which 

part of the software you are in, so select a link below to view shortcut keys for that 

section: 

Orders Workspace Shortcut Keys 

Retouch Workshop Shortcut Keys 

Photo Library Shortcut Keys 

Slideshow Shortcut Keys 

Presentation Mode Shortcut Keys 

Photo Workshop Shortcut Keys 

Border Workshop Shortcut Keys 

 

For a table with all special text for photo data and queries, click here. 

Orders Workspace Shortcut Keys 

Key Description  Key Description 
CTRL F Find Order  F10 Photo Library Tab 

P Print Order  F11 Photo Workshop Tab 

CTRL P Print To CD  F2 Find Order 

ALT P Print All Orders  F5 New Orders Tab 

SHIFT+ P Print Order Form    

Q Print Queue  F6 Pending Orders Tab 
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Key Description  Key Description 
S Mark Order Shipped  F7 Completed Orders Tab 

DELETE Delete Order  F9 Manage Studio Tab 

ESCAPE Cancel Print  RETURN Edit and Proof Order 

Retouch Workshop Shortcut Keys 

Key Description  Key Description 
Page Up Zoom Out  [ Decrease Brush Size 

Page Down Zoom In  ] Increase Brush Size 

CTRL Y Redo   { Increase Feather  

CTRL Z Undo   } Decrease Feather 
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Photo Library Shortcut Keys 

Key Description  Key Description 

- 
View More Photos / Decrease 

thumbnail size 

 
V Vertical / Portrait Orientation  

+ 
View Less Photos / Increase thumbnail 

size 

 
DELETE Remove Photo 

0 Order ‘A La Carte’ item 
 

DIVIDE (/) 
Paste Photo Attributes from the 

Clipboard 

1 Add Package 1 to Cart  F1 Find Photo Catalog 

2 Add Package 2 to Cart  F9 Home 

3 Add Package 3 to Cart  F11 Photo Workshop Tab 

4 Add Package 4 to Cart  F12 Orders Tab 

5 Add Package 5 to Cart   F2 Find Photos 

6 Add Package 6 to Cart   F3 Find Next Photo 

7 Add Package 7 to Cart  Shift F3 Find Previous Photo 

8 Add Package 8 to Cart  F5 Refresh  

9 Add Package 9 to Cart  F7 Opens the Attribute Menu 

= 
View More Photos / Decrease 

thumbnail size 

 
MULTIPLY (*) 

Copy Photo Attributes to the 

Clipboard 

A Add Photo 

 
CTRL MULTIPLY 

(*) 

Save Advanced Custom 

Attribute window marked with 

current clipboard attributes 

CTRL A Select All  Num Pad 0 Order ‘A La Carte’ item 

C Create New Catalog in Catalog Wizard  Num Pad 1 Add Package 1 to Cart 

CTRL ALT C Clear Preview Cache   Num Pad 2 Add Package 2 to Cart 

D Catalog Info  Num Pad 3 Add Package 3 to Cart 
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Key Description  Key Description 
F Flip Orientation  Num Pad 4 Add Package 4 to Cart 

CTRL F Find Photos  Num Pad 5 Add Package 5 to Cart 

G 
Photo Group Information in Catalog 

Wizard 

 
Num Pad6 Add Package 6 to Cart 

H Horizontal / Landscape Orientation  Num Pad 7 Add Package 7 to Cart 

I Repeat Last Import  Num Pad 8 Add Package 8 to Cart 

CTRL I Import Single Photo  Num Pad 9 Add Package 9 to Cart 

SHIFT I Import Multiple Photo  RETURN Place Order 

O Clockwise Orientation   CTRL RETURN Save Order  

SHIFT O Counter-Clockwise Orientation 

 

SPACE 

Take Picture (Fire Cameras 

Shutter Release) or multiple 

import if no camera attached 

P Proof  TAB Move to next one photo 

SHIFT P Picture Properties  CTRL + TAB Picture Properties > Photo Data  

R Import Tethered Camera Pictures  SHIFT+ TAB Move back one photo 

CTRL R 
Rebuild Catalog Tree (use with caution, 

backup files first) 

 
[ Scroll photos up 
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Slideshow Shortcut Keys 

Key Description  Key Description 
CTRL C Crop Orientation: Horizontal  END Move to last photo 

ALT C Crop Orientation: Horizontal  ESCAPE Close  

SHIFT C Crop Orientation: Vertical  F1 Rating 1 Star 

F Flip  F2 Rating 2 Star 

SHIFT F Flip  F3 Rating 3 Star 

H Horizontal / Landscape Orientation  F4 Rating 4 Star 

L Horizontal / Landscape Orientation  F5 Rating 5 Star 

O Clockwise Orientation   HOME Move to first photo  

SHIFT O Counter Clockwise Orientation   LEFT Move one photo next 

P Vertical Flip  PAGE 

DOWN 

Move next one page 

V Vertical Orientation  PAGE UP Move prior one page 

DELETE Delete Photo  RIGHT Move one photo back 

DOWN Move to next photo  UP Move one photo back 
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Presentation Mode Shortcut Keys 

Key Description  Key Description 

+ 
View Less Photos / Increase thumbnail 

size 
 LEFT 

Moves to previous photo row, 

Enhance Presentation Mode: 

Move photo left 

= 
View Less Photos / Increase thumbnail 

size 
 Ctrl Left 

Moves to previous photo row, 

Enhance Presentation Mode: 

Move photo left in Largest 

Increments 

- 
View More Photos / Decrease thumbnail 

size 
 Shift Left 

Moves to previous photo row, 

Enhance Presentation Mode: 

Move photo left in Smallest 

Increments 

0 Order ‘A La Carte’ Item  PAGE DOWN Scale Out 

1 Add Package 1 to Cart  
CTRL PAGE 

DOWN 
Scale Out in Largest Increments 

2 Add Package 2 to Cart  
SHIFT PAGE 

DOWN 
Scale Out in Smallest Increments 

3 Add Package 3 to Cart  PAGE UP Scale In 

4 Add Package 4 to Cart  CTRL PAGE UP Scale In Largest Increments 

5 Add Package 5 to Cart   SHIFT PAGE UP Scale In Smallest Increments 

6 Add Package 6 to Cart   RIGHT 

Moves to next photo row, 

Enhance Presentation Mode: 

Move photo right 

7 Add Package 7 to Cart  CTRL RIGHT 

Moves to next photo row, 

Enhance Presentation Mode: 

Move photo right in Largest 

Increments 

8 Add Package 8 to Cart  SHIFT RIGHT 

Moves to next photo row, 

Enhance Presentation Mode: 

Move photo right in Smallest 

Increments 
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Key Description  Key Description 
9 Add Package 9 to Cart  TAB Moves to next photo 

O Clockwise Orientation   UP 
Moves user one photo 

before/up in catalog 

SHIFT O Counter Clockwise Orientation  CTRL UP 

Moves one “row “ back/up in 

the catalog. In editing mode, 

moves Image UP in Larger 

Increments 

DELETE Remove Photo  SHIFT UP 

Moves one “row” back/up in the 

catalog. In editing mode, moves 

Image UP in Smaller Increments 

DOWN 
Move to next photo, Enhance 

Presentation Mode: Move photo down 
 F1 Photo Rating 1 Star. 

CTRL 

DOWN 

Enhance Presentation Mode: Move 

photo down in Largest Increments 
 F2 Photo Rating 2 Star. 

SHIFT 

DOWN 

Enhance Presentation Mode: Move 

photo down in Smallest Increments 
 F3 Photo Rating 3 Star. 

END Moves to last photo in catalog  F4 Photo Rating 4 Star. 

Home Moves to first photo in the catalog.  F5 Photo Rating 5 Star. 
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Photo Workshop Shortcut Keys 

Key Description  Key Description 
0 Order ‘A La Carte’ Item  F8 Drop Out Tab 

1 Add Package 1 to Cart  F9 Home 

2 Add Package 2 to Cart  Home Border On 

3 Add Package 3 to Cart  INSERT Picture Properties > Photo Data 

4 Add Package 4 to Cart  LEFT Move Photo Left 

5 Add Package 5 to Cart  
 

CTRL LEFT 
Move Photo Left in largest 

increments 

6 Add Package 6 to Cart  
 

SHIFT LEFT 
Move Photo left in smallest 

increments 

7 Add Package 7 to Cart 
 

MULTIPLY (*) 
Copy Photo Attributes to the 

Clipboard 

8 Add Package 8 to Cart 

 
CTRL MULTIPLY 

(*) 

Save Advanced Custom 

Attribute window marked with 

current clipboard attributes 

9 Add Package 9 to Cart 

 

ALT+ MULTIPLY 

Save Advanced Custom 

Attribute window for NEW 

custom 

= 
View More Photos / Decrease 

thumbnail size 

 
PAGE DOWN 

Scale Out 

A Save as New Photo 
 CTRL+ PAGE 

DOWN 

Scale Out in largest increments 

CTRL A Select All 
 SHIFT+ PAGE 

DOWN 

Scale Out in smallest increments 

B Choose Border  Num Pad 0 Order ‘A La Carte’ Item 

CTRL C Crop Orientation: Horizontal  Num Pad 1 Add Package 1 to Cart 

SHIFT C Crop Orientation: Vertical  Num Pad 2 Add Package 2 to Cart 
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Key Description  Key Description 
F Flip Orientation  Num Pad 3 Add Package 3 to Cart 

CTRL F Find Photos  Num Pad 4 Add Package 4 to Cart 

H Horizontal / Landscape Orientation  Num Pad 5 Add Package 5 to Cart 

I Repeat Last Import  Num Pad6 Add Package 6 to Cart 

CTRL I Import Single Photo  Num Pad 7 Add Package 7 to Cart 

SHIFT I Import Multiple Photo  Num Pad 8 Add Package 8 to Cart 

K Get Express Color Code  Num Pad 9 Add Package 9 to Cart 

O Clockwise Orientation  PAGE UP Scale In 

SHIFT O Counter Clockwise Orientation  CTRL PAGE UP Scale In largest increments 

P Proof  SHIFT PAGE UP Scale in smallest increments 

SHIFT P Picture Properties  RETURN Place Order 

R Import Camera Images   CTRL RETURN Save Order  

S Save Changes  RIGHT Move Photo Right 

CTRL S Slideshow Start  
 

CTRL RIGHT 
Moves Photo Right in largest 

increments 

T Border Text or Photo Text 
 

SHIFT RIGHT 
Moves Photo Right in smallest 

increments 

CTRL E Edit Border Color  ALT E Edit Graphic List 

CTRL P Add New Shape  ALT R Reset Border 

CTRL T Photo Text Options 

 

SPACE 

Take Picture (Fire Cameras 

Shutter Release) or multiple 

import if no camera attached 

V Vertical / Portrait Orientation   TAB Move to next photo 

ALT BACK 

SPACE 
Undo 

 
CTRL TAB 

Picture Properties > Photo Data 
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Key Description  Key Description 
DELETE Remove Photo  SHIFT TAB Move back one photo 

DIVIDE (/) 
Paste Photo Attributes from the 

Clipboard 

 
UP 

Moves Photo up 

DOWN Move Photo Down 
 

CTRL UP 
Moves Photo up in largest 

increments 

CTRL DOWN 
Move Photo Down in largest 

increments 

 
SHIFT UP 

Moves Photo up in smallest 

increments 

SHIFT DOWN 
Move Photo Down in smallest 

increments 

 
X 

Undo All 

END Undo ALL editing  CTRL Y Redo  

ESCAPE Cancel Image Viewer  Z 1:1 Zoom Actual Zoom 

F10 Photo Library Tab  CTRL Z Undo  

F12 Orders Tab  ALT Z 3x Zoom 

F2 Find Photos  SHIFT Z 2x Zoom 

F4 Full Screen Mode  SHIFT ALT Z 4x Zoom 

F5 Enhance Tab  [ Scroll photos up 

CTRL F5 Refresh  \ Add Service Notes 

F6 Correct Tab  ] Scroll photos down 

F7 Color Balance Tab  ` Move back one Photo 

F8 Drop Out Tab    
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Border Workshop Shortcut Keys 

Key Description  Key Description 
CTRL C Copy  CTRL PAGE UP Scale In Largest Increments 

CTRL X Cut  SHIFT PAGE UP Scale In Smallest Increments 

CTRL V Paste  CTRL Y Redo 

CTRL D Duplicate  DEL Delete 

ALT E Edit Graphics List  CTRL E Edit Border Color 

CTRL P Add New Shape  RIGHT Move Right 

TAB Next Item in Border Items  CTRL RIGHT Moves Right in Largest Increments 

SPACE Pan  SHIFT RIGHT Moves Right in Smallest Increments 

` Previous Item in Border Items  Numpad 2 
Scale Out bottom edge of object in 

small increments 

SHIFT TAB Previous Item in Border Items  
CTRL Numpad 

2 

Scale Out bottom edge of object in 

large increments 

CTRL B Change Border View  Numpad 4 
Scale Out right edge of object in 

small increments 

DELETE Delete   
CTRL Numpad 

4 

Scale Out right edge of object in 

large increments 

DOWN Move Item Down  Numpad 6 
Scale In bottom edge of object in 

small increments 

CTRL DOWN Move Item Down in Largest Increments  
CTRL Numpad 

6 

Scale In bottom edge of object in 

large increments 

SHIFT DOWN 
Move Item Down in Smallest 

Increments 
 Numpad 8 

Scale In right edge of object in small 

increments 

LEFT Move Item Left  
CTRL Numpad 

8 

Scale In right edge of object in large 

increments 

CTRL LEFT Move Item Left in Largest Increments  CTRL Z Undo 
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Key Description  Key Description 
SHIFT LEFT Move Item Left in Smaller Increments  ALT Backspace Undo 

PAGE DOWN Scale Out  UP Moves Item up 

CTRL PAGE 

DOWN 
Scale Out in Largest Increments  CTRL UP 

Moves Item Up in Largest 

Increments 

SHIFT PAGE 

DOWN 
Scale Out in Smaller Increments  SHIFT UP 

Moves Item Up in Smallest 

Increments 

PAGE UP Scale In    

Home Shortcut Keys 
  

F10 Photo Library Tab 

F11 Photo Workshop Tab 

F12  Orders Tab 
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Inserting Special Text 

Special Text Description 

[C] This option will print a copyright symbol: © 

 

%COLORCODE% 

This option will print the color code profile. This is represented by numeric 

values: 1234567 

 

%COPIES% 

This option will print the number of copies of the current sheet requested in 

the order. 

 

%COPYRIGHT% 

This option will print copyright information. This will not include company 

copyright information: Copyright © 2006 

 

%CUSTOMERABBREVNAME% 

This option will print the customer name in the format, Last First Initial 

Middle Initial: ThompsonRL 

 

%CUSTOMERADDRESS% 

This option will print the customer’s complete address: 123 Main Street, 

Suite 100, Austin TX 78746 

 

%CUSTOMERADDRESS1% 

This option will print the first line of the customer address. This is usually the 

street address: 123 Main Street 

 

CUSTOMERADDRESS2% 

This option will print the second line of the customer address. This is usually 

the suite, apartment or building number: Suite 100 

 

%CUSTOMERCITY% 

This option will print the city name of the customer address: Austin 

 

%CUSTOMERCITYSTATEZIP% 

This option will print the city name, state abbreviation, and zip code. It will 

print in this format – City, State Zip Code: Austin, TX 78746 

 This option will print the country of residence of the customer: United States 
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%CUSTOMERCOUNTRY% 

 

%CUSTOMEREMAIL% 

This option will print the customer email address: customer@company.com 

 

%CUSTOMERFIRSTLAST% 

This option will print the customer name in the format First Middle Initial 

Last: Rebekah L Thompson 

 

%CUSTOMERLASTFIRST% 

This option will print the customer name in the format Last, First Middle 

Initial: Thompson, Rebekah L 

 

%CUSTOMERNAME% 

This option will print the customer name in the format First Middle Initial 

Last: Rebekah L Thompson 

 

%CUSTOMERPHONE% 

This option will print the phone number divided by dashes: 555-555-5555 

 

%CUSTOMERSHIPADDRESS% 

This option will print the complete address where the prints are to be 

shipped: 123 Main Street, Suite 100, Austin TX 78746 

 

%CUSTOMERSHIPADDRESS1% 

This option will print the first line of the address where the prints are to be 

shipped, this is usually the street address: 123 Main Street 

 

%CUSTOMERSHIPADDRESS2% 

This option will print the second line of the address where the prints are to 

be shipped. This is usually the suite, apartment or building number: Suite 

100 

 

%CUSTOMERSHIPCITY% 

This option will print the state abbreviation of the address where the prints 

are to be shipped: TX 

 

%CUSTOMERSHIPCITYSTATEZIP% 

This option will print the city name, state abbreviation, and the zip code of 

where the prints are to be shipped. It will print in this format – City, State Zip 

Code: Austin, TX 78746 

 

%CUSTOMERSHIPCOMPANY% 

This option will print the company name of the receiving company. 
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%CUSTOMERSHIPCOUNTY% 

This option will print the country of residence of the address where the 

prints are to be shipped: United States 

 

%CUSTOMERSHIPEMAIL% 

This option will print the receiving customer’s email address: 

customer@company.com 

 

%CUSTOMERSHIPFIRSTLAST% 

This option will print the name of the receiving customer in the format, First 

Middle Initial Last: Rebekah L Thompson 

 

%CUSTOMERSHIPLASTFIRST% 

This option will print the name of the receiving customer in the format - 

Last, First Middle Initial: Thompson, Rebekah L 

 

%CUSTOMERSHIPNAME% 

This option will print the name of the receiving customer in the format – 

First Middle Initial Last: Rebekah L Thompson 

 

%CUSTOMERSHIPPHONE% 

This option will print the phone number of the person who is to receive the 

prints, divided by dashes: 555-555-5555 

 

%CUSTOMERSHIPSTATE% 

This option will print the state abbreviation of the address where the prints 

are to shipped: TX 

 

%CUSTOMERSHIPZIP% 

This option will print the zip code of the address where the prints are to be 

shipped: 78746 

 

%CUSTOMERSTATE% 

This option will print the state abbreviation of the customer address: TX 

 

%CUSTOMERZIP% 

This option will print the zip code of the customer address: 78746 

 

[D] 

This option will print the month as a single digit for the first nine months and 

two digits for the last three months. For example, February is represented by 

the number 2, and December is represented by the number 12. 

 This option will print in numerical form, divided by front slashes: 01/14/06 
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%DATE% 

 

%DAY% 

This option will print the day in numeric form. If the day is a single digit, for 

example February 1, the day will print with a zero in front: 01 

 

%DAYOFWEEK% 

This option will print the day of the week: Wednesday 

 

[DD] 

This option will print the day as a double-digit number for every day of the 

month. So days 1-9 will gain a zero: 01, 02, 03 

 

[F] 

This option will print the image filename 

 

%FILE% 

This option will print the filename of the primary image used on the sheet. If 

the sheet contains a composite border, then this is the filename of the first 

image. 

 

%FILE1% 

This option will print the filename of the primary image used on the sheet. If 

the sheet contains a composite border, then this is the filename of the first 

image. 

 

%FILE2% 

This option is a special case used when two prints are optimized on a single 

sheet. For example, this could be when two 5x7’s are on one 8x10 sheet 

 

%FILEDATE% 

This option will print the image file save date in numeric form, divided by 

front slashes: 02/14/06 

 

 

 

 

%FILEFOLDER% This option will print the folder file pathway that the image file is housed in 

on the computer. For example if the image file was stored on the C:\ drive, 

in the Photos directory and then in the Team1 folder, the address would be 

as follows: C:\Photos\Team1 



Inserting Special Text 

 

355 

 

 

%FILETIME% 

This option will print the time the image file was most recently saved. The 

time will print in the standard form: 1:01PM 

 

%LONGDATE% 

This option will print the date in its most extended form, writing out the day 

of the week, an abbreviated month, and numerical values for the date and 

year: Wednesday, Feb 14, 2006 

 

[M] 

This option will print the month as a single digit for the first nine months and 

two digits for the last three months. For example, February is represented by 

the number 2 and December is represented by the number 12 

 

%MEDIUMDATE% 

This option will print the date in extended form, meaning the month will be 

spelled out completely: February 14, 2006 

 

[MM] 

This option will print the month as a two-digit number. For example, 

February is represented as 02 and December is represented as 12 

 

%MONTH% 

This option will print the month in numeric form. If the month is a single 

digit, for example February is the second month, it will add a zero in the 

front: 02 

 

%ORDERBACKPRINT1% 

This option will print the customer back print information submitted by the 

customer will the order. This will print the first line of customer information 

 

%ORDERBACKPRINT2% 

This option will print the customer back print information submitted by the 

customer with the order. This will print the second line of the customer 

information 

 

%ORDERCOMMENTS% 

This option will print the order comments for the order 

 

 

%ORDERDATE% 

This option will print the order date associated with the print job. The order 

date is represented by numbers that are divided by front slashes. All single 

digit numbers will have a zero placed before them. February 14
th

, 2006 will 

appear as: 02/14/2006 

 

%ORDERDATETIME% 

This option will combine both the ORDERDATE with the ORDERTIME. It will 

look like this: 02/14/2006 01:52PM 
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%ORDERDISCOUNT% 

This option will print the order discount amount in dollars using two decimal 

places: 9.99 

 

%ORDERID% 

This option will print the order ID associated with the print job. Order IDs 

can be found by searching within the Orders tab. Order IDs are in numeric 

form: 12345 

 

 

 

%ORDERMULTIPLE% 

This option is helpful when the original order was split into multiple print 

orders or if the printer order represents the complete original order, then an 

asterisk (*) is generated. This symbol can be used to indicate whether the 

operator will need to combine separate portions of the order together to 

create a complete order. This option is most helpful when the order was 

sent to multiple printers for printing. 

 

%ORDERPARTIALSHEETS% 

This option will print the quantity of partial sheets in the current print order. 

This is represented by a numerical value. 

 

%ORDERPRINTCOMMANDS% 

This option will print the order total dollar value with two decimal places: 

99.99 

 

 

 

%ORDERSHEETS% This option will print the entire number of sheets along with what sheet 

number the current page is. For example, if you were holding the 6
th

 page in 

a 10-page order, the software would print: 6/10 

%ORDERSHIPCOST% This option will print the order shipping cost value in dollars using two 

decimal places: 9.99 

 

%ORDERSUBTOTAL% 

This option will print the order subtotal dollar value using two decimal 

places: 99.99 

 

%ORDERTAX% 

This option will print the order tax amount in dollars using two decimal 

places: 9.99 

 

%ORDERTAXRATE% 

This option will print the amount of tax charged to an order. 
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%ORDERTIME% 

This option will print the order time associated with the print job. The order 

time is denoted in standard form: 01:52PM  

 

%ORDERTOTAL% 

This option will print the order total dollar value with two decimal places: 

99.99 

 

%ORDERTOTALSHEETS% 

This option will print the quantity of sheets all together in the current print 

order. This is represented by a numerical value. 

 

[P] 

This option will print the computer name that supplied the image 

 

%PACKAGE% 

This option will print the package name: Package 1 

 

%PAGE% 

This option will print the page number in a series or stand-alone. For 

example, if I were on page 2 of 5, the software would print: Page 2 of 5 

 

 

%PATH% 

This option will print the file pathway of the image directly to the image 

name. For example, if the image is saved on the C:\ drive, located in the 

Photos directory, then in the Team1 folder, and finally called “Front.jpg,” the 

software would print: C:\Photos\Team1\Front.jpg 

 

%PRINTSIZE% 

The option will print the print size of the image: 5x7 print 

 

[R] 

This option will print the sequential print number within the order 

 

 

%REPEATCOUNT% 

This option is specific to Noritsu printers and displays the specific sheet 

number within an order. On most printers if you print 10 copies of a sheet, 

the backprint information will be identical for all sheets. On Noritsu printers, 

the printer is able to insert a different count onto each copy: 

001,002,003…010 

 This option will print the roll size: 203 mm 
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%ROLL% 

 

%SHORTDATE% 

This option will print the date with the month abbreviated but the numbers 

will be in extended for: Feb 14, 2006 

 

%TIME% 

This option will print the time of day using AM and PM designations. For 

example, 12:14PM, is just after noon. 

 

%TIME24% 

This option will print the time under military distinction. This will indicate 

the time on a 24-hour cycle rather that a 12-hour repeating cycle. For 

example, 2:35PM is represented as 14:35.  

 

[U] 

This image will print the user name, which is the login name of the image 

supplier. 

 

 

%YEAR% This option will print the year using four digits: 2006 

 

[YY] 

This option will print the year in a two-digit sequence. For example, the year 

2006 will be represented by only: 06 
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Index 

A La Carte Items, 141 

add effect tool, 288 

add graphic tool, 284 

add multiple photos tool, 279 

add photo tool, 273 

add text tool, 259, 286 

Advanced Tilt, 184 

align tool, 293 

Application General Settings 

Add text on the fly, 41 

Delete after archiving, 41 

Image format, 42 

Show Desktop, 41 

View previews, 41 

Application Options, 39 

Archiving, 40 

General Settings, 40 

Restoring, 40 

Studio Information, 39 

Application Shared Settings 

Caption Logo, 41 

File Management, 41 

Archiving, 119 

arrays 

in borders, 279 

Attributes 

Applying, 131 

Custom, 131 

Saving, 130 

Auto-Orient, 41 

barcode, 261 

Basic Toolset, 181 

Batch Orders, 134 

border 

add custom object, 260 

barcode, 261 

border items, 272 

border workshop, 255 

Border Workshop, 209 

borders 
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aligning objects, 293 

centering objects, 293 

changing order of objects, 294 

composites, 279 

drop shadow on photos, 277, 283, 285 

editing, 254 

effects, 288 

fitting objects to page, 292 

graphics, 284 

image cells, 272 

making objects same, 293 

masks, 275, 289 

multiple photos, 279 

photo array, 279 

photo placeholders, 272 

properties, 270 

rotating objects, 295 

spacing objects, 294 

testing variable text fields, 297 

text, 259, 286 

Borders 

Applying in Photo Workshop, 188 

Creating, 210 

Editing, 214 

Brightness, 194 

Calendar, 92 

Add Booking, 95 

Add Call, 97 

Add Task, 96 

Adding Notes, 99 

Schedules, 98 

Tasks and Events, 94 

Viewing Modes, 94 

Cameras 

Connecting, 59 

Hot Folder, 61 

Importing, 62 

Importing in Photo Workshop, 176 

Tethered, 60 

Wifi, 60 

Catalogs, 113 

Archiving, 119 

Batch Publishing, 119 

Photo Numbers, 120 
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Photo Paths, 121 

Publishing, 118 

Unpublishing, 118 

center tool, 293 

Checking In and Out, 105 

Color, 194 

Color Balance Toolset, 202 

Color Profile, 205 

composite borders 

image cell settings, 282 

labels, 283 

photo frames, 283 

photo queries, 280 

transparency setting, 283 

Composite Sheets, 192 

composites, 279 

Contrast, 194 

Correct Toolset, 194 

custom objects, 260 

Customers 

Add Booking, 102 

Add Call, 104 

Add Note, 103 

Adding, 88 

Details Page, 100 

Setting Up, 88 

Desktop, 114 

Drop Out Toolset, 205 

drop shadow, 277, 283, 285 

edit 

add barcode, 261 

Edit & Proofing, 154 

effects 

on borders, 288 

Employees 

Adding, 87 

Adding Notes, 107 

Adding Shifts, 107 

Adding Tasks, 107 

Details Page, 105 

Setting Up, 84 

Enhance Toolset, 185 

Exposure, 194 

fill & fit tool, 292 
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Finding Photos, 126 

Fit to Page, 296 

Focus, 193 

font tool, 292 

Front vs. Back, 167 

Fulfillment Options, 44 

graphic lookup, 297 

graphics 

on borders, 284 

Help, 28 

Hiding Photos, 127 

Histograms, 130 

Home Page, 92 

Hue Percent, 207 

image cells, 272 

Image Preview Settings, 44 

Importing Photos, 173 

Installation, 30 

Before installing, 31 

Operating Reqs., 30 

Inventory 

Setting Up, 82 

Updating, 84 

labels 

on composite borders, 283 

Labtricity, 46 

Login, 32 

Logging in as an Employee, 33 

Logging into Photoreflect, 33 

lookup, 297 

make same tool, 293 

masks 

on border effects, 275, 289 

Music, 163 

Network Options, 48 

Client Computer, 53 

Server Computer, 51 

Single Computer, 50 

Typical Setups, 48 

order tool, 294 

Orders 

Batching Orders, 151 

Finding Orders, 148 

Managing Orders, 146 
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Printing, 149 

Printing an Order Proof, 152 

Printing to CD, 149 

Viewing Older Orders, 148 

Orienting Photos, 132 

Overview, 34 

Pan, 296 

Password 

Setting an Admin PW, 32 

Permissions, 85 

Photo Groups, 116 

Photo Icons, 171 

Photo Library 

Navigating, 113 

Using, 113 

photo lookup, 297 

Photo Workshop 

Finding Photos, 170 

Importing Photos, 173 

Photo Information, 171 

Using, 165 

Photographer Notes, 126 

Photoreflect, 46 

photos 

drop shadow, 277, 283, 285 

Portfolio, 113 

Portraits, 114 

Presentation Mode, 158 

Managing Photos, 160 

Navigating, 159 

Preset Color Balances, 203 

Print Commands, 144 

Print Media, 144 

Print Queue, 150 

Printers 

Arrangements, 58 

Connecting, 55 

Margin Text, 57 

Media & Profile, 57 

Raster Printer, 58 

Rolls, 56 

Setting Up, 56 

Sheets, 56 

Printing Orders, 149 
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Products 

Creating, 63 

Package Groups, 63 

Proofing Photos, 136 

Custom Proof Sheet, 138 

properties 

borders, 270 

queries 

in composite borders, 280 

lookup, 298 

on border objects, 297 

Quick Import, 175 

Rating Photos, 127 

Receipts, 153 

Redeye, 194 

Redo 

Retouch, 269 

Renaming Photos, 126 

Reports 

Running Reports, 109 

Retouch Methods, 233 

Retouch Settings, 232 

Retouch Tools, 234 

Retouch Workshop 

Using, 230 

Retouching Photos, 186 

rotate tool, 295 

Schedules 

Printing a Schedule, 108 

Search 

Studio, 91 

Service 

Lab Service, 75 

Local Service, 74 

Service Notes, 128 

Services, 74 

Shadows, 194 

Shipping and Handling Tax, 81 

Shipping Info, 128 

Shipping Options, 79 

Shipping Groups, 80 

Shopping Cart 

A la Carte Items, 141 

Adding Items, 140 
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Adding Services, 144 

Hiding the Cart, 139 

Package Groups, 140 

Placing Orders, 142 

Saving Orders, 142 

Single vs. Multiple, 166 

Slideshow, 164 

Software 

Supported CD/DVD, 32 

Supported File Formats, 32 

space tool, 294 

Station ID, 40 

Status Bar, 91 

Errors, 300 

System Properties, 46 

targa, 255 

Tax Information, 80 

Local Order Sales Tax, 80 

Template Marketplace 

Show purchased, 42 

templates 

borders, 254 

Templates 

Creating, 78 

Importing, 78 

Viewing, 75 

test form tool, 297 

text 

fonts on borders, 292 

on borders, 259, 286 

variable fields on borders, 297 

Thumbnails, 124 

Title Bar, 90 

Tone, 194 

Toolsets, 181 

Undo 

Retouch, 269 

User Roles 

Adding, 85 

Users, 90 

Vendors 

Setting Up, 82 

Viewing Guides, 169 

Vignettes, 193 
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Zoom, 296 

 



All images and effects simulated. 
Not responsible for typographical errors.  Availability and specifica-

tions subject to change without notice. Canon is a registered 
trademark of Canon Inc. in the United States, and may also be a 

registered trademark or a trademark in other countries. 
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